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other processes, or transmitted into a language used for machines, especially data 
processing machines, without the express written consent of the publisher. 

All copyrights reserved. 

All other product names are trademarks of the corresponding manufacturers. Errors in 
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Preface 
MAGIX Music Maker 2013 offers an easy start and the option to dive deeper into the 
world of music production. A giant, high-quality sound archive, an especially intuitive 
approach to creating original music, plus many useful functions result in an 
unbeatable complete package for making your own songs. 

The handling is especially easy and consistent. The included sound files can be 
combined with the software synthesizers easily. MP3 songs can be used with audio 
CD tracks, your own music recordings and even videos, photos or graphics. Even VST 
and DirectX plug-ins or MIDI files can be added easily. 

This turns your computer into a universal production studio for music and all other 
kinds of multimedia files. The included CD-quality musical building blocks can all be 
easily combined since they are all categorized according to tempo and harmony. And 
for those of you who want to start making songs effortlessly and straight away, the 
integrated "Song Maker" will take care of almost everything for you. 

The tutorial (view page 21) starts off by explaining all of the basic features in the 
program and then goes on to provide complete, detailed descriptions of each of the 
functions. If you prefer to discover the many possibilities of the program by yourself, 
you can also use the PDF manual and the Help feature as references. An alphabetical 
index is included at the very end. 

Have fun with MAGIX Music Maker 2013. 

The MAGIX Team 
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Support 
Dear MAGIX customer, 

Our aim is to provide fast, convenient, solution-focused support at all times. To this 
end, we offer a wide range of services: 

• Unlimited web support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered via the convenient MAGIX service portal on http://support.magix.net, 
including an intelligent help assistant, high-quality FAQs, patches and user 
reports that are constantly updated. 
The only requirement for use is product registration at www.magix.com 

• The online community, on-the-spot support and a platform for exchange: 
MAGIX customers have free and unlimited access to the online community at 
www.magix.info, which includes approx. 150,000 members and offers the 
opportunity to ask members questions concerning MAGIX products as well as 
use the search function to search for specific topics or answers. In addition to 
questions & answers, the knowledge pool includes a glossary, video tutorials and 
a discussion forum. The multiple experts, found round-the-clock at 
www.magix.info guarantee quick answers, which sometimes come within 
minutes of a question being posted.  

• Email support for MAGIX products:  
For every new MAGIX product you will receive, as of date purchase, 12 months of 
email based customer service. 
Premium email support: 
For priority support, or if you want the MAGIX support team to help with non-
MAGIX related hardware problems you can purchase a Premium email support 
ticket. Log in at http://support.magix.net and click on "Purchase access code", 
the ticket is for a specific problem, and is valid until it is solved, it is not restricted 
to an email. 

Please note: To be able to use the Premium email support and free product email 
support via the Internet, you have to register your MAGIX product using the serial 
number provided. This can be found on the CD case of your installation CD or on the 
inside of the DVD box. 

• Additional telephone service: 
Besides the large number of free customer service offers, we also offer a fee-
based telephone customer service. 

Here you can find a summary of our technical support telephone numbers: 
http://support.magix.net/ 

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 
Germany 
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Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, Reno, 
NV 89502, USA 

Please make sure you have the following information at hand: 
• Program version 
• Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
• Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 
questions and problems: 

• Orders 
• Product consulting (pre-purchase) 
• Upgrade requests 
• Returns 

Europe 
Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  
Denmark: 45 699 18763 
Sweden: 46 852 500713  
Finland: 35 89 42419023 
Norway: 47 210 35843 

North America 
9 am to 4 pm EST Mon-Fri 
Phone: 1-305-722-5810  
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Introduction 

What is MAGIX Music Maker 2013? 
MAGIX Music Maker 2013 is the ideal program for creating professional sounding 
recordings without having to learn any complicated musical theory. You can simply 
combine the professionally produced loops in the intuitive arranger and mix them to 
create your own personal sound. 

Are you aiming for a unique sound that will set you apart from the crowd? Then try 
creating your own special sounds with the included software synthesizers or load 
your own plug-in synthesizers. High-quality effects help to give your tracks the final 
polish or you can take things in the other direction and distort them until they are 
almost unrecognizable. Express your own creativity by recording your vocals or 
instruments and adding them to the arrangement. 

Whether rock, techno or film music, you can produce all kinds of tracks using the 
wide range of styles available in the program. When you combine elements from 
different style libraries the tempo is adjusted automatically to make sure your 
arrangement fits together perfectly. Who knows? Maybe flamenco rock or country 
techno is the next big thing. 

If you need even more sounds and samples, Catooh offers a rich selection of audio, 
video, images and professionally created sound effects, which can add even more 
variety to your project. 

Or how about a remix? Load up your favorite hits from the past and add some fat 
bass or a totally modern beat! When you load audio CD tracks and MP3s into Music 
Maker the tempo of the song is recognized and adjusted to fit the arrangement. The 
track can also automatically be cut into loops. 

But music alone isn't everything! You can import images and video files to your 
arrangement, include text and add video effects and cool visuals. The finished video 
can be directly exported from Music Maker and posted on MAGIX Online Album, 
Youtube or Facebook 

What's new in MAGIX Music Maker 2013? 
New Sounds and Loops 
As usual there is a brand new sound archive with various styles ranging from "trendy" 
to "retro". In addition to the included sound loops, an additional 1000 loops can be 
downloaded for free from the Internet. To download sounds, click on the "Catooh" 
button after installing the software and follow instructions. 
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New Synthesizers 
The Vita Sample Player has a new interface and a lot more instruments like the new 
Vita Solo Instruments String Ensemble and Rock Drums and the Bass Machine and 
World Percussion included in the Premium version. 

Improved Interface 
The user interface and the workflow have been improved and simplified. The main 
windows for the arranger, the Media Pool and the video monitor (peak meter) can be 
adjusted for size and position and the track height is now completely customizable. 

Improved Soundpool Control 
The Soundpool display has been completely redesigned and many of the most 
important functions have been enhanced. You can now use the full text search to find 
loops and list them according to pitch or type, i.e. MIDI or audio loops. You can also 
filter the search to display only the favorites that you have selected. The sample list 
can also be sorted according to properties, e.g. key, bar length, date, etc. 

Improved Compatibility 
Music Maker arrangements can be opened in Music Studio 2013. All of the functions 
in Music Maker are reconstructed perfectly in Music Studio. In the rare case that this 
doesn't work, you can also export arrangements from Music Maker as single tracks. 

More Tracks 
The number of tracks you can use in the Premium version is unlimited and has been 
increased from 64 to 96 in the standard version. 

New Program Performance Features 
Music Maker can now be started faster and has been enhanced for better 
performance and stability. The new WASAPI driver support (starting with Windows 
Vista) for audio playback reduces latency (delays between hitting a note on the 
keyboard and the production of sound) and provides more stability. It's also a good 
alternative to ASIO divers for complicated audio output devices. 

Improved Audio Effects 
The parametric equalizer has a redesigned interface and six channels instead of four. 
The new and improved Premium version also includes the Vintage FX Suite, essential 
FX Suite and the Mastering Suite. 

Additional features new in the Premium version 
• Larger sound archive: Over 5000 new sounds and MIDI loops from all genres can 

be accessed via the "Soundpools" button in the Media Pool. 
• Essential FX Vocal Strip: This combination of effects is specifically designed for 

editing speech and vocal recordings. 
• Two Brand New Synthesizers: World Percussion offers a huge selection of 

percussion instruments like bongos, congas or timbales that are perfect for 
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creating Latin American rhythms or simply adding an exotic flair. The Bass 
Machine is special synth for creating booming bass sounds for Dubstep and Hip 
Hop productions. 

The Features 
Multimedia Library 
The included multimedia library provides audio and video building blocks ("samples") 
that can be combined in the arranger. The program also offers lots of melodies, effect 
presets and graphic animations that you can add to your songs and video clips. In 
short: just about anything can be combined with anything else. The sky's the limit to 
your creativity. 

BeatBox 2 
BeatBox 2, the new groove synthesizer, lets you make great beats with ease. It can be 
accessed in the Media Pool via the "Synthesizers" button. Easy mode must be 
switched off to access it. 

Audio Effects 
MAGIX Music Maker 2013 provides lots of different audio effects. A short overview: 

• You can correct tempo and pitch in real time using Resampling, Timestretching 
or Pitchshifting. 

• The Audio Effect Rack supplies Reverb, Echo, Equalizer, Compressor, Time 
Processor, Distortion, Filter - all classic effects which can be used to produce 
almost any sound. The reverb effect, for example, provides professional, realistic 
reverb algorithms to add depth and spaciousness to your material. 

• The Gater enables rhythmic splitting of surface sounds 
• Vandal SE is a guitar amplifier from MAGIX. You can adjust all the typical 

settings on its realistic user interface.  
• essentialFX: important bread-and-butter effects that are embedded like VST 

plug-ins.  
• The Vintage Effects Suite covers "good old" guitar effects that were activated 

using a foot pedal in Jimi Hendrix's era: more warmth and fullness with Chorus, 
jet-like special effects with the Flanger or ping-pong effects with Delay. The Filter 
enables tempo-synchronous frequency filtering. 

In general, there are three ways of implementing filters:  

• Object effects: Effects for selected objects. These effects can be found in "Effects 
> Audio > Audio effects" or in the context menu (right mouse click).  

• Track effects: Effects for complete tracks. These effects can be found in the track 
box or in the mixer channels.  

• Master effects: Effects for the overall sound. These effects can be found in the 
mastering area of the mixer ( or in the "Effects" menu). 
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Note: In the track box, you will only find pre-configured track effects, while the mixer 
channels contain editable effect devices. 

Media database 
Find your recordings, sounds, pictures, and videos quicker and faster with the MAGIX 
media database. An existing MAGIX database from the MAGIX Photo Manager or 
MAGIX Media Manager is integrated in the Media Pool and can be updated directly 
from MAGIX Music Maker 2013. Use the simple search function to find suitable 
pictures or MP3 files for your arrangement. 

Import 
You have the following options for using your own material: 

• Audio files in a wide range of formats. You can also use MIDI, video and bitmaps.  
The files can be dragged to a track from the Media Pool with a held-down mouse 
key (drag & drop). You can find a list of supported formats below (view page 16). 

• Audio CDs can be imported directly in the program. Simply place the CD into the 
drive and press "CD/DVD" and all the tracks are ready to be dragged & dropped 
into the Arranger. Whether for remixes or as sound material for your own 
compositions - your personal CD collection has a whole new meaning. 

• Use the recording function to record vocals, noises, or instruments and integrate 
them into the arrangement. 

High-end 32-bit floating point 
All sound changes are executed using 32-bit floating point calculation for especially 
differentiated and high-quality sounds. This technology is also used in professional 
studios. This way, an audio picture with especially high dynamics can be created. 
Digital overmodulation and clipping become virtually impossible. 

Own recordings 
Use this recording function from MAGIX Music Maker 2013 to record vocals, noises, 
or instruments and integrate them into the arrangement. 

Audio & MIDI 
The MIDI format is extremely important in modern music production. You can use 
MIDI files to control external devices such as synthesizers and samplers and internal 
software audio generators such as VST plug-ins from your computer. 

With MAGIX Music Maker 2013 you can arrange, load, record, edit, and play MIDI 
data just as easily as audio data. For MIDI recordings and editing you can use the 
specialized MIDI Editor with Piano Roll, Drum Editor, Velocity/Controller Editor and 
Event List. Recording can be started directly from the arranger by setting the 
recording mode in the track header to "MIDI record" or "Audio record". 
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VST Support 
Now it is possible to use external VST instruments and effects in all MAGIX Music 
Maker 2013 versions. A wide range of DirectX and VST plug-ins are offered in retail 
stores or directly on the Internet, greatly expanding the possibilities of MAGIX Music 
Maker 2013. 

VST instruments and effects are external programs, which must first be installed 
before being used in MAGIX Music Maker 2013. You can then find them in the mixer 
plug-in slots and in the track boxes at the start of every track. VST effects are applied 
to an entire track. VST instruments are controlled by MIDI objects. 

Mixer 
MAGIX Music Maker 2013 contains a professional real-time mixer with an Effect 
Rack and two Insert Effects per channel and for the Master, as well as additional 
Mastering Effects. You can group a number of faders of a specific type (for example, 
volume or panorama) and use them all together by holding down the Ctrl key. The 
quickest way to open and close the mixer is by using the M key. 

Harmony Agent 
The Harmony Agent provides harmony recognition automatically and determines the 
key and chord of any music title. See the guitar tablature of your favorite song in real 
time for the arrangement! 

Formats and interfaces 
Import: WAV, MP3, OGG Vorbis, WMA, QuickTimeTM, MIDI, CD-A (without copy 
protection), BMP, JPG, AVI, MXV, WMV 

Export: WAV, MP3, OGG Vorbis, WMA, QuickTime, MIDI, BMP, JPG, AVI, MXV, 
WMV, CD-A (Premium version) 

Song Maker 
The Song Maker lets you create new arrangements quickly and easily and 
complement existing arrangements by automating the complicated steps such as 
sample selection and combination. The Song Maker takes over arranging whole 
sections such as intro and refrain. Therefore, you do not have to do everything 
yourself – you can omit the arranging and process your selection from the 
suggestions. 

InfoBox 
Thanks to the new info box, all important functions can be easily understood as they 
are applied. Just hold the mouse over a button that you would like to learn about and 
read the info text in the preview monitor. 
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Live Sessions 
While the virtual instruments and sounds are played on the available tracks, a new 
track can be recorded simultaneously in realtime. What's more, you can also add 
realtime effects. 

SoundVision 
SoundVision is a new way of visualizing music which shows audio material at a glance 
in the form of a musical galaxy. Similar sounds are clustered close together; different 
sounds are organized further apart. SoundVision can be activated in the Media Pool 
via the corresponding button. Easy mode must be switched off to access it. 

Internet upload to many platforms 
When the song is finished, it should be heard not just by your friends, but preferably 
the whole world. This is achieved, naturally, with the help of the web. Under "File > 
Export > Community upload" you will find the most impotant communities, where 
you can upload your songs. 

Additional features of the Premium version 
Additional Audio Effects 
• Elastic Audio for total control over vocals. Voice samples or melodies you sing 

yourself can be "tuned" to match automatically. With the "Harmonizer" in the 
Elastic Audio Editor, you can add a suitable second vocal or a whole choir to a 
specified melody. 

• Vocoder: Produces distorted vocals from synthesized sounds. 
• Mastering Suite: A special effect rack for "Mastering". In this process, the mixed-

down music track is "polished" using parametric equalizer, multimax,  limiter and 
stereo enhancers.  All this can be found in the mixer (M key). 

• Am-Track SE: This analog vintage compressor produces an especially warm, 
pumping sound. Launch it via the effects menu for selected audio objects or via 
the plug-in slot in the mixer. 

Additional Styles & Samples 
More content: The Premium version comes with more styles and ca. 2,000 additional 
samples. 

Additional Instruments 
• Revolta 2: An analog, especially variable and "professional" sounding, 12-tone 

synthesizer. With sound matrix, noise generator and nine effect types. 
• BeatBox 2 plus: The ultimate groove tool with even more drum kits, automations 

and an even more flexible effects section.  
• New features: Century Guitars & Electric Bass. 
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Object and track curve automation 
Effect and volume progressions can be controlled using freely drawable curves – for 
individual objects as well as for complete tracks. In addition, you can fade an echo in 
or out at a specific position in the song by drawing in a curve peak at the 
corresponding position. 

Video recording 
In addition to audio recording, MAGIX Music Maker 2013 provides a recording 
function for video from analog video sources for your own video clips. 

DirectX and VST plug-ins 
MAGIX Music Maker 2013 enables the direct use of DirectX and VST plug-ins, a large 
variety of which is available in retail stores or directly online. Such plug-ins (audio 
effects or synthesizers from third party manufacturers) can significantly increase the 
functionality of MAGIX Music Maker 2013. 

MAGIX Mastering Suite 2.0 
Impressive studio sound just like you hear on store-bought CDs! MAGIX Mastering 
Suite is a special effects rack for use with the mixer master channel. The included 
effects help you with so-called "mastering"; put the final touch on your completed and 
mixed music piece using parametric equalizers, MultiMax, limiter, and stereo 
enhancers. 

Real 5.1 Surround Sound 
MAGIX Music Maker 2013 deluxe provides real 5.1 Surround Sound. 5.1 Surround is 
the preferred home cinema sound format, which is also supported in the Premium 
version when importing, editing, and exporting. With the 5.1 Surround Editor you can 
move your sound around the room. 

MAGIX Music Editor 
Detailed audio editing in real time and specialist for CD burning, sound restoration, 
sampling and audio editing. 

Revolta 2 
Revolta 2 is a powerful-sounding, varied 12-voice analog synthesizer with highly 
advanced functions, sound matrix, noise generator, and a complete effects section 
featuring nine effect types. 

This synthesizer can create any electronic music you can imagine. The sound presets 
were created by sound designers for Access Virus and Rob Papens Albino, which 
makes Revolta 2 the number 1 choice for beginners and professionals alike. 

Also in the Premium version 
• Additional tracks: The Premium version offers unlimited tracks (instead of 96 - 

more space for even more complex arrangements. 
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• Timecode sync: For creating songs in teams on multiple PCs. Simply connect two 
notebooks to each other via MIDI and jam together. 

• MIDI step recording: Provided for composers unsure of their keyboard playing 
skills who want to play perfect melodies. The MIDI editor can be opened by 
double-clicking on a MIDI object. 

• ReWire: For embedding of other music programs. Programs such as 
Propellerhead Reason or Ableton Live can be controlled in MAGIX Music Maker 
2013 like a software synthesizer using MIDI objects. 

• Video recoding: In addition to audio recording, MAGIX Music Maker 2013 
Premium provides a recording function for video from analog video sources – for 
your own video clips. It can be found in the "File" menu under "Import > Video 
recording". 

• Curve automation: Effect and volume progressions can be controlled using freely 
drawable curves – for individual objects as well as for complete tracks. In 
addition, you can fade in or out an echo at a specific position in the song by 
drawing in a curve peak at the corresponding position. 

• MAGIX Music Editor: Detailed audio editing in real time and specialist for CD 
burning, sound restoration, sampling and audio editing. 

• MAGIX Xtreme Print Center for quickly creating CD covers, inlays and labels. 
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Overview of the program interface 

 
 Menu bar This bar provides the most important editing commands. 

 Toolbar This contains the buttons for quick editing and the different 
mouse modes. 

 Track headers Complete tracks can be turned on or off (muted) or played 
separately (solo). Use the FX buttons to apply track effects. 

 Arranger You can freely position any multimedia material on all of the 
arranger's tracks. 

 Transport console In the middle you'll find the volume control, the transport 
console for the playback functions and the tempo display. 

 Zoom functions Here you can enlarge or reduce the view. The horizontal 
scrollbar can be stretched and compressed for zooming. 

 Media Pool  All files listed here can be added to the arranger using drag 
& drop. 

 Arranger buttons Buttons for displaying the mixer, Live Performer and video 
monitor with peak meter. 

The arranger, video monitor and Media Pool can be positioned anywhere on the 
screen or completely hidden. In the "View" menu (F11 key) you can reset the standard 
layout for Music Maker. 

 The maximize buttons on the arranger, the video monitor and the Media Pool let 
you display them on the full screen, e.g. to make positioning and editing objects 
in the arranger easier. 

For very large arrangements, the video monitor can be used as an overview display 
(Menu -> Video monitor -> Arrangement overview). 
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Quick start 
This chapter explains the basic functions of MAGIX Music Maker 2013 with a step-
by-step introduction. A systematic description of all program functions can be found 
towards the end of the manual. 

Tip: Watch the introductory videos and learn some tips and tricks from other users 
at magix.info http://www.magix.info/de/suche/Music+Maker/. 

Play demo project 
When MAGIX Music Maker 2013 is started for the first time it will display a welcome 
screen. 

 

To get an idea of what Music Maker can do, click on "Load demo song" and select a 
demo song from the menu. Once it is loaded, the Music Maker interface will be 
displayed. 

 

http://www.magix.info/de/suche/Music+Maker/�
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The large area with the horizontal tracks is the arranger. The colored rectangles are 
objects. They represent various samples, synthesizers and other sounds. There are 
also objects for titles, images and video files. 

Look at the individual tracks of the song in the arranger: In MAGIX Music Maker 2013 
you can create a complete song by compiling objects. Click on the vertical scroll bar 
on the right-hand side of the screen and drag them down (hold down the left mouse 
button) in order to be able to see each track. 

In the middle you'll find a large volume control, the transport console (view page 35) 
and some buttons for opening important windows.. 

In the lower section of the program interface you can find the Media Pool. You can 
switch between the different areas. In Soundpools you will find the included loops 
that you can load into the arrangement by drag & drop while holding the mouse key 
or by double-clicking.  

To play the demo, click on the Play button with the mouse or press the space bar on 
your keyboard. A vertical red line (the playback marker) runs across the screen and 
music will play from the speakers. 

Note: If you do not hear anything, check if the correct sound card is active for 
playback in the Setup window (P key). Also make sure that the output of the sound 
card is connected to the speakers. 
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Previewing and loading sounds 
Now you can load your first sound into the arranger. 

 
Create another new, empty arrangement. Simply click on this button. 

• Now click on "Soundpools" (1) in the Media Pool.  
• Various "Styles" (2) are shown on the left hand side of the Media Pool. Styles 

represent particular musical genres. Click on one of the styles to display the loops 
that match this genre. 

 

• Now, select which instrument you would like to use under instruments (3). On 
the right all of the loops (5) will be listed and you can select the sound you want. 
The selected sound will play back automatically.  

• Most instruments are categorized according to pitch. Click on the pitch (4) to 
listen to the sound in the corresponding pitch. Other instruments, like drums, are 
not categorized according to pitch. 

• To load a file into the arranger, simply press the Enter key. You can also drag the 
file from a table onto a track in the arranger. Once you let go of the mouse button, 
the file will appear as an audio object (or MIDI object) at that position. 

Creating an arrangement 
Start playback now. 

To load new samples into the arranger, you do not need to interrupt playback. MAGIX 
Music Maker 2013 has a "Smart Preview" function: You can simultaneously preview 
new samples in the Media Pool – they always run in sync with the song in the 
arranger. This function considerably simplifies the search for suitable samples for a 
song you wish to create. 
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This way, any number of loops from any style can be dragged from any folder into the 
arranger and placed on top of one another, on multiple tracks, or behind one another. 

 

Take note of the two markers at the top of the bar ruler – they represent the start and 
end points of the range to be played (playback range). Playback is "looped" in this 
range which means that it repeats continuously. New loops can be added when 
possible.  

If you want to create a new part for the song you can reposition the start marker by 
left-clicking on the bar ruler and the end marker by right-clicking on the bar ruler. Or 
you can use the right arrow key to move the playback area its entire length to the 
right.  

Each object can be moved in any way in the arranger with the mouse, horizontally on 
a track as well as vertically between tracks. 

Note: There is one important limitation to the movement of objects on tracks. The 
Soundpools contain two different kinds of loops: audio & MIDI. You can recognize 
MIDI loops by their icon in the list. You can recognize MIDI loops by their 

corresponding icon in the list . These loops only produce a sound when 
combined with a software synthesizer (view page 102). This synthesizer is 
automatically loaded to the track where the MIDI object is placed. These objects 
should not be moved to other tracks once the synthesizer is loaded to a particular 
track. 

Editing Objects 
Even though it's possible to make great arrangements with the audio building blocks 
provided, you will probably get to a point where you want to add your own personal 
touch by shortening or removing objects or adjusting the loops in specific areas. 

All objects can be shortened or looped by moving the mouse to one of the lower 
corners of the object until it turns into a stretch symbol. You can now stretch or 
compress the object length as much as you like. If you make the object longer than it 
originally was, it will be played back as a loop. This way you can create rhythm tracks 
from short drum samples simply by stretching them. 

If an object is selected, additional "handles" will appear on it. 
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At the top corners of every object there are two fade handles that can be adjusted to 
fade an object in or out. The handle at the top center can be used to adjust the volume 
of audio objects and the transparency of video objects.  

All objects can be split into multiple objects. To do so, select "Split objects" from the 
"Edit" menu. The selected object will be split at the position where the playback 
marker is.  

 
This can be done even faster using the special splitting mouse mode, found in 
the mouse mode button in the tool bar, or by pressing Alt + 6. 

Right-clicking on an object opens the context menu with the options available for that 
specific object in the Timeline mode. 

Tip: You'll really notice the advantages of object-based editing when you start to use 
Object Effects! You can apply audio effects to each individual audio object. For 
example, you can cut a sample to create an object for the last beat before a pause in 
the arrangement and add an echo effect! Or create a some crazy drums by applying 
various filter effects to each beat in the loop. There's no limit to the creative 
possibilities!  

Adding software instruments 
The included audio loops in the Soundpool are of the highest quality and melodically 
synchronized. But sometimes it's good to have a bigger selection of beats and 
melodies or a way to create your own ideas. In this case you need software 
instruments.  

While audio objects consist of pre-made recordings, the sound from software 
instruments (synthesizers) is created during playback on the computer. The resulting 
sounds are not as refined but allow for total control of every musical detail.  

A selection of the loops included in Music Maker are intended as control files for 
software synthesizers (MIDI loops). The sound progressions of these loops can be 
edited in the MIDI Editor (view page 80). You can also record your own melodies by 
connecting a MIDI keyboard. 

In MAGIX Music Maker 2013 a distinction is made between VST instruments and 
object synthesizers. 

Object synthesizers are standalone objects in the track and can be moved, cut and 
arranged just like any other objects. Various object synthesizers can also be put 
together on one track. The control of the sound creation takes place within the object 
synthesizer. 
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VST Instruments are always loaded to one track and controlled by MIDI objects in the 
track. MIDI objects only contain control information (notes) that is used to create 
sounds in VST instruments. Various MIDI objects arranged on one track control the 
same synthesizer and that means a maximum of one instrument per track. 

To open the folder with the software instruments in MAGIX Music Maker 2013 
switch to the Instruments folder in the Media Pool. 

 

• As with all Media Pool objects, the instrument that is selected will automatically 
produce a preview sound.  

• Drag the desired synthesizer into an arrangement track by holding down the 
mouse button.  

• For object synthesizers a Synth Object will be created and a settings dialog for 
the synthesizer will open. You can "program" the synth here. The resulting Synth 
object can be moved, cut, stretched or adjusted with effects just like an audio 
object. 

• VST instruments are loaded to a track and a preset MIDI object is added to the 
track. Double-clicking on it opens the MIDI Editor where you can make 
adjustments to the melody.  

• Or you can switch the the Media Pool  Keyboard view. Here you can play the 
synthesizer using your computer keyboard. You can also record your playing by 
clicking on the large red record button. 

Tip: You can access the sound programs of the included VST instruments Vita 2 and 
Revolta (only Premium version) with the button on the far left of the track. 

Experiment with the various synthesizers in MAGIX Music Maker 2013 and take 
advantage of each of their individual strengths. 
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Add videos or images 
Perhaps you would like to make a video clip? To do so, open a folder with video or 
photo files in the Media Pool under Data Manager and select the ones you want to 
use in your project. 

You can activate a video monitor using the middle button on the right below the 
arranger. 

 

A preview of the selected video file is shown on the video monitor. 

 

Once you have found a matching video, 
use the mouse button to drag it onto any 
track (like previously with the audio files). 
You can place as many video and photo 
files as you like under your music.  

You can adjust the length of the individual 
image objects with the help of object 
handles (view page 24). 

In the Media Pool templates you will also find animated text templates (view page 
176) (Titles), video effects (Video FX) and visualizations that you can use to spice up 
your videos. 

Effects 
You should take time to experiment with the effects. In the context menu you can 
select the effects for the objects. Effect modules can be opened and adjusted to get 
the exact sound you want. 

Effects can also be dragged onto objects by holding the left mouse button or double-
clicking. Simply open the Templates folder in the Media Pool and test out the effects 
listed in Audio FX by clicking on them. As with all other entries in the Media Pool, 
effects in this folder always have a preview as well. If you like an effect and wish to 
apply it to an object in the arranger, simply click on it, drag it onto the object, and 
release the mouse button. 
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Tip: Use the object inspector in the Media Pool to display all important object 
effects. 

Another option for using effects is to apply Track Effects. These effects influence all 
of the signals on a track making it a quick way to apply the same effect to several 
objects. They also affect the audio output of track synthesizers. There are no audio 
effects available for MIDI objects so object effects can't be used on them. 

 You can also select from a variety of useful track effect presets by clicking on 
the button on the corresponding track. These are organized according to the 
instruments and applications. 

 

Export Arrangement 
When your arrangement is ready, you would normally want to do something with it 
"out in the real world". For example, show it to friends. To do so, you must first export 
your work from MAGIX Music Maker 2013.  

You can find the most important functions in "File > Export > Common export 
functions". 

 

• Export as MP3: You can transfer your 
arrangement in MP3 format to a 
portable player. 

• Burn onto CD or DVD: The classic 
way to present music. You can burn 
single songs or complete albums 
directly to CDs.  

Tip: In the Premium version, you can 
use the integrated CD mastering and 
burn program to do this. Click on "File" 
and select the "Export arrangement -> 
Burn audio CD-R(W)" option to export 
your arrangement. The arrangement 
will be loaded into the CD mastering 
program MAGIX Music Editor and can 
be burned straight to disc from there. 
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• Upload to the MAGIX Online Album: When the song is finished, it should be 
heard not just by your friends, but preferably the whole world. The easiest way to 
do this is with a MAGIX Online Album of your own.  

• Publish on Facebook (YouTube/SoundCloud): With these options you can 
publish directly on the popular online platforms. 

• Export in various formats: In the "File > Export" menu you will also find all 
supported export formats for creating an audio or video file (for music videos) 
from your arrangement. 

Note: The export calculations don't affect playback performance. Even if playback on 
your computer begins to stutter because too much RAM is being used for videos 
and effects, the export file will still be calculated correctly. We recommend placing 
already finished passages of complex arrangements via the export or mixdown 
function into a single file to free up some processing power (and tracks). This kind of 
file can be reloaded into the arrangement and edited further with the other parts. 

Burn audio CD 
To burn an audio CD, first export your arrangement as a WAV file: 

• Click "File" and select the "Export arrangement -> Audio as wave..." option.  

The WAV file created can be burned as an audio CD with the included burn program 
MAGIX Speed burnR. 

Tip: You can use an integrated CD mastering tool in the Premium version and a burn 
program to do this. Click on "File" and select the option "Export arrangement -> Burn 
audio CD-R(W)" to export your arrangement. The arrangement will be loaded into 
the CD mastering program MAGIX Music Editor and can be burned straight to disc 
from there. 
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Arranger 

Tracks 
The arranger is organized into tracks. Each track corresponds to a channel on the 
mixer (view page 179). You can use this channel to control volume, apply effects, 
mute or solo all of the objects in the track. The loops of the same instrument are 
typically grouped together on one track (bass track, vocal track, etc.) which makes it 
easier to edit them.  

 

  
Additional tracks can be added with the button at the bottom of the arranger 
or by selecting the "Add track" option in "Edit" menu (Ctrl + I) 

In total, up to 96 tracks can be used for an arrangement. To move a track you can 
open the Effects menu (view page 31) of the track and select "Move Track Up" or 
"Move Track Down". Tracks cannot be deleted, but those that don't have any audio 
objects are automatically deactivated and that means they don't use any computing 
power! 

If the tracks in the arranger are not long enough, you can increase their length by 
pressing the minus button (-) to the right. The size of the arrangement adapts itself 
automatically when objects exceed the space for them on the right-hand side or when 
new objects are loaded. 
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Track headers and Instrument icons 
At the beginning of each track there is a track header with controls and displays. 

 

 Instrument icon: When you drag & drop a MAGIX Soundpool sample onto an 
empty track an icon will appear in the track header. You can replace this icon by 
right-clicking on it and selecting a different one. A left-click on the icon opens 
the menu for the track synthesizer (see below). 

 The Peak Meter can be found beside the icons. This way, you can control the 
volume of the track and see if the track produces any audio sound at all. 

 The  track name is located to the left of the track number. You can rename the 
track by double-clicking on the field. 

 You can use the Mute button to shut off the sound of a track or the Solo button 
to play only the sound from one particular track. The Solo function is not 
exclusive which means you can use it to play back the sound from several tracks. 
On the lower border of the arranger underneath the track headers you will find 
the buttons Reset Solo / Mute which you can use to restore the previous solo 
and mute settings of all tracks with one click. 

 

 
 

Left-clicking on the field with the instrument icon opens a menu with the 
sounds from the included software synthesizer which can be loaded to 
the track. This software instrument will then be used by all MIDI objects 
in the track. You can find out more about this in the chapters Software 
Synthesizers (view page 102) and MIDI objects (view page 80). 

 

 The track header of a track with a loaded synthesizer has a 
few additional controls. With the arrows (2, 4) you can 
switch back and forth from the previous to the next sound 
in the software instrument and the gear icon (3) opens the 
instrument editor. 

 

  Here you can open the Track Effects menu. In it you will find presets for 
track effects sorted according to the instrument type. 
With the "Move track up/down" commands you can sort your tracks. 

 

  With REC you can activate the track for an Audio or MIDI recording. 
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 A simple click puts the track into Audio Recording mode. This also 
activates monitoring which means you can hear the input signal of 
your sound card during playback. (Find out more in the "Mixer" 
chapter, "Recording/Live Monitoring" (view page 182)) If you start 
recording now (R key), the audio recording dialog (view page 60) will 
open.  The recorded audio material is added to this track in the 
playback range (view page 34). 

 Clicking this button again puts the track into MIDI Recording mode. If 
a software instrument is loaded, you can play it with a hooked-up MIDI 
keyboard (Monitoring). If you start recording now, a new MIDI object 
will be created in the track, the MIDI Editor will open and the MIDI 
recording  (view page 86) will begin. 

 

Zooming 
The vertical zoom function sets the number of visible 
tracks. On many tracks zooming is useful to be able to 
selectively edit a track or an object in full view. 

Use the horizontal zoom functions to set up the visible section of the arrangement on 
the timeline. 

Clicking and dragging on the bottom border of a track allows you to adjust the height 
of the display. 

Move/Zoom with the scroll bar 
If you move the mouse to the edge of the scroll bar, the cursor will turn into a double-
arrow symbol which can be used to select and compress/stretch the scroll bar. This 
way, you can zoom in and out quickly. Dragging the middle of the scroll bar moves the 
visible section. 

You can tell which part of the entire arrangement is being played by the size and 
position of the scroll bar. If the whole arrangement is displayed, then the scroll bar will 
fill out the bar. Complete view may be set by doublke clicking the scroll bar. 

A track may not be diminished without any limit, and the number of maximum 
displayable tracks is also limited, meaning not all tracks may be able to be viewed at 
once. 

Zoom buttons 
 Zoom menu: Certain zoom levels may be selected by right clicking the 

horizontal scroll bar or by clicking the zoom menu. You can also jump to 
certain positions in the arrangement here.  

 Enlarge objects: Vertical and horizontal zoom stages are enlarged so that 
all of the selected objects are displayed at maximum size. If the function is 
switched off, the regular zoom stage will be restored. 
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 Optimize view (view page 223) 

 Zoom buttons: Buttons for zooming in and out 
 

Move/Zoom with the mouse wheel 
The visible section can be moved, reduced, and increased in size by using the mouse 
wheel.  

Moving a visible section Mouse wheel 

Enlarge or reduce the visible section (Zoom) Ctrl + Mouse wheel 

Displayed tracks Shift + Mouse wheel 

Number of displayed tracks, increase/decrease track 
height 

Ctrl + Shift + Mouse 
wheel 

 

Grid 
Timestretching in the arrangement is displayed by the vertical progress of the tracks. 
To structure this progression, a timeline displaying time units has been positioned at 
the top of the first track.   

Two consecutive objects will seamlessly snap together even if they are on different 
tracks. This avoids undesired gaps or overlaps. 

The bar grid makes sure that the objects and the start, end & play markers only snap 
into place at specific positions so that they can be positioned precisely according to 
the beat. 

  The grid width can be set using the button to the top left. 

If, for example, "1/2 beat" has been set, then the objects and markers snap into 
position at all half beat positions when moved. This way there won't be any gaps 
between the objects and precisely beat-matched cuts are possible. The selection 
ranges from full beats to 1/16 grid sizes. Triplet values are also possible.   

The "Frame" setting allows fine positioning using the time code. The time display in 
the timeline and transport control automatically changes from bars:beats:ticks to 
hours:minutes:seconds:frames. 

"Objects" deactivates the beat grid and the grid will now only affect the object edges. 
You can also deactivate the grind entirely by selecting "No grid" or by pressing "Ctrl + 
F12". 

"Select beat type" switches the timeline to irregular bars like ¾ beat. 
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Playback area, Start and end markers 
In the upper area of the timeline, there are two markers between which playback area 
is displayed, and this area can be played back as a loop (endless).  

 

The length of the playback area is shown in blue. The number before the point 
indicates the number of bars, the number following it indicates the number of 
fragments corresponding to the selected grid, e.g. 3.3 on a 1/16 grid = 3 bars and 
3/16. A tilde (~) in the display means that the playback area doesn’t have the exact 
raster length and the loop is therefore "non-circular". Double clicking on the playback 
area sets it to cover the whole arrangement; double clicking again sets it between the 
start of the arrangement and the last object. 

This area also determines which positions are copied or inserted into the clipboard’s 
memory by the the edit menu commands "Edit range" or the keyboard shortcuts "Ctrl 
+ Alt + C" for "copy", "Ctrl + Alt + V" for "paste" or "Ctrl + Alt + X" for "cut".  

The right end marker is always moved together with the start marker so that the 
length of the looped playback area remains constant as the start marker is moved. So 
always move the start marker first and then the end marker.   

The start and end markers can be moved in different ways with the mouse. You can 
move them to any position via drag & drop or directly with a mouse click: a left mouse 
click in the timeline moves the start marker; right clicking moves the end marker. 

It’s even easier with the keyboard: The cursor keys move the playback area forward or 
backward by a whole playback area’s length. Press "Ctrl" as well to move the playback 
area by a quarter of its length. "Shift" + cursor keys halves or doubles the playback 
area’s length. 

"Ctrl + Shift" +cursor keys enables you to lengthen or shorten the playback area by a 
bar. Use this function as well to quickly move the playback area onto a smooth bar 
length. 

When you move the playback area while a playback is running, the old area is always 
played to the end and smoothly changed into the new one after. In this way you can 
remix your tracks in real-time with the keyboard! 

Note: If the starting marker does not move to the right with a left click or via the 
keyboard, it is because the end marker would then have to be shifted beyond the 
end of the arrangement. In this case, move the start marker via drag & drop or 
position the end marker!  
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Move playback marker 
The playback marker can be moved independent of the start marker. Just click on the 
lower portion of the timeline Once the playback marker reaches the end marker 
playback will recommence at the position of the start marker. If the playback marker 
has been set to the right outside of the area, the arrangement will be played to the 
end. The stretched out playback range will then be played as a loop. 

Transport Bar (playback functions) 
The transport bar's functions enable you to control the playback behavior of the 
arrangement using the mouse. 

 

Tip: Using the space bar on your computer's keyboard you can start and stop 
playback much more easily. An overview of all keyboard shortcuts is available at the 
back of the manual. 

  

Playing an endless loop (looped object) can be deactivated here. 
Playback will always stop when the end marker is reached. 

  

Back to start: With this button the start marker is quickly moved to the 
beginning of the arrangement.  Another click on "Back to start" moves 
the start marker and the playback range to the beginning of the 
arrangement. 

  

Stop: This button ends playback. The playback marker returns to the 
position from which it started. 

  

Play/Pause: This button starts continuous playback of the 
arrangement. If the playback marker reaches the end marker, the range 
between the start and end marker will be played back as a loop. 
Another click on Play stops it at the current position of the playback 
marker (Pause).  

  

Record: Depending on the settings in the track header (view page 31) 
an audio (view page 60) or MIDI recording (view page 86) will be 
started. 
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Volume control 

 

The volume control is to the left of the transport controller. With it, you can quickly 
control the overall volume of your arrangement. To regulate the volume of individual 
tracks, use the mixer (view page 179). 

Clicking on the speaker icon mutes the entire sound output. 

Under the volume control there is a peak meter that displays the master signal peak 
level and an indicator for incoming MIDI signals. 

Time display 

 

The time display is beside the transport console. This is where the current playback 
position is displayed. With the position slider you can quickly move the playback 
marker within visible range. By right-clicking it is also possible to switch the time 
display to show the remaining time (relative to the end of the project) or to choose 
various units of measurement, e.g. hh:mm:ss or frames. 

Metronome 

 

If this icon is active, then a metronome (click) will play during playback and recording. 
This provides helps you orient yourself with the arrangement tempo while you make 
your own recordings. 

Tempo 

 

Here, the song's beat is displayed in BPM (Beats per minute). The arrangement 
tempo is set automatically by the first sample used in the arrangement. To enter a 
new tempo, click on the number and enter a BPM value in the field. Finalize the entry 
by pressing the Enter key. The objects in the arrangement are adapted using 
timestretching. 

Click on BPM to open the Tap Tempo Dialog where you can set the tempo by 
"tapping" it out. Simply click the tap button at your desired tempo or press the T key. 
The tempo is measured and displayed in the dialog. Pressing OK accepts the tempo. 
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Arranger buttons 
The Arranger buttons for quickly opening and closing all the most important windows 
can be found underneath the last track in the Arranger. 

Opens the mixer (view page 179) where tracks can be mixed by adjusting 
volume, setting the position in the stereo panorama and adding effects. 

Opens or closes the video monitor (view page 174). The video monitor 
displays the video and images files that have been loaded into Music Maker. It 
can also be used as a peak meter, overview of the arrangement or as an info 
box for help text. 
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Media Pool 
The Media Pool in MAGIX Music Maker 2013 lets you access, preview and load all 
supported media types online and offline, e.g. the included audio and MIDI loops, 
audio CDs, MP3s, software instruments or effects. 

All media types are loaded into an arrangement from local drives or directly from the 
Internet by  double-clicking or dragging & dropping. 

The upper edge of the Media Pool contains seven buttons which operate the Media 
Pool in different ways:  

• The setting Soundpools offers a database view of all Soundpools.  
• The File manager is very similar to Windows Explorer. It controls and loads media 

files of all types from the hard drive. 
• The Instruments (view page 102) setting displays a list of the available software 

instruments. 
• Under Templates (view page 44) you can find the presets for all types of audio, 

video and title effects.   
• The Keyboard enables software synthesizers to be played and recorded directly 

via the on-screen keyboard. 
• The object Inspector offers quick access to properties of objects, e.g. audio 

effects for audio objects.  For MIDI objects (view page 80), a smaller version of 
the MIDI Editor is shown, which allows you to edit the selected object. 

• Catooh connects directly to Catooh (view page 202).  

Preview function 
There is a preview function for all files: By simply clicking an audio object, the pre-
listening function starts via the sound card. Video, graphics and text objects are 
shown on the video screen. 

As the arrangement plays on, you can experiment with sounds from the Media Pool 
(see Smart Preview (view page 57)). 

Note: Even while previewing, audio files are adapted to the current tempo using 
timestretching (you can deactivate this in the "Audio/Video options" menu). 
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Soundpool settings 
This setting can be used to access the Soundpools. You can access the included 
Soundpools through the clearly laid out database view that lets you arrange the 
display of the loops according to styles, instruments and pitch. 

During installation, if you no longer have the Soundpools on your hard disk, insert the 
MAGIX Music Maker 2013 installation DVD into the drive. The contents of the 
Soundpool media will now be imported into the database. Other Soundpool media are 
automatically recognized and added to the media database. 

Note: Under program settings -> General (view page 204), you will find different 
options for maintaining and displaying the Soundpool database. 

 Soundpools already present on the hard disk can be imported into the 
database by clicking "Add styles". 

Soundpools from previous versions of Music Maker or additional Soundpool 
collections that you have purchased can also be integrated into the Media Pool this 
way. 

A Soundpool consists of one or more styles. Styles are sound libraries that belong 
together and cover a certain musical style. The sounds (sample or MIDI loops) of one 
style all have a certain tempo. You can mix loops from different styles, and the 
tempos will be adjusted accordingly. Within a style, loops are ordered according to 
instruments, and one instrument folder contains different sounds. Each sound can 
have a different pitch (except for drums and effects sounds). 

 

All of the styles that are available in the database are displayed in the first column. 
The second column lists the instruments.  

The list of samples found is created after entry selection in the first two columns. 
With "Ctrl + click" you can reduce or expand a selection. No selection ("Ctrl + click" 
on a single selected element) or clicking on "Select all" shows all entries from this 
category. If you select an instrument (e.g. "Drums" and "Percussion") and no style, all 
drums and percussion samples in the whole database will be displayed. 

Simply clicking on the loop starts the preview. Clicking on the numbers 1 to 7 changes 
the pitch. The pitch for that loop is set when you click on a different loop. 
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You can sort the list according to criteria (Type, Name, BPM, Length in bars, Favorite, 
Style) by clicking on the column header. 

The list can also be filtered: 

  

Clicking on the star in the sample list marks the 
loop as a favorite. You can use the filter 
"Favorites" to display only the loops that you have 
marked as favorites. 

You can display only audio loops, MIDI 
loops or both. For the difference between 
audio and MIDI loops see below. 

An entry field for full text search is located above the match list. 

In the search field, you can search the list of the samples 
found according to a certain sound file name. 

 

 Sound Vision view: This button displays all Soundpools as 
galaxies. 

 

Audio Loops and MIDI Loops 
In Music Maker a distinction is made between audio and MIDI loops. Audio loops are 
normal audio files that have a specific number of bars (1, 2, or 4) and can be played 
back as loops. MIDI loops consist of a MIDI Take (view page 54) that contains the 
notes (MIDI file) and the sound settings for a particular software instrument. Both 
types of loop have advantages and disadvantages:  

 Icon Advantages Disadvantages 
Audio  • Recordings made on 

professional studio equipment 
with top quality instruments 
and expensive synthesizers. 

• They require less computer 
power than sounds reproduced 
in realtime. 

• If the original tempo of the loop 
is changed with timestretching 
the sound quality can be 
negatively affected. 

• The melody and rhythm are 
already set in the recording and 
can only be adjusted with 
complicated pitchshifting. 

MIDI  • Pitch and tempo changes don't 
require additional computer 
power and don't affect the 
sound quality. 

• You can use the MIDI Editor to 
change the melody of the loop 
any way you want. 

• Software instruments process 
the sound in realtime and 
therefore require more 
computer power. 

• Even the most high-quality 
samples don't sound quite as 
natural as real instruments. 
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SoundVision 

 

This alternative display of the Soundpool library shows all available sounds 
graphically. No matter how large the Soundpool collection is, you can view the entire 
library using this 2-dimensional display. This "galaxy" can now be accessed via the 
mouse to collect all of the sounds you want. 

The large clusters of "stars" are the styles, and these are arranged from inside to 
outside with increasing tempo. Eventually they form a center - the styles furthest out 
have the highest tempo. 

Within a style are the individual instruments  (e.g. keys, pads, sequence) formed in a 
circle, and the drums are in the middle. Every instrument group has a certain color 
assigned to it which is the same in every style. The individual sounds are points 
encircled by the individual pitches, if available. 

You navigate throughout the Sound Vision view by moving the selection displayed 
with the mouse; the mouse wheel enlarges or diminishes the view. The points (which 
symbolize the sound loops) can be manipulated exactly as in the Media Pool list view, 
i.e. select by double clicking and load by double clicking or via drag & drop. 

File manager settings 
MAGIX Music Maker 2013's file manager works very similarly to Windows Explorer. 
It can be used to access and load media files of all kinds, e.g. videos, bitmaps, MP3 
audio files, audio CD tracks, RTF text files for titles. 

The Media Pool consists of a file list to the right (the actual “Media Pool”), in which all 
loadable media types (and, if required, further subfolders) are listed, and the 
navigation area on the left-hand side. 

In the file list, all supported multimedia files and subdirectories of the currently 
chosen directory are displayed. All entries can be loaded into the arranger tracks by 
double clicking or via drag & drop. 

In the navigation area, you can find different buttons for directly accessing preset 
subfolders.  

You can right click in the file list to define further buttons ("links"). Switch to the 
folder which you would like to create a link to and select the option "Link to folder" 
from the context menu. 



 

42   

www.magix.com 

Navigation buttons 
Forwards/Back  The "Back" button always returns you to the 

folder where you were previously. 
Up 

 
The "Up" button brings you to the next highest 
folder level. 

View  These buttons switch the file view list between 
icons, lists, or details. 

 

Various file list view modes 
The file list displays all supported multimedia files and subfolders of the currently 
selected folder. Three different views (list, detail, large symbols) can be set by right 
clicking on the options or Media Pool's context menu.  

 

List: Only file names are listed. 
This view mode displays the 
most files simultaneously. 

 

Details: The details section 
displays the type, size, and date 
of modification for every media 
file beside the name. The list can 
be sorted by clicking on any of 
these details.  

 

Large symbols: These can be 
quite useful, since they show a 
preview frame for each movie 
and picture file. This allows you 
to sort through the material 
quicker. The disadvantage is that 
it takes longer for the file list to 
be displayed.  

 

Deleting, copying, and moving files 
All files listed in the media window can be selected, deleted, or moved into other 
folders via drag & drop, just like via Windows Explorer. This way, all objects desired 
for placement in an arrangement can be collected in a separate folder beforehand. 

Additional functions can be accessed via the context menu, i.e. by right clicking an 
entry. 
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My Projects 
This button opens the "My Projects" folder. This is a subfolder of "My Projects" that is 
named after the program (i.e. MAGIX Music Maker 2013, only featuring "_" instead of 
empty spaces). This is created automatically when the program is installed. All new 
recordings and arrangements are saved here automatically as a preset, and finished 
arrangements are exported here. You may change the save location as you see fit via 
Program settings > Folders (view page 204, view page 203). 

My Files: This displays the contents of the "My Files" folder. This is normally the save 
location of videos, pictures, music, etc. (in the corresponding subfolders). 

My MP3s 
This provides quick access to your own MP3 collection. When this button is pressed 
for the first time, you can select the folder where your MP3 files are saved. You may 
also change this path later via "Program settings", the "Folder" tab (Y key or "File" 
menu > "Settings" > "Program settings"). 

Database 

 This button displays the media files on your computer in a well-
structured database view.  

This means the files are no longer displayed according to where they are stored in the 
different folders but are grouped according to general characteristics. The top "folder 
level" is the difference in audio, video or image files; subfolders would be, for instance, 
the date for photos or the artist for MP3 files. 

In order to present media data on your PC in a database view, you first have to add 
them to the MAGIX database. To do this, click on the database button to the right and 
select the option Start media manager for photos and music.  

This opens the corresponding MAGIX program and the database scan function of the 
program.  

MAGIX Music Maker 2013 comes with the free photo and music management 
programs MAGIX Photo Manager and MAGIX Music Manager. If you have the 
corresponding free versions, MAGIX MP3 Maker or MAGIX Digital Photo Maker, 
they will be used instead. 

By right clicking on "Database" and clicking on "Database search", you can open a 
special search dialog in which you can carry out a targeted search for media. 

Search the database 
Quick search: Simply enter a keyword and highlight the data type (photo, audio, 
video). All available Database columns are searched for the keyword. 

Expert search: Here you can restrict your search by stating search criteria in the 
following way: 
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 Database column Condition Comparison item 

e.g. dimensions greater than 800 

You can search up to three database columns that are connected via "and" or "or" 
simultaneously. 

"AND" means only those files will be listed that match all criteria.  

"OR" means only those files will be listed that match at least one of the criteria. 

Instrument settings 
This button opens the folder containing your software instruments. You can read 
more on this in the Software Instruments (view page 102) chapter. 

Template settings 
This opens the folders for installed effects presets. Saved audio and video effects 
presets as well as title templates also land in these folders, so that over time a 
complete library of your own presets will develop.  

 

The buttons to the left open the folders for audio effects ("Audio FX"), presets for the 
Vintage Effects Suite ("Vintage FX"),  presets for the Live Performer ("Live Pads"), the 
LiViD drums synthesizer, title templates ("Titles"),  video effects ("Video FX", "Video 
Mix FX"), and animations ("Visuals"). 

You can also add effects via drag & drop. Simply drag these onto the corresponding 
object using the mouse. 

The context menu for audio objects enables you to to set audio effects in the effects 
rack (view page 132) precisely! 
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Keyboard settings 
The keyboard enables software synthesizers (view page 124) to be played and 
recorded directly via the on-screen keyboard. 

 

If a track synthesizer is not present, then a new track will be added and a new 
synthesizer plug-in will be added when the view is switched to "Keyboard" (Vita with 
Sound Acoustic Bar Piano).   

The keyboard always controls the synthesizer in the track for which MIDI recording 
has been activated. 

You can click the keyboard with the mouse to play the instrument. The closer to the 
bottom edge you click on the "virtual keys", the louder the sound will play. Of course, 
you can't seriously play music by clicking with the mouse (this function is more 
suitable for testing out sounds quickly). That's why you can also play the keyboard 
with the keys on your computer's own keyboard.  

Note: This works only after you first click once on the keyboard using your mouse. 
Otherwise, pressing the computer keys will function as key shortcuts (view page 
232) for the different features in Music Maker. If the computer keys control the 
program's keyboard, then the piano keys feature the corresponding characters on 
your keyboard.  

 
A sound program for the synthesizer may be selected from 
this list. 
This button opens the editor window for the synthesizer for 
fine tuning the sound. 

Object Inspector settings 
The Object Inspector offers quick access to properties of objects, e.g. audio effects for 
audio objects. For MIDI objects (view page 80), a smaller version of the MIDI Editor 
is shown, which allows you to edit the selected object. 
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Audio Objects 
If an audio object is selected the object inspector will open featuring the audio object 
view 

 

This displays the available object effects (view page 133) in a clearly laid out list. The 
button at the front switches the effects on and off. Clicking on the effect name opens 
the settings dialog. 

MIDI objects 
If a MIDI object is selected, then the Object Inspector shows a smaller version of the 
MIDI Editor. The MIDI Editor in the Object Inspector operates in the same way as the 
"bigger" version in its own window, but the menu and several playback and recording 
settings are not available. 
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For more information, please read the section MIDI Editor in the chapter "MIDI 
objects"! 

Setting  Catooh 
You can preview multimedia files from the Online Content Library Catooh, load them 
into the arrangement, and edit them further . 

Please read the chapter entitled Catooh (view page 202)! 
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Mouse modes 
MAGIX Music Maker 2013 offers special mouse modes for arranging and editing 
objects. 

 
A small arrow next to the mouse pointer symbol allows different modes to be 
set. 

Move selection 

 
This is the preset mouse mode in which most changes are made. 

Left clicking selects an object. When the "Shift" or "Control" keys are pressed, 
multiple objects can be selected.  Hold down the mouse button to move selected 
objects.  

In this mode the objects can be faded in or out or their lengths can be changed using 
any of the five handles. Please refer to the "Arranging objects" (view page 50) 
chapter. Right clicking on an object opens the context menu with the most important 
effects and settings available for that specific object. 

If an effect curve is active in the deluxe version, the curve handles can be selected and 
moved. Double clicking on the curve creates new handles. 

Shortcut:   Ctrl + 1, number key 1 

Move to track 

 
This mouse mode behaves basically like the mouse mode for individual objects, 
but moving objects  

results in all other objects behind the object moving in sync on the track. This is 
practical if space is needed at the start of a track, since all objects can be moved 
together without moving them underneath each other. 

Shortcut:   Ctrl + 2, number key 2 

Move all 

 
This mouse mode behaves in principal just like the "Single object mouse mode",  

but during moving, all objects on all tracks will be moved together from the mouse 
position. 

Shortcut:   Ctrl + 3, number key 3 
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Draw 

 
In this mode you can insert further similar objects behind an already loaded 
object. 

Starting from the first object, the following objects are always inserted synchronously 
so that you can also think of this mode as the insertion of a "Mute" automation from a 
continuous loop. You can read more about this in the section "Drawing in loops (view 
page 54)" in the chapter "Arranging objects". 

Shortcut:   Ctrl + 5, number key 5 

Split 

 
You can split objects quickly with this mouse mode in order to remove 
unwanted parts or attach various effects to parts 

of objects. 

Shortcut:   Ctrl + 6, number key 6 

Stretch 

 
This special mode is for customizing the length of objects.  

Objects can be on the lower handles stretched or compressed. Audio material is 
therefore lengthened via timestretching without changing the pitch itself The middle 
object handles allow the object's pitch to be changed using pitchshifting in the range 
of -7... +7. 

Shortcut:   Ctrl + 7, number key 7 

Preview audio 

 
This mode allows you to preview audio objects (as long as the mouse button is 
held down)   

for the entire duration and independent of the start and end markers in the timeline. 
Other object types are protected against unwanted moving. 

Shortcut:   Ctrl 8, number key 8 

Scrubbing 

 
By holding down the mouse button, the arrangement can be previewed at the 
point where the cursor is positioned.  
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The playback marker follows the mouse movements. This mode is especially suited to 
searching for specific parts of an arrangement. 

Shortcut:   Ctrl + 9, number key 9 

Replace 

 
This mouse mode simplifies searching for suitable samples: Left mouse click on 
a MAGIX   

Soundpool object to switch the object automatically with another from the same 
instrument category. Shift + left mouse click keeps the object but changes the pitch. 
Ideal for quick experimentation! 

Shortcut:   Ctrl + 0, number key 0 

Context help 

 
This mouse mode allows you to open the corresponding "Help" section by 
clicking on any area of the MAGIX Music Maker 2013 screen. 

 
Shortcut:   Alt + F1 
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Arranging Objects 
In MAGIX Music Maker 2013 you can jointly and uniformly load, arrange, edit, and 
export different multimedia file formats. This chapter describes the basic way of 
working with multimedia objects. This includes audio objects, video objects, graphics, 
midi objects, and synth objects. Later chapters will describe the particulars of the 
respective formats. 

All object editing is virtual, non-destructive, and is calculated in real time during play. 
The multimedia material is thus not destroyed (non-destructive editing) and any 
change can be cancelled with the multi-stage undo function ("Ctrl + Z"). You can 
experiment to your heart’s content without having to fear that you will change or 
damage the original material. 

Loading and saving arrangements 
"Arrangement" refers to the objects found in the arranger (Audio, Video, MIDI, songs, 
graphics, synthesizers) along with all its positions, fades, length, volume, brightness 
settings and effects. 

Arrangements can be saved via the menu "File"as an MMM file and loaded again.  

When loading arrangements you must ensure that all the used objects are available in 
their respective folders. Often is it advisable to "Save Arrangement and Used Media" 
from the menu "File" > "Backup". Then the entire arrangement with all objects and 
effects are saved to a configurable folder on the hard disk and can be easily 
downloaded from there. 

Multimedia files and objects 
All multimedia files supported by MAGIX Music Maker 2013 can be previewed or 
listened to in the File Manager by clicking and dragging into the arranger via drag & 
drop. The files are displayed as objects in the tracks after the mouse is released.   

Using the "Tab" button, you can switch between two object display views.   

In alternative display modes, the objects are not represented frame by frame, but 
simplified. This is useful for quicker representations of video objects: RAM is saved 
and the overall performance improved. Audio objects will be shown using one or two 
(for stereo) waveform representations.  

Right clicking on an object opens the context menu with the most important editing 
options available for that specific object. 



 

52   

www.magix.com 

Select objects 
To edit or delete objects using the menus, you must first select them. To do so, simply 
click on the object you wish to select. When the "Shift" key is pressed, multiple 
objects are selected. Object modifications like cutting, moving, effects assignment 
and so on, apply to all selected objects together. 

The handles of selected objects light up to show that the accompanying object has 
been selected and can be edited using the menu functions. 

Several objects can be selected quickly by clicking on the first object in the first track 
with the mouse and dragging out a square for selection. All objects entirely or partially 
within the square will be selected (rubberband selection). 

Mute objects 
Each object can be muted individually. Simply select the objects you want to mute 
and press Ctrl + M (or use the corresponding command from the context menu). 

Build or split object groups 
Several objects can be combined to make up a group, to avoid the objects being 
unintentionally moved out of relation to each other. 

Once they are combined, clicking on one object of a group will select the entire group.   

To group or separate groups, use the buttons in the toolbar or the corresponding 
commands in the "edit" menu. 

Splitting objects 
All objects can be split. Each object section that is created becomes a separate object. 
To do this you can select the object you want to cut and move the playback marker to 
the position where you want to cut. .  

 
Click on this button in the upper toolbar (view page 232) or click on „Edit” and 
select the option „Split objects” or press the „T” key. It's even easier with the 
mouse mode "Split objects (view page 49)".  

To rejoin these split objects at a later stage, simply highlight the individual parts and 
select the command "group" to join the selected objects together into one group.  
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Duplicate objects 
Objects can be duplicated very easily in order to create larger arrangements. First, the 
objects that need to be duplicated must be selected. 

Then select the command "Edit menu -> Duplicate objects" 

A copy of the object appears right beside the original which can be moved to any 
position with the mouse. 

It’s even faster if you click on the object that has to be copied and hold down "Ctrl" 
at the same time. An object is then created which can be dragged to the desired 
position. Furthermore, object copies require virtually no additional memory! 

Another way to duplicate is by using the copy/edit commands from the "Edit" menu. 

Object handles 

 

With the help of the object handles, fine positioning, volume and brightness settings, 
fading in and fading out as well as loops can be carried out directly in the arranger.  

All editing is carried out in real time and is already calculated during playing. The 
multimedia material is not destroyed in the process (non-destructive editing); any 
change can be cancelled with the multi-stage undo function ("Ctrl + Z"). 

Object fades 
Use the handles on the top left and right to fade an object in or out. By fading objects 
in and out onto different tracks, it is possible to produce crossfades between different 
objects. The length of the crossfading can be directly regulated with the handles.  

Shortening or looping objects 
Objects are "cut" virtually by "compressing" them with the mouse. "Pulling" them to 
the right will stretch them, which results in the object being played as a loop until the 
play cursor reaches the end of the object representation. In this way it is possible to 
very quickly create an entire drum track from one single drum loop or to create a long 
video from a short video sequence. 

Guide the mouse to one of the bottom corners of the object until the mouse pointer 
turns into a stretch symbol. Now you can stretch or compress the object until it has 
reached the desired length. 
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Normally an object is always looped over the full length of the underlying data 
material (audio or video file). To set a clip from a file as a loop, shorten the object at 
the front and the back with the handles and choose the command "Edit menu -> 
Insert user-defined loop". This function is very useful for setting your own recording 
as a loop, as the silence at the beginning of a recording can be cut away. 

Adjusting volume/brightness 
With the volume/brightness handle in the top center of the object, you can change 
the volume of audio and MIDI objects or adjust the brightness of video and bitmap 
objects.  

If several objects are played in parallel, it is possible to individually adjust the volume 
or brightness ratios between objects in this manner.  

The volume and brightness ratios between tracks are adjusted in the mixer. 

"Draw in" loops 
Audio loops can be drawn into the arranger tracks with the mouse. 

 
For this you have to set the mouse mode to "Draw objects" by clicking on the 
corresponding icon in the mouse modes menu. Now an audio sample has to 
be loaded which will serve as a template and which will then be drawn into the 
following area of the track as a loop in the track. 

 This works as follows: 

1. Load any loop from the Media Pool into the arranger. 

2. Click on an area further back on the same track and hold down the mouse button to 
draw in the loop. 

Starting from the first object, the drawn-in loop area is always synchronous with the 
beat. This means that the drawn-in loop is not played from the beginning, but rather 
starts from the position where the original loop would be if you had continued to this 
position. Or, to put it differently, a running loop can be found on the track and you can 
draw in at which position you can hear it ("Mute automation").  

The synchronous start of the object in this mode has another consequence: If an 
object is moved, then only object borders are moved, but the underlying loop, 
however, always remains intact.  

Takes 
Every object can be saved as a "Take". Takes save all editing done on an object, like 
object length, fade settings and all object effects. MIDI takes save the instrument 
controlled by them (MIDI output or software instrument). 
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Takes are saved as "TAK" (*.tak) files and take up virtually no space on the hard disk. 
This means you can cut a sample, add various effects to it and save it as various takes 
in order to use these together with all their editing in other MAGIX Music Maker 2013 
arrangements. Instead of repeatedly saving the original sample, only the object and 
effect settings are saved. You can also save Synth objects (view page 124) as takes 
which creates your own preset libraries for the synthesizer. 

 The MIDI loops included with MAGIX Music Maker 2013 (you'll recognize them 
in the Media Pool by this icon) are also takes because the MIDI files (view page 
80) only sound the way they were intended when combined with the right 
synthesizer sound. 

Attention  When loading takes, the audio or video file for which the take was added 
must be in the original folder. 

Keyboard shortcut:  Alt + Shift + S 

Object properties 
This function displays all the information about the currently selected objects, such as 
file name, position on the hard disk, tempo, etc. The object editor also defines the 
foreground and background color of every object in the arrangement. 

In the "Tempo/Pitch" tab, information on the patched/determined tempo and pitch of 
the audio object is shown. Furthermore, there is an overview of how the various 
timestretching/pitchshifting operations affect the entire audio object. The 
tempo/pitch adjustment when loading the sample, the effect of the master tempo 
fader, and the time processor as object effect tracks are offset against one another, 
but they may not mesh properly. For this reason, there are two buttons which can be 
used to double/halve the object speed. Try using these buttons if the tempo of some 
loops is incorrectly interpreted as twice or half the speed. 

Mixdown audio 
If the arranger becomes too full to manage, the system is out of RAM, or you just 
want to ”summarize” your production, use the mix down function to convert the 
entire audio arrangement into a single audio and/or video file. 

To do so, choose the "Mixdown" function from the "Edit" menu. You can choose a 
name and a destination for storing the mix down object. The default directory is ”My 
Projects”. If only audio objects are in the tracks, a wave file will be created. If audio 
and video objects are combined, you can choose whether an audio or a video file will 
be created. 

The objects of the arranger or the area will be replaced by the new object. 
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MAGIX Music Maker 2013 automatically normalizes the audio file, i.e. the loudest 
part of the wave audio object is identical with the highest figure of the 16-bit 
resolution ceiling. This guarantees the same sound quality, even if you repeat the mix 
down procedure or you combine the mix down file with other wave audio objects 
again and again.  

Tip:The mix down function is very helpful if you want to go on working with the mix-
down object. To create the finished end version of the song or video it is 
recommended to select the "Export arrangement" function in the "File" menu 
instead of the "Mixdown" function. 

Shortcut:   Ctrl + Shift + G 
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Audio Objects 

Audio formats 
MAGIX Music Maker 2013 loads and edits audio files in the formats Wave (.wav), 
OGG Vorbis (.ogg), Windows Media Audio (.wma), MPEG (.mpg), MP3 (.mp3) and 
CDA (audio CD tracks). The stereo or mono data of a file are displayed as an object in 
the arranger of the MAGIX Music Maker 2013. The material will be displayed as a 
waveform, optically representing the sound to make editing easier. 

Along with wave files, MP3 files, OGG Vorbis (.ogg), and ringtones can also be 
exported.  

In addition, the Premium version can load and export the Surround formats (after 
activating the encoder) MP3 Surround, Surround WMA and wave (6-channel 
interleaved). 

Load and process audio files 
All importable audio files can be accessed via the File Manager and previewed (audio) 
by clicking the file name. Tracks from audio CDs can also be integrated by dragging & 
dropping them into the arrangement.  

Editing, fine positioning, volume adjustment, fading in and out, is all processed using 
the "Object" tab directly in the arranger. 

Please see the chapter "Arranging objects" 

Smart preview for the included samples. 
The included samples can be previewed while the arrangement is being played. They 
are always played in time with the song. This means that if you combine loops from 
different styles that have different tempos they will automatically be adjusted to the 
current arrangement tempo even in the preview. 

You can compose a song in realtime by loading different samples and searching for 
suitable new building blocks during playback. 

By simply clicking on the mouse or pressing the Enter key you can add the loop to the 
arrangement or remove it by pressing the Del key.  

Tip: You can also use key commands to quickly change the playback area (view 
page 34) by using the arrow keys. This will let you add loops to your arrangement 
with more precision. 
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Audio recording 
Your own sounds like vocals, speech, noises, or instruments can be easily recorded in 
MAGIX Music Maker 2013 using the audio recording function. 

 Click the REC button in the track box to specify the track for the recording. 
 

The display in the track box will change  
 

Assuming you have everything connected properly (see below), the input signal will 
be played back featuring all track effects (if there are any) (live monitoring (view page 
182)). 

Live monitoring requires the use of ASIO drivers (view page 206). 

 

Click the red button on the transport bar to start the actual recording. 

Connecting the source for recording 
First of all, the source of the audio material must be connected to the sound card 
input. Again, there are several possibilities which primarily depend on the type of 
equipment you have. 

If you are recording from a microphone, then please connect the microphone to the 
microphone jack on your sound card (usually red). 

If you want to record material from a stereo system, then you can use the line-out or 
AUX out jacks on the back of your amplifier or tape deck. This involves connecting 
them to the sound card input (usually red).  

If your amplifier has no separate output (other than for the speakers), then you can 
use the connection intended for headphones for your recordings. In most cases, you 
will need a cable with two mini-stereo jacks. This type of connection has the 
advantage of being able to set the headphone input signal level with a separate 
volume. As headphone connections generally are not the best, it is advised that you 
use the line outputs if possible. 

When recording cassettes from a tape deck, you can connect the tape deck's line out 
directly to the sound card input. 

When recording from vinyl records, you should not connect the record player's output 
directly with the sound card because the phono signal needs to be pre-amplified. A 
more suitable method would be to use the headphone connection or an external pre-
amp. 
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Adjusting the Signal Level 
Adjusting the signal level to the sound card is also recommended to get the best 
sound quality during digital recording. 

Once a recording source is connected to the sound card, the "Record" button opens 
the recording dialog and starts the recording source. 

You can now adjust the recording level with the help of the LED display in the 
recording dialog. For this, you must first check off "Show Levels". 

If the adjustment is set too high, distortion occurs and the incoming signal must be 
reduced. If you have connected the source through either an amplifier or tape deck 
output to the sound card, you can only reduce the signal level in your sound card’s 
software mixer interface. You can access the mixer directly from within the recording 
dialog via the “Recording Level” button. 

If you reduce input sensitivity by using the input fader, the resolution at which the 
analog signal is digitized is also reduced. Try to set these automatic controllers to the 
loudest sound level possible. 

The maximum setting for an optimal level is the loudest part of the material. The 
loudest part should be adjusted to be the maximum. The actual recording begins 
when you press the "Record" button.  At the end of the the recording you will be 
asked if you want to use the recording. Upon confirmation, the newly-recorded 
material will be placed at the next free position of the start maker in the arrangement. 
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Audio recording dialog 

 

Normalize after recording: This option raises your material to the correct volume 
level after recording is completed. In order to achieve good audio results, you should 
try to record the source as loud as possible without overmodulating it. The Peak 
Meter display helps in the recording dialog. 

Audio driver: This selects the sound card for recording. 

Save audio file as/save in the following folder: This select the title of the audio file 
you wish to record. You can also select the folder where you wish to store the file. 

Recording quality: Sets the sound quality of the recording. The preset menu allows 
you to choose between AM tuner, FM Radio, DAT (Digital Audio Tape), and CD 
quality. 

Display volume control (monitor): The peak meter allows you to monitor the level of 
the incoming signal. Please read more on this in the section 'Adjusting levels (view 
page 59)'. 

Record: This button begins recording. The next free track will be used for recording 
the audio material. 

Stop: Click this button to stop recording 
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Play during recording: If this option is active, then the arrangement will play back 
during recording. This allows you to add recordings to the existing arrangement. 

Advanced: Use this button to open a window containing a selection of three special 
functions. 

Advanced settings for audio recordings 
• Mono recording: Activate to record in mono. This reduces the required memory 

space in half. Mono recordings are recommended for voice recordings made 
using only one standard mono microphone. 

• Real-time resample to project's current sample rate: Automatically matches the 
sample rate of a new file to be recorded with the sample rate of the current 
movie's sound track (set in the video recording). 

• Automatic volume reduction of other audio tracks ("ducking"): To add narration 
or other sound material to a video that already has sound volume levels set, 
activate the option ”Automatic reduction of sound volume of remaining audio 
tracks”. This automatically reduces the volume of audio objects in the 
arrangement during the recording session (”ducking”). This is achieved using an 
automatically configured volume curve: Before and after the recording, other 
tracks will be faded in or out, resulting in a homogeneous total volume level. 
(Lowering of volume level during spoken comments is also called "Ducking".) 

Import audio CD 
Importing an audio CD works the same way as adding other audio files into the 
arrangement: 

• Insert an audio CD into the CD/DVD drive of the PC 
• Go to your CD/DVD drive in the Media Pool (File Manager, Computer). The 

individual CD titles appear in the file list. 
• A simple mouse click starts the playback of the CD title for sampling purposes 
• Drag & drop the track from the CD into a track of the current arrangement and it 

will be digitally scanned and copied to the hard-drive. The files will be saved in 
the import folder (may be specified under File > Settings > Program > Folders 
(More information can be found in the section "Folders" on page 209)). 

• The CD track appears in the track as an audio object and can be played back or 
edited immediately. 

CD Manager 
This option opens the CD manager to select tracks from audio CDs and partially or 
fully import them into the arrangement. You can also select and configure the used 
drive if you have more than one drive.  

The CD manager lets you import audio data using most CD and DVD drives. You may 
have to contact your technical support to find out which drive is suitable. The data is 



 

62   

www.magix.com 

imported digitally, thus eliminating loss in sound quality. Audio tracks are imported 
into the arrangement as Wave files. The files are saved in the import folder ("File -> 
Properties > Program settings -> System -> Path settings (More information can be 
found in the section "Folders" on page 209)"). 

To import audio tracks via the CD manager you should proceed as follows: 

1. Insert an audio CD into the drive and select "Import audio CD track(s)" from 
the "File" menu. A dialog with a list of the CD tracks will open. If you have 
more than one drive, you may have to first select the drive containing the CD. 
You can do this in CD drive options. 

2. Select the desired tracks (multiple selection by "Ctrl" + mouse-click). 
3. Click on "Copy selected track(s)...". 
4. The "Import project" dialog will now appear. Here you can enter the file name 

and select the target directory. 
5. The audio material is then copied from the drive onto the hard disk. A progress 

bar is displayed. 
6. Once copying is complete, the dialog will be closed and the tracks are inserted 

into the arrangement as individual objects. 

The track list dialog 

 

On the left-hand side in the list you can choose which track(s)/title(s) you wish to 
import from the CD. Several subsequent tracks can also be selected by holding "Shift" 
and left-clicking; "Ctrl" + clicking selects several tracks; "Copy selected track(s)" 
starts the audio copying process. A new object is created for every track in the 
arrangement and the corresponding track marker is created. 
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Transport control: This lets you start and stop 
playback just like on a real CD player and skip 
forward and backward in the playlist. 

Use the small faders to control the preview volume. With the faders at the bottom 
you can go to a specific position in a track. To import just one section of a CD track, 
choose "Start selection" at the beginning of the section and "End selection" at the 
end. 

Below the transport control details on the total length and the memory capacity of the 
selected track/section are displayed.  

Select all tracks: All tracks are selected, for instance, to copy the entire CD. 

In the right selection box you can select the read speed, and in the left one you can 
select the export mode (see Configuring the CD-ROM). 

CD drive options: Here you can change the settings and select the drive for grabbing 
the CD if you have installed several CD drives (see also CD-ROM drive dialog). 

"Import project" dialog: The "Import project" dialog appears after you have selected 
the option "Copy selected tracks". Here you can specify name and target address of 
the audio files. The audio files are subsequently numbered (name -> name_1.wav, 
name_1.wav).  

Copy-protected audio CDs 
According to the copyright act, it is forbidden to copy a CD with copy protection. 
However, an owner of a CD may create a backup copy for himself. The problem is, 
however, that you cannot create a copy from copy-protected CDs because they 
cannot be read using a conventional PC drive. In order to create a backup of such a 
copy-protected CD, you have to play it on an audio CD player and record it as a 
regular analog recording via the sound card. 

CD/DVD drive list 
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Configuration: This button opens the configuration dialog, where various special 
settings can be made. 

Reset: sets drive settings back to default. 

Add: Creates a new drive in the list, which first requires special settings. 

Delete: Deletes selected drive from the list. 

Load setup: Loads the current drive list and all configuration data from a *.cfg file. 

Save setup: Saves the current drive list and all configuration files in a *.cfg file. 

CD/DVD-ROM configuration 

 

Drive Name: Lets you edit the name of the drive in the list. This is useful if you create 
more than one entry accessing the same physical drive.  

Host Adapter Number: Lets you specify the number of your SCSI adapter - normally 
0. 

Bus ID: Here you can enter the ID of your CD-ROM drive. Be sure to set the correct 
ID, there is no error checking! 

Bus LUN: sets the LUN parameter, normally 0. 

Alias: Lets you select the manufacturer type of your CD ROM drive. 

Normal copy mode: copies audio files without any software correction. 
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Copy mode sector synchronization: copies audio files with a special correction 
algorithm. This is especially useful, since many CD drives have problems finding an 
exact position again and gaps can occur.  

Burst copy mode: optimizes the speed of the copy process, no software correction is 
used.  

Sectors per cycle: defines the audio sector count that should be read from the audio 
CD in one cycle. The higher the number of sectors, the faster the copying process. 
Numerous SCSI systems have problems with more than 27 sectors. 

Sync sectors: sets the count of audio sectors, which should be used for software 
correction. A higher number results in a better synchronization but also in a slower 
copying process. 

Recording Audio CDs 
In some cases the CD can be copied during recording. The CD track is simply played 
on the CD/DVD-ROM drive and recorded by the sound card. You should note that 
the digital track data from the digital analog converters of the CD-ROM drive have to 
be converted into analog signals and then into digital data by the analog/digital 
converters. Depending on the quality of the converter used, this can lead to losses in 
quality. 

Before beginning this, the "Load tracks via record dialog" option under "File -> 
Properties -> Program settings -> Audio" has to be activated. The audio output of the 
CD-R drive must also be connected with the input of the sound card. This is already 
the case with most multimedia PCs (if not, then it can be accomplished with a small 
cable inside the computer). 

When "Load CD tracks via record dialog" is active, song parts can also be added to 
the arrangement without having to load the entire track. 

Change the playback tempo or pitch 
If you want to combine audio material you have recorded yourself from different 
sources, samples from Soundpools, or songs from CD with each other, then you will 
often need to adjust the tempo or pitch of audio objects to match each other. There's 
an automatic function which automatically adjusts the tempo of audio objects when 
they are loaded to the arrangement's tempo, plus advanced tools like the Remix 
Agent and the Loop Finder (view page 220). 

Automatic tempo adjustment when loading 
In general, MAGIX Music Maker 2013 automatically adjusts audio files to the 
arrangement tempo. In normal cases, you won't need to worry about the different 
tempo of audio files and Soundpool samples, since these are automatically matched. 
But since automatic processes can fail too, the following process explains when you 
may need to "manually" adjust things. 
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In the new arrangement (empty), the tempo will be determined by the first samples 
loaded into it. All additional audio files will then be automatically adjusted to this 
tempo. If you are planning a remix which is composed of different samples with 
different tempo, then try to add the most important sample first. This minimizes 
sound distortions compared to the other samples via timestretching. 

In order to be able to correctly adjust an audio object to the tempo, its output tempo 
must first be detected. If the sound is a Soundpool sample, then the tempo saved 
therein ("patched") will be used, and the tempo adjustment will always work. 

For all other (short) samples, an attempt will be made to automatically provide the 
tempo. If the sample is not cut exactly, i.e. it does not contain an exact number of 
beats or is incorrectly interpreted by the automatic detection process, then this may 
not work. The sample will then be incorrectly stretched or an incorrect arrangement 
tempo will be set. 

In this case, use the Loop Finder to specify the tempo semi-automatically (more 
about this under the chapter "Menu effects -> Audio -> Loop Finder (view page 
220)"). This allows the sample to be cut to an even loop and the arrangement will 
adjust to the detected tempo or vice versa. 

The Remix Agent launches optionally for longer samples ( >15 seconds), e.g. entire 
songs from CD or MP3s. This also gives you the option of either adjusting the sample 
to match the arrangement or the arrangement to the sample. 

MIDI objects for controlling synth objects always have the correct tempo because 
they are always aligned with the arrangement tempo. 

In the dialog "Program settings (view page 205)  -> Import" ("Y" key), you can 
deactivate the automatic tempo adjustment or limit it to patched samples. 

Change tempo or pitch of individual objects manually 
"Resampling", "timestretching", and "pitchshifting" provide high-quality effects for 
you to change the pitch and tempo of selected audio objects dependent on or 
independent from each other. You can access these tools via the "Effects" menu or 
the object FX effects tracks. 

These functions can be used for all audio files, i.e. for the included samples as well as 
your own recordings, CD tracks, CD tracks, or sounds from the Internet. 

The playback tempo can be quickly changed via "Timestrech" mouse mode, i.e. by 
compressing/stretching the audio object's lower handles, in which case the tempo 
will change but the pitch will not be influenced (compare with chapter "Mouse 
mode"). The middle handles can also be used to change the pitch. 

Detailed access can be accessed via the time processor effect (see chapter "Audio 
effects -> Timestretch/Resample"). This allows you to specify different timestretch 
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algorithms for the corresponding object, since the best results often depend on the 
respective audio material and the different algorithms. 

The tempo setting on the transport controller allow the arrangement's tempo to be 
changed retroactively. This affects all objects contained in the arrangement, and in 
some circumstances this can lead to an increased demand on the system and 
dropping out during playback. If this occurs, use Apply function in the effects rack 
(view page 137) or the Combine audio (view page 214) function. 

Song Maker 
With the help of the Song Maker, you can automatically arrange multiple audio 
objects (loops) using included samples for songs or song parts without having to drag 
them individually from the Media Pool into the corresponding tracks. Considering the 
relatively random selection of loops that are combined you shouldn't expect the Song 
Maker to produce a chart-topping hit, but it can be very helpful as a basis for making 
your own adjustments and additions to create a cool arrangement. 

 Activate the Song Maker by pressing the “Song Maker” button or from the Effects 
menu. 

 

 Select a music style. 

 Select the instruments that you want to use. If, for example, you only want a 
rhythm section with drums and bass, deactivate the other instruments with a 
mouse-click. 

 Select the song part or parts that you want to create. The parts differ in their 
harmonic structure and instrument density, for example verses have fewer 
instruments than refrains, while there are accompaniment variations between 
the 1st and 2nd verses as well as in the refrains. The pitch sequence from verse 
to verse remains the same. If you activate all parts, Song Maker creates a 
complete song in the typical structure of a classic pop song, i.e. intro-verse-
chorus-verse-chorus-bridge-(transition or solo)-chorus-outro. 

 Use the sliders to the right to set the speed and the length of your song.  
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 "Chaos" draws a different loop of the corresponding instrument for each new 
object. Normally, the same loop is continuously used in various pitches for each 
element of the song such as verse, chorus etc. If you use "Automatic", a new 
song in a randomly generated style will be created automatically, as soon as a 
song has been played. 

 Now click on "Create Song".  Song Maker automatically compiles an 
arrangement. The following is only a suggestion. 

 Use the play button to preview the song maker's suggestion. If you don't like the 
results, you can repeat the process. Before you do this, right-click on the 
instruments you want to keep in the arrangement to prevent them from being 
overwritten. You can return to a previous status anytime by clicking on "Undo" 
or "Redo". 

 Once you're happy with Song Maker's suggestion, click on "Apply". The building 
blocks are only now added to the arranger. A click on “Cancel” closes Song 
Maker and returns to the original arrangement status. 

Tip: If you start the Song Maker for an arrangement that already has audio material 
in it, this material will not be affected. This means you can apply the Song Maker 
repeatedly saving only the parts you like until you have a final arrangement. You can 
also create song parts one after the other. The results from the Song Maker are 
always added at the start marker position. If you decide you want to replace the 
chorus you can simply set the start marker (view page 34) at that position. 

Keyboard shortcut:  W 
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Remix agent - Tempo and beat assignment 

 

The Remix Agent is a powerful tool that determines the tempo (measured in beats 
per minute, or BPM) as well as the timing of the beats for a song’s quarter notes. This 
is important if an audio CD title is imported into MAGIX Music Maker 2013, and you 
want to mix in sounds like drum loops, effects, or synthesizer voices. 

When to use the Auto Remix Assistant: 

• When the tempo of the arrangement must be adapted to the tempo of the song.  
• When the tempo of the song must be adapted to the tempo of an existing 

arrangement. 
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• When the song is to be cut up precisely to create a remix object which can then 
be rearranged as desired. 

Requirements for using the Remix Agent 
• The song must be longer than 15 seconds. 
• The song must be “rhythmic” (danceable). 
• The song must be in stereo format.  

Note: For analysis, it is presumed that the song is recorded in 4/4 time. If one of the 
above requirements is not fulfilled, the Loop Finder can be used. 

If songs longer than 15 seconds are dragged into the arrangement, the Remix Agent is 
started automatically. When loading short samples (< 15 sec) the tempo is specified 
automatically and some loops are similarly automatically customized to the tempo of 
the arrangement. This also applies to previewing in the Media Pool (Smart Preview). 

This method can be deactivated individually in the audio/video options ("A" key). You 
can find out more in the "File -> Properties -> Program settings" section. 

Preparation - Setting the start marker and object end 
Before opening the Auto Remix Assistant, you should set the start marker at the 
position in the song object in the arranger where you want detection to start. If the 
song contains a long intro without beats, set the start marker after the intro. As a rule 
of thumb, the Auto Remix Assistant should always be "fed" dance music.  

• The start marker should be set before a quarter note beat or, better still, briefly 
before a beat at the start of a bar. 

• If the start marker lies before the song object, the object is examined from the 
beginning.  

• If detection is not performed by the end of the song, the object can be shortened 
accordingly with the object handle at the end of the object.  

Checking the automatic tempo recognition 
The song has to meet the following three requirements to be successfully analyzed: 

• It must be longer than 15 seconds. 
• It must contain "rhythmic" (danceable) music. 
• It must be in stereo format. 

The analysis takes place in three steps: 

Step 1: Checking the start marker 
Step 2: Tempo recognition 
Step 3: Specifying beat starts 
Step 4: Application of BPM and beat recognition 
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Step 1: Start marker check 
Before analysis can begin, you should set the start marker in the project at the 
position where rhythmic material begins. This means, it should be located after the 
intro. If the assistant can't find any rhythmic information, it will ask if the marker is 
located behind the intro. In the dialog, you can move it to the appropriate location. 

If the beginning of the track has no rhythmic information, you will be asked if the start 
marker should be moved. 

Step 2: Checking automatic tempo recognition 
The Remix Agent will begin the audio file analysis and try to determine the tempo. 
The object will be played back while a metronome click will sound and numbered beat 
lines will appear in the waveform display. 

Below the waveform display to the left is an indicator of the found tempo in BPM. A 
small transport control is available in the middle to make navigation easier. The slider 
enables position control. To control the metronome volume, an additional slider as 
well as a mute button is found to the right. 

Automatic tempo recognition doesn't always work on the first try. If you don't hear 
the metronome clicking in time with the music, click the "No" button in the upper 
section of the dialog in order to access the manual tempo input dialog. 

To correct metronome tempo and move metronome clicks if needed, use the tempo 
correction and "Tap tempo" buttons. 

Tempo correction: The Remix Agent offers you a number of tempos. The tempo, 
which the Remix Agent considers most likely to be the case is already preset. If the 
calculated tempo is incorrect, select one that better fits from the list. When the object 
is played again, metronome clicks should be synchronized. 

On/off beat correction: It can also be the case that the tempo is correct, but the 
beats are shifted. "On/off beat correction" provides a number of alternatives for 
moving the beats according to the complexity of the rhythm. Try out different 
alternatives until you can hear that the metronome clicks are synchronous to the beat. 

Tap tempo: Alternatively to tempo selection under "Tempo correction" you can also 
click on the "Tap tempo" button or the "T" key to the beat of the music. Additional 
blue lines are displayed in the wave display. After at least four taps, the Remix Agent 
attempts to select the correct tempo from the list in "Tempo correction". The display 
next to the "Tap tempo" button displays the current status. Keep tapping until the red 
display showing "Unlocked" changes to the green "Locked" setting. 

Use the "0" key to manually set the quarter beats while the music plays. Placed 
markers will be removed automatically in such a way that the set tempo will be 
maintained.  
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You can move the markers with the mouse. If you press the "Ctrl" key at the same 
time, all following markers will be moved. 

If the metronome clicks now correspond with the music, you can continue to the next 
step. 

Step 3: Determining the start of a bar: 
First set the type of beat. 4/4 beat is the default preset. If needed, correct the start of 
the beat. The beat at the start of the beat should always match with the high-pitched 
metronome click or the red line in the waveform display. 

Correction cat take place in just one step: If you can hear the start of the beat, click 
once with the mouse on the"Tap one" or press the "T" key on the keyboard. 

Alternatively, select how many quarter notes the "One" is to be moved back. 

Use the "0" key to manually tap the position of the beginnings of the bars during 
playback. This offers an efficient option to correct the beat start of longer ranges. 

Continue to the last step if the starts of the bars are now correct. 

Step 4: Apply 
The last step applies the musical information into the audio material.  

Video cuts will now be inserted into the video material on track 1 based on this 
information 

Setting the manual and Onbeat/Offbeat 
If the result is incorrect, you can help the Auto Remix Assistant with a few mouse 
clicks on the correction buttons.  

There are two possibilities:  

On the one hand, the "Tempo correction" list offers alternative BPM numbers which 
could also fit with the music. The adjustable BPM values are detected automatically – 
the total BPM can therefore deviate from song to song.  

For more difficult audio material, we recommend using the "Tapping input" mode. 
Either the "T" key must be pressed or the "Tap tempo" button must be clicked with 
the mouse in time with the music. With repeated tapping of the tempo correction 
button, one should keep an eye on the color in the BPM display. In the "unlocked" 
condition (red), the tapping is not in time with the music. One should tap until the 
"locked" condition is displayed. After a short time, you will hear if the result is correct 
via the metronome.  

Subsequently, offbeat correction takes place as required. If the detected quarter note 
beats lie around the length of an eighth note (transferred behind the real positions of 
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the quarter note beats), one or more alternatives can be selected from the 
onbeat/offbeat correction list. 

Determining the start of a measure 
Next, the starting point of the measure is corrected. The beat at the start of the 
measure must always agree with the high tone of the metronome and/or the red line 
in the wave-shaped display.  

Corrections can be made by tapping; If the start of the measure can be be heard, tap 
with the mouse or press the "T" key. Alternatively, you can also select how many 
quarter notes the "one" is to be pushed to back.  

If the starting marker was set briefly before the first beat of a measure, this correction 
is not necessary.  

Note: With all corrections, the metronome and visualization react to the lines in the 
wave-shaped display only after a short delay. 

Using BPM and beat detection 
Now you may select one of the actions to be adapted to the arrangement song (or 
vice versa) or cut up the songs at the ends of a measure. 

Save only Tempo & Beat information 
Only wave file data is stored. This makes sense if some manual post-correction is 
required for determining beat/tempo.  

When the data is stored, tempo & beat regulation can be released for future tempo 
adjustments or to create object remixes. 

Tempo adjustment 
Setting the object tempo to the arrangement tempo 
This fits the object length to the existing arrangement. Three different procedures are 
possible: timestretching, resampling, or audio quantization.  

• Timestretching keeps the pitch of the song constant, but sometimes the sound 
quality can suffer.  

• Resampling changes the pitch (similar to changing the speed of a record player), 
and retains the sound quality of the song as much as is possible.  

• During audio quantization, the audio file takes the tempo adjustments into 
consideration as if the first remix object (see below) were created and combined 
immediately into a new audio file. If the recognition is uncertain, extreme tempo 
fluctuation may result. It is particularly important to set the starting marker so 
that the tempo is recognized definitely. The advantage of audio quantization is 
that small tempo fluctuations in the music balance out. The start of the measure 
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always agrees with the start of the arrangement measure and never plays out of 
time. 

Setting the arrangement tempo to the object tempo  
The arrangement adopts the detected BPM value. If you would like to use the cut-up 
song as the basis for a new composition (e.g. for remixes), then this option should be 
active. 

Creating remix objects 
The song is cut by beat into individual objects. Some applications may include:  

• To produce loops from complete songs which can then be used with other 
material. Most importantly, not all remix objects are suitable as loops. Ideally, 
less complex material should be used, e.g. drums from an intro. 

• To remix songs, thus changing the sequence of the objects, cutting or doubling 
beats or to enrich the song with other loops or synth objects.  

• To mix two songs: If percussion and tempo fit perfectly, can you blend the songs 
without "side effects"? 

This option can be activated later from the "Object" menu, provided that the tempo 
data is stored.  

The "Audio quantization" option: Audio quantization fits new objects exactly in time 
with the arrangement.  

With homemade music, tempo fluctuations are common, and therefore different 
measure lengths may result. Nevertheless, so that the objects fit into the rigid timing 
pattern of the VIPs, the time processor is activated automatically and object 
timestretching is used to correct the different lengths.  

Setting resampling for small corrections: If the necessary corrections are very small, 
better quality resampling can be used instead of timestretching. Afterwards, you 
should not change the master tempo any longer, since definite pitch changes may 
arise. 

Remix objects in "Loop" mode: New objects are set in "Loop" mode. When extending 
the object with the right object mouse handle, the original length of the object is 
played again and again. 

Setting the arrangement tempo to the object tempo: (see above) 

Note: Time correction assigned to objects can be subsequently cancelled if the time 
processor is called up and edited ("Timestretch/Resample object", or double click 
on the object to open the FX racks associated with the time processor). 

Cancel: The dialog is closed. 
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Problems and Remedies regarding the Auto Remix Assistant 
Problem: The playback stutters, the metronome is suspended, the computer is 
overloaded... (on older computers.)  

Remedy: We recommend changing to wave drivers ("P" key, "Playback parameter" 
dialog) instead of DirectSound.  

Problem: The metronome does not work and there are no lines on the the wave-
shaped display.  

Probable cause: The material does not contain beats or the song contains a passage 
without beats.  

Remedy: The song should be limited in such a way that only rhythmic passages are 
contained.  

Possible 2nd reason: Inaccurate tapping or a false BPM value has been entered.  

Remedy: Try the tempo correction buttons or tap until the "locked" condition is 
attained.  

Problem: The metronome sounds inaccurately or is jerky, the lines in the wave-
shaped display are irregular and thinly drawn.  

Remix Maker 

 

The Remix Maker is connected directly to the Remix Agent. 

Use it to automatically generate remixes. The loop objects sliced by the Remix Agent 
are regrouped according to defined criteria. Simply choose one of the four "virtual 
DJs", each of which represents a different remix style, and set the remix length and 
structure. 

Opening the Remix Maker 
1. New song 

• Load the new song you want to remix. This should contain clearly defined 
rhythms.  

• When the song is loaded, the Remix Agent pops up to give you the option of 
dividing the song into its structural segments (see "Remix Agent" above). 
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• Select the option "Open Remix Maker" from the Remix Agent dialog box.  
• Once the Remix Agent has sliced your song, the Remix Maker is started 

automatically.  

2. Existing, edited song (in the arranger) 

• Load a song arrangement that is made up of loop objects. 
• Select one of the loop objects. 
• Select "Remix Maker" from the shortcut menu (right mouse click). 

3. Long, unedited audio object (in the arranger) 

• Load an arrangement containing a long, unedited audio object. 
• Select "Remix Maker" from the shortcut menu (right mouse click). 
• You are then given the option of generating remix objects.  

Presets 
Choose one of four virtual DJs with different remix characteristics. We recommend 
you try them all out and see which results you like best! 

Remix length 

Very short: around 20 seconds 

Short: half the length of the original song 

Normal: regular length of the original song 

Double: twice the length of the original song 

Shuffle mode 
This determines the selection and order of the objects. 

Do not change: The order of the objects are not changed. 

Change slightly: A "pattern" (sequence of objects) is either repeated or the next 
pattern inserted. 

Distant: Objects that are far apart in the original song are placed close to each other. 

Random: The objects are ordered randomly. 

Fill mode 
A "fill" or "fill-in" is created when the loop object sliced by the Remix Agent again to 
produce very short objects that are looped or played in rapid succession. Fills are used 
to liven up the regular beat.  
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None: No fills are included. 

Use slightly: A few simple fills are included. 

Strong accentuation: Many complex fills are included. 

Use randomly: Different kinds of fills are used in a random order. 

Loop Finder 
The Loop Finder has been developed to find the BPM in short rhythmic passages, to 
integrate short loops in an existing arrangement, or to yield drum loops from short 
rhythmic passages. Otherwise, the BPM Finder helps in this regard. 

More information under “Effects” menu. 

Harmony Agent 

 

The Harmony Agent is designed to analyze harmonies. 

The music track is analyzed first when you open the Harmony Agent. The Harmony 
Agent tries to automatically identify the harmonies for each beat of the music. Thus 
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the right beat information is an important prerequisite for a properly-functioning 
Harmony Agent. 

During subsequent playback, the detected harmony is played by an internal generator 
for verification purposes. You can adjust the volume with "Volume Generator". 
"Mute" deactivates the generator. 

The transport control controls playback of the music track. The position slider below 
lets you quickly move to a certain passage. 

Check and correct the automatic harmony recognition 
After the analysis, you can manually correct harmonies which were not correctly 
identified. Note that major chords are written with capital letters and minor chords 
with lower-case letters. 

Left click on the respective harmony symbol in the wave display. Hold the key if you 
want to mark several subsequent harmonies. If you right-click on selected harmony 
symbols, a menu containing alternatives will be displayed. The initially recognized 
harmony is marked with an *. 

If there are no alternatives, you can select the correct "Keytone" or "Chord" from the 
"Correction" section of the menus. Use the option "Replace selected harmony in the 
entire song" if you are sure that the incorrectly recognized harmony is not included in 
the entire song. A mix-up between major and minor is typical in this case. 

Once you are sure that all harmonies are set correctly, click on "Continue". 

Use harmony recognition 
Here you can use the information from the Harmony Agent. There are different 
possibilities to output harmonies. 

• You can create picture objects in the arrangement that display harmonies 
graphically in the video monitor and in sync with the music. 

• You can save the information in the audio file. This also ensures that the 
harmonies are available later. For instance, if you want to display the harmony 
information in the timeline ("Edit -> Display Object Marker -> Harmony 
Marker"). 

• You can choose between different displays of the harmony symbols. You can use 
German, English or Roman symbols to name the tones. Furthermore, you can set 
the "preceding symbol" to force single harmony interpretation. With #, all notes 
are shown as "sharps" (C#, D#, F#), with B they are displayed as flats. 

Text to speech 
In this dialog reached in the Effects > Audio dialog, you can get speech from typed 
text. You can choose from a range of different types of voices. You can change the 
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speed and volume of the spoken passages. Once you've settled on a suitable voice a 
WAV file will be created. This can of course be used in the arranger like any other 
audio object. 

Load text: Here you can load any text file (formats: *.txt or *.rtf).  

Save text: Your entered text can be saved. 

Test: After entering your text, you can preview the result.  

Voice: You can choose from various voice types. 

Speed: Playback speed can be regulated with this controller. 

Volume: Output volume is regulated with this control. 

Format: Here you can determine the quality of the created wave file (.wav).  

File: Path selection for the wave file to be created. 
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MIDI Objects 

Arrange MIDI objects 
MIDI objects may be moved, the volume may be modified (middle handle), or fades 
(in/out) may be added (top right and left handles) in the same way as audio, video, or 
synthesizer objects. Use the lower handles to "stretch out" individual MIDI loops so 
that they easily fit onto a whole track. 

Pay attention to the following: 

• Volume changes in MIDI objects (central handle or fades in/out) are controlled 
by adjusting the velocity level (MIDI velocity). Many synthesizers do not change 
the volume, but rather the sound in relation to the velocity level. In this case, use 
the effects curve automation function. 

• MIDI objects always control a single synthesizer per track. If you move a MIDI 
object onto another track, then a different synthesizer will be controlled and the 
sound of the arrangement changes accordingly. 

Transpose MIDI 
This function in the the context-menu is used to change the pitch of a MIDI object. 
Simply enter the number of half tone steps by which the playback is to be transposed 
up or down! The transposition is shown in the MIDI Object in the arranger with "+n" 
and "-n" (n is the number of halftones). 

Load MIDI files 
Proceed as follows to integrate MIDI files into an arrangement: 

1. Open a directory containing MIDI files using the Media Pool.  
2. Click a MIDI file and it will be played back immediately; this makes it easy to 

load audio files without guessing. 
3. Now drag the desired file into the arrangement and that's it!  
4. An MIDI object will appear in which the MIDI notes are shown by dots; the 

high notes are dots in the upper section, and the lower notes are the dots 
further down in the lower section. You can even see the velocity of the notes: 
the louder the note is played, the darker it appears on the screen. 

MAGIX Music Maker 2013 uses the external MIDI device (view page 82) to preview 
a MIDI file in the Media Pool without using software instruments. If you can't hear the 
MIDI file, then there may be different reasons for this: 

• Check the MIDI output device in the "Program settings" window via the 
"Audio/MIDI" tab (P key or "File > Settings > Program settings"). "Microsoft CD 
Wavetable SW synth", a standard software synthesizer included in Windows® as 
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an OS component, should be set as the default. If sound cards with their own 
synthesizer are used or in case MIDI hardware synthesizers are connected, set 
the sound card's MIDI driver or a MIDI interface! 

• The sound car synthesizer's volume is set via the the sound card mixer. Double 
click the small loudspeaker icon in the tray and find the controller for the SW 
synthesizer. 

• Several sound cards cannot use the SW synth simultaneously with ASIO drivers. 

The "Microsoft GS Wavetable SW-Synth" is treated as an external MIDI device, 
which means that even while it produces sounds in the computer, it is still not a 
component of MAGIX Music Maker 2013. If you want to export a sound from the 
arrangement, then you will have to record it beforehand (see Converting MIDI objects 
to audio files (view page 83)). The sound quality of the device is rather modest 
compared to "proper" software synthesizers like MAGIX Vita or Revolta. 

It's easier if you assign different software synthesizers to the MIDI object after you 
load it. MIDI files of complete songs, for example like you might find on the Internet, 
often contain multiple tracks that control different instruments. MAGIX Music Maker 
2013 is able to use one software synthesizer per track. For this reason, duplicate your 
MIDI one beneath the other as often as there are different instruments involved and 
set the corresponding Channel filters (view page 87) in the MIDI objects ("Options" 
menu in the MIDI Editor) so that each object only plays the notes for a single channel. 
Next, assign software instruments for the individual channels via the Track (view page 
31) menu. 

Connect external equipment 
USB-MIDI keyboards 
Over the last few years, controls for software synthesizers have produced a new class 
of devices: USB-MIDI keyboards. These devices usually do not contain separate 
sound generators, but rather consist of just a keyboard, different controls, and a MIDI 
interface that is connected via USB cable to the computer. 

These keyboards usually do not need special drivers - they only need to be connected. 
Make sure that the device is switched on and is able to be detected prior to starting 
MAGIX Music Maker 2013, since the available MIDI ports are only able to be 
discovered during program launch! 

Under some circumstances, you may have to select the MIDI input device via the 
Program settings ("Audio" tab) (view page 206). This is usually called "USB audio 
device" 

Note: Some older devices  do not function in some cases in Windows XP. Even 
though the device has been detected, the corresponding MIDI drivers do not appear 
in the list. In this case, please contact MAGIX customer support!  
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MIDI cabling 
MIDI inputs/outputs: If your computer has an internal or external MIDI port, or has a 
MIDI-capable sound card installed, connect your MIDI keyboard’s “MIDI out” to the 
computer’s “MIDI in” (on the interface, sound card, and so on).  

If your MIDI keyboard can generate its own sounds, connect the computer’s “MIDI 
out” to the keyboard’s “MIDI in”. If your computer (or the MIDI device) offers more 
than one MIDI output, connect any other sound synthesizers to these. If the computer 
only has one MIDI output, you need to connect the second sound synthesizer’s "MIDI 
in" to the keyboard’s "MIDI thru" port. A third device can be connected to the 
second’s "MIDI thru", and so on. The "MIDI thru" port always delivers a copy of the 
signals coming into the device’s "MIDI in". It is preferable, however, to use a direct 
connection from a computer’s "MIDI out" to a device, rather than chaining too many 
devices one after the other. Timing problems may occur in the chain if a lot of MIDI 
commands are sent in a short space of time. This is due to the slight delays 
introduced by each "MIDI in" to "MIDI thru" transaction. If your computer also 
features several MIDI inputs, they can be used for the connection of MIDI expanders.  

MIDI local off: If your keyboard features an internal sound source, it is important that 
you stop the keyboard from generating sounds directly from its own keyboard. If you 
buy a new keyboard that is to be used without a sequencer and connect it straight to 
an amplifier, you would expect the device to make a sound when you press its keys. In 
other words, the keyboard is internally connected to the sound synthesizer. This 
behavior, however, is not what you want to happen when using your keyboard with 
MAGIX Music Maker 2013. In this scenario, the keyboard is used as the computer’s 
input device, and MAGIX Music Maker 2013 is sending (i.e. playing) MIDI 
information to any connected sound synthesizer, be they the keyboard’s own sound 
generator, a sound card, or any other connected sound module. 

If you wanted to control and record another sound module using your keyboard as the 
input device, its own sounds would play alongside those of the other sound 
synthesizer, which is why the keyboard must be separated from its own internal 
synthesizer. This function is known as “Local OFF”, and is set directly on your 
keyboard. Refer to your keyboard’s manual for information on how to do this. Don’t 
worry about “breaking” the link between the keyboard and its internal sound 
generator – MAGIX Music Maker 2013 will act as the “missing link” in this scenario. 

External synthesizers 
Naturally, MIDI objects can also be played back over a MIDI interface onto external 
synthesizers, sound modules, etc. "Pure" MIDI output takes place (i.e. without using 
software synthesizer plug-ins) assuming that the MIDI output device has been 
properly set (see previous sections); in this way, any MIDI object may be sent to an 
external synthesizer. 
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Note: If a MIDI object is on a track which features a software synthesizer, then this 
will be controlled first. To play the object on an external sound synthesizer via MIDI 
output, select "no VSTi" from the list of software synthesizer. 

Convert MIDI objects into audio files 
If you use VST instruments, you won't have to convert these MIDI objects into audio 
data before exporting your entire arrangement, since the sound is created on your 
computer and can be processed there. If you wish to do this nevertheless (e.g. to 
provide some relief to your PC), then use the function 'Combine audio (view page 55)' 

All MIDI objects that control external synthesizers via a MIDI interface (view page 
82) will have to be converted into audio objects if you want them to be exported as 
well. They only contain control information for sound generation. 

In order to do this, the output of the MIDI synthesizer (e.g., the sound card) must be 
connected to the input of the sound card. The MIDI data can then be played and 
recorded simultaneously via the record function. This produces an audio file that can 
be edited and exported together with the multimedia files as usual. 

Playing and recording MIDI synthesizer 
MAGIX Music Maker 2013 allows you to play and record software synthesizers or 
external MIDI devices from the arranger. The MIDI Editor does not need to be opened 
for this, which was previously the case in the former version. 

Presuming that the MIDI input and output devices are set correctly (see above), then 
you should be able to play any synthesizer that is loaded via the MIDI keyboard. 

MIDI recording mode must be activated in the corresponding track by 
clicking "Rec" twice in the track box. Now, all of the notes that you play via 
the keyboard will be played back through the synthesizer. 

If a software instrument is loaded via the track box or opened via the MIDI Editor, 
then MIDI recording mode is activated automatically. 

Tip: You can also play a synthesizer live without an external MIDI keyboard. The 
Media Pool features an On-screen keyboard that may also be operated via the 
computer keyboard. 

 

In order to record a new MIDI object, simply click the red "Record" button 
in the transport bar 
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MIDI Editor 
The MIDI Editor makes it possible for you to edit MIDI objects. The MIDI Editor 
provides different sub-editors, views, areas, and aids to do this. 

Double clicking a MIDI object opens the MIDI Piano Roll Editor for advanced 
recording/editing of MIDI objects. 

Tip: The Media Pool features a smaller version of the MIDI Editor. Select the MIDI 
object you would like to edit and then click the Settings Object Inspector button. 
This MIDI Editor may be operated identically to the "bigger" version that features its 
own window; of course, the menu and different play and recording settings will not 
be available. 

 

In the center you'll find the Piano Roll Editor in which the notes are displayed as bars 
and from which they can be edited using the mouse. There are various buttons 
located just above the Piano Roll. 

 
Clicking on this button opens the Event list (view page 92). In this list you 
can view all MIDI data of a MIDI object, including those that cannot be 
edited in the piano roll or controller editor. You can use the Event List to 
remove unwanted commands included with imported MIDI files. 

 
Use this button to switch to Drum Editor (view page 98) mode. 
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You can use this to leave the Drum Editor and return to the Piano Roll 
section. 

 
Clicking on this button opens the Controller Editor (view page 90) in the 
bottom area. This allows you to edit features such as the note velocity, 
pitchwheel, and controller data.  

 
Deletes all MIDI data from the object. Now you can begin from the start 
again... 

 
Of course, "Undo/Redo" is also available for all changes you make in the 
MIDI Editor. 

Along the top edge, you will also find the buttons for selecting the editing tools (view 
page 88), for quantization (More information can be found in the section 
"Quantization settings" on page 94), and for the output (view page 85) used by the 
MIDI object (MIDI out or VST instrument). 

Select sounds 
The sound of virtual instruments (VST plug-ins), is produced by the synthesizer chip 
of the sound card or by external MIDI synthesizers. Each MIDI object can produce as 
many sounds as the corresponding synthesizer offers. The sounds themselves can be 
specified in the instrument – regardless whether its a virtual VST Instrument or a 
hardware device.  

If there is no VST instrument loaded, the MIDI object uses the MIDI output for the 
external synthesizer or for the Microsoft™ Windows® supplied synthesizer. The MIDI 
output can be adjusted in the "Program settings" window in the "Audio/MIDI" tab (P 
key or via "File" menu > Settings > Program settings" 

 

Select the desired VST instrument from the menu. You can test the same MIDI object 
with various VST synthesizers. You can set the sound of VST instruments in the VST 
instrument editor (view page 126). You can open the instrument editor with a right-
click on the VSTi name or a left mouse click on the cogwheel symbol.  

You can set up the MIDI output channel under MIDI channel. This is important for 
VST instruments which can receive MIDI notes on multiple channels and play several 
different sounds simultaneously (multi-timbral). 

Play/ PlaySolo 
Play solo only plays the MIDI object for which the MIDI editor is opened 
(corresponding with the filter settings of the options menu). 

Play all plays the entire arrangement. 
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Playing instruments with the keyboard 
Open the MIDI editor to be able to play software instruments directly via the 
computer keyboard. The assignment of the notes to the computer keyboard is 
displayed in the following graphic. 

 

"Page up" and "Page down" move the octave up or down. 

MIDI Record options 
You may also begin MIDI recording directly in the MIDI Editor. To do so, simply click 
the red "REC" button. Compared to the simple "Record" featured directly in the 
"Arranger", this version features several additional options for you to select 

Overdub: Normally, existing notes are deleted with each new recording. "Overdub" 
simply adds new MIDI notes to the existing MIDI recording. "Overdub" allows you to 
create a completely new MIDI song step-by-step (or take-for-take). 

Cycle: This plays the MIDI object in a loop during recording. This enables you to let 
the object play through a few times before you get started recording your own 
melody. 

Metronome: In order to play back the proper tempo, you can activate the MIDI 
metronome to provide the beats. This is only for orientation while you play and is not 
recorded. 

 
Play arrangement during recording: If this option is active, then the 
arrangement will play during recording. 
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Notation display, movement, zoom 
MIDI data can be edited in three main areas in the MIDI editor. 

• Piano roll (view page 89) 
• Velocity editor (view page 90) 
• Lists editor (view page 92)  

Here various tools are available, e.g. pencil or eraser.  

Fundamentally, changes, e.g. moving or deleting notes, always refer to all selected 
MIDI events (red) with just a few exceptions. Changes to the selection in a range 
always apply to every other range as well. For example, you can select a group of 
notes in the piano roll and then change the velocity of these note groups which 
modifies all selected notes simultaneously. 

Note display in the piano roll and the controller editor (with velocity curves) 
All of the unselected notes are highlighted in blue. The intensity of the color indicates 
the velocity of the note; the darker/stronger the color, the higher the velocity.  

Selected notes are highlighted in red. Again, higher velocity notes are brighter than 
lower velocity ones. 

Note: You can also customize the velocity color range for selected notes. To do this, 
open the graphics file "vel_sel_map.bmp" from the bitmap directory and modify the 
color spectrum accordingly. 

Current event: This is displayed in bright red and with a red outline. The properties of 
the currently selected event are displayed in the edit fields above the piano roll. An 
event is "current" when it is selected with the mouse. 

Event display filters 
To get a better overview of a MIDI object's events, you can filter specific events for 
the display.  

A MIDI object can contain events in up to 16 channels and up to 16 MIDI tracks 
(original track from the imported standard MIDI file). For example, it's possible to 
control a multi-output VST instrument using a single object on several MIDI channels. 
Notes in the corresponding MIDI editor can be edited simultaneously or only in one 
selected channel within this object. 

There are comfortable viewing options available for this: 

• A channel filter ("Options" menu) enables all or only selected channels to be 
displayed. Notes in the remaining channels are grayed out and cannot be 
manipulated by the selection tool. 
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Example: The MIDI object includes notes in the MIDI channels 1, 2, and 5. You can 
now make all notes in channels 2 and 5 accessible for the selection and editing tools 
via the selection of the MIDI channels in the channel filter by selecting the two 
channels from the menu. All unselected, filtered notes in channel 1 are displayed in 
gray in the piano editor and the list editor. 

Events in the filtered channels can be completely hidden using the "Hide filtered MIDI 
data" in the "Options" menu. 

• A track filter (also "Options" menu) enables data to be filtered according to an 
imported MIDI file in the same way. 

• The list editor (view page 92) provides additional display filters that only function 
within the list. The display filters are activated by the playback filter settings 
(mute settings), but the filters can be set independently of one another. 

Muted events display 
Events that lie ahead of the object start point or behind the object end point (the start 
and end points are displayed as blue lines in the editor) are also paler than the un-
muted events within the object’s boundaries. If display transparency is activated, the 
outside events are grayed out. 

Events above or below the currently visible selection 
There are two small red indicators above and below the vertical scroll bar on the right 
border of the MIDI editor window. These light up correspondingly if there are other 
notes outside of the currently displayed screen selection. 

Piano Roll - Edit events 
There are various editing options for notes within the Piano Roll, as well as mouse 
modes. In all modes (except Delete) the same functions also apply to notes when 
editing them, so that these modes only differ in behavior when you click on empty 
areas. 

Editing tools 

 
Selection 
(Ctrl + 1) 

Lasso: Press and hold down the mouse button to draw out a 
rectangular selection frame. 
Clicking on a free range highlights an existing selection. 

 
Draw 
(Ctrl + 2) 

A note can be drawn with a left-click. The beginning and 
length are set according to the current quantization settings 
(above). 

 
Drum (draw)
(Ctrl + 3) 

Draws a series of notes. The note length and distances are 
calculated from the current quantization settings.  
When holding Alt: The pitch of the first note is also 
maintained for all notes drawn subsequently. 
Moving the mouse backwards (to the left) while depressing 
the mouse button removes drawn notes. 
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Pattern 
(draw) 
(Ctrl + 4) 

This mode allows you to draw entire Drum Patterns (or 
melody patterns). If you want to create a new pattern, you 
have to select it first in "Selection Mode" and press the keys 
Ctrl+N simultaneously (or go to menu "Edit" in the 
"MIDI/Drum Editor > Create pattern from selection"). If you 
have created a pattern, you can start drawing at any position. 
Draw the pattern at the position of the deepest note of the 
pattern. This makes an original pitch sound, but you can, of 
course, draw in a different pitch.  
If <Alt> is pressed when drawing, the pitch of the first note 
will be applied to all notes drawn that follow it. 
Moving the mouse back (to the left) while holding down the 
mouse button removes the notes which were just drawn. 

 
Velocity 
Mode 
(Ctrl + 5) 

This mode allows you to mark events and change the velocity 
values of all selected events in relation to each other. 
Absolute values are entered when you hold the Shift key, i.e. 
all changed events receive the same velocity value. 

 
Delete  
(Ctrl + 6) 

Clicking on the selected note deletes all selected notes. 
Dragging the mouse deletes all notes underneath the eraser. 
The Delete mode can be activated anytime by clicking with 
the right mouse button. For instance, you can use the pen to 
insert new notes when left-clicking and remove already 
inserted notes with a right-click, without having to change 
tools. 

 
Magnifying 
glass 
(Ctrl + 7) 

Left mouse button: Zoom in 
Right Mouse Button: Zoom out 
Left mouse button + drag: Zooms in on the range. 

 

Selecting MIDI events 
(Piano roll, velocity editor, list editor, ) 

Select event  Left click event 
Add/delete event from selection Ctrl + left click event 
Select current event and unselect all 
other events  

Double click event 

Change or set current event within 
multiple selection 

Left click selected event 

Select events from the same line or 
area 

Click while pressing the "Shift" key 

Selects all notes of the same pitch Double click the desired key on the keyboard 
ruler to the left 

Selects all notes Ctrl + A (if a pitch is selected on the keyboard 
ruler, only notes with this pitch are selected)  

Selects the next or previous note  Arrow keys 
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As you can see from this list, a simple click is all it takes to choose a specific event for 
editing – even from selections containing several events such as a pattern. 

Edit notes with the mouse 
If you move the mouse over a note, the mouse cursor will change and, depending on 
the part of the note, the following options will be available: 

 Change note start time (Grab note bar at the beginning, note end 
remains the same) 

 Change note length (Grab note length at end) 

 + Shift Set fixed note length for multi-selection: Hold "Shift"  and drag the 
current reference note longer/shorter – all notes will have the same 
length 

 + Ctrl Scale note length for multi-selection: Hold "Ctrl" and drag current 
reference note longer – all notes will be lengthened by the same factor 

 Move note freely, pitch and start time change 

  If in "Move" mode "Alt" is also pressed, the note will only be moved 
horizontally, retain pitch (in free move mode, hold "Alt") 

 If "Shift" is pressed while in "Free draw" mode, only the pitch can be 
changed, the position will remain the same. 

/  "Ranges for limited moving": If you activate this setting in the 
"Options" menu, clicking and dragging in the start portion of the note 
only results in a change to the position, while clicking on the end 
portion changes the pitch. 

 

Moving and zooming 
The vertical and horizontal view or zoom are adjusted with the scroll bars just like in 
the project window. 

Mouse wheel: Scroll horizontally 
Shift + mouse wheel: Zoom vertically 
Shift + Ctrl + mouse wheel: Scroll vertically 
Ctrl + mouse wheel: Zoom horizontally 

Controller editor - Selecting and editing events 
The controller editor is located below the piano roll and can be hidden. 

 
It is opened either with a click on the button below the keyboard or via "Alt + 
V". 

The velocity values of existing events are displayed as colored bars in the controller 
editor, whereby darker and higher bars symbolize larger values. The bars are located 
directly below the notes. 

The values of all other controllers will appear in controller editor as ramps. Here, too 
the height of the ramps and their color intensity represent the last defined value of 
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each event. The length of the represented ramps reached to the next varying event. 
Selected event ramps are also represented in red. 

Controller Editor Hints 
• In polyphonic events, the bars are layered on top of each other, which can make it 

difficult to single out specific notes. To edit only notes with a certain pitch (such 
as all C1 notes in the controller editor), click the corresponding key in the 
keyboard ruler. The key and the background color of the selected pitch are 
highlighted, and only the notes with this pitch are displayed in the controller 
editor.  

• Notes with different pitches (such as all C1, D1 and A1 notes) can be displayed 
simultaneously by pressing "Ctrl" while clicking them (or "Shift" for areas 
between notes). This is basically a velocity editor view option. Multiple notes can 
be selected with a double-click. 

• Another aspect of working with the controller editor’s layered controller bars is 
that the bar of the currently selected note (mouse selection/editing) is always on 
top. To change this, click on the note you want to edit in the piano roll, or click 
directly on the layered bars and switch between the notes with the arrow keys. 
You can then change the controller value by clicking on the top third of the red 
(current) part of the top bar. 

• After drawing controller values with the pen tool, click on an unselected area and 
drag the mouse to change several velocity values in sequence. Move the mouse 
in a curve to create velocity curves. Existing (multiple) selections are ignored. 
This is a great method for creating crescendos or decrescendos.  

Tools 
The Controller Editor has its own tools for editing curves and values. 

 Controller selection: A click on the menu area of the button opens a 
selection menu in which the MIDI controller for editing can be selected. 

 Selection: This is a combi tool used for value changes as well as freehand and 
line drawing. 

Click in the upper range of a controller bar to modify the controller value immediately 
by dragging. Clicking in the lower two thirds of the bar selects the corresponding note 
which is then highlighted in red in the editors. 

Select multiple controller bars by clicking and dragging a range in the Controller 
Editor; individual values can be selected by single-clicking within the bar. Selected 
controller events will be highlighted red. 

Combi tool editing options: 

• Click on the bar end + drag: The controller value can now be adjusted by dragging 
vertically. If you hold the "Shift" key down while dragging, all of the selected 



 

92   

www.magix.com 

events will be set to the same value. If you also hold down "Ctrl", then the values 
of multiple selected controllers will be changed relative to one another.  

• Alt + Drag: This activates freehand drawing; the mouse pointer becomes a pencil. 
By dragging in the corresponding controller area, you can draw in any number of 
controller curves. 

• Shift + Drag: This activates line drawing and the mouse pointer becomes a cross 
hairs. By dragging horizontally, you can draw in linear value curves (ramps). 

 Freehand drawing: Draws new controller value curves or individual values by 
single-clicking without dragging. 

By dragging backwards, you can delete your curve during drawing. Shift + Drag with 
the cross hairs to draw a line. 

 Draw lines: Use the line function to insert a transition between two different 
controller values. 

Hint: If you edit velocity with the draw tools, no new notes are generated; only 
existing velocity values are modified. 

Quantize controller events 
MIDI controller events can be quantized and thinned out; select the "MIDI functions" 
menu and the "Quantize/Thin out controller" command to do this. Quantization 
occurs according to the quantization settings (view page 94). 

List Editor 
The MIDI editor contains an integrated list display of all events with additional view 
and edit options. This list editor is opened either by clicking on the button above the 
keyboard or using the shortcut "Alt + L". 

When the list editor is open and ready to receive input, it will have a narrow red 
border. This makes it clear that certain functions, for example, select next/previous 
event (cursor keys) or the "Select all" (Ctrl + A) command, only refer to the list. 

In the list editor, not only note events but also the MIDI controller and Sysex 
messages are displayed. These controllers and messages can be displayed or even 
filtered out during playback ("Mute"). 

"Note on" and "Note Off" events belong to each note, which are then selected as pairs 
and edited ("Note off" events can be displayed and hidden with a tick in the check box 
below the editor). 

To edit specific events only, the list editor provides a view filter for each column. 
These are small check boxes below the columns of the list editor. 
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Select a representative event. For example, this could be a note with a certain pitch. 
Then click on a display filter for a specific column to only display events of this type 
with the selected pitch. All other events will now be faded out. 

Display filters can be combined with one another. This way, when working with the 
"Select all" command (Ctrl + A), you can select and edit all control change events of 
type 10 (volume) on MIDI channel 6. 

Quantize 
Small irregularities when playing to record can be smoothened with the quantization 
function. In contrast to this, mechanical sounding sequences can be made a little 
more groovy by applying the Swing function. 

  
Clicking on the Quantize button shifts all selected notes to a customizable 
quantization grid.  

All notes are quantized without previous selection. 

 
1/4, 1/8, 1/16, and 1/32 notes and corresponding 
triplets can be selected as starting points (grid) 
and lengths.  

The Quantize button always performs standard quantization (the note's start point 
and length are preset). MIDI functions (view page 95) -> Advanced quantization 
provides other quantization modes (e.g. length only or Soft Q). 

The quantization options enable the type and scope of the quantization to be set 
more precisely. 

Quantization grid ("Snap") 

 
If snap is activated, the notes "snap" to the quantization values when they 
are created or edited. 

The quantization values are also considered. For instance, the notes snap to the 
corresponding positions within the quantization window.  

The snap positions are displayed within the piano roll as a matrix. A swing 
quantization is displayed by the different intervals of the vertical partitions in the 
piano roll. The grid can be hidden with the "Show quantization grid" command in the 
options menu ("Alt + G"). 

You can deactivate the snap function while creating or editing notes by holding down 
"Alt" as you draw them. 

Move relatively on grid ("Options" menu): If this option is active, then notes keep 
their original intervals  relative to the grid and not to the note start when they are 
moved; the distance moved snaps to the quantization value. Use this option if you 
want to move unquantized notes a certain distance without disturbing the timing. 
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Keyboard shortcut:  Shift + G 

Quantization settings 
The quantization settings can be found in the menu "MIDI functions -> Extended 
quantization" in the MIDI editor. The dialog with the settings is not "modal", i. e. you 
can open it as required and test certain passages with different settings. 

 

The selected quantization settings may be visualized in the top of the dialog. The blue 
lines indicate the target positions for the quantized notes, i.e. the snap points. The 
gray area around this show the quantization window i.e. the target positions that are 
affected by the quantization. 

Q-grid/length: The quantization grid and length at which target points within the beat 
on which the note start points or lengths move (see above).  

Q threshold/ Q window: This parameter may be used to slightly vary quantization by 
excluding notes from quantization that are very close to the next quantization value. 
"Q window" refers to the interval to the left and right of a grid point; events will be 
quantized within this range. Quantization does not take place outside of this window. 
This means that events with distance less than the "threshold" or more then the 
"window" from the grid point will not be quantized. The affected target range will be 
indicated in gray in the dialog graphic. 

Swing: Starts swinging, groovy playback (for example, triplet). Specifies the division 
for uneven grid points. 
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• 50 ... “50-50” division: The odd eighths are exactly half way between the even 
eighth notes (“even” playing method) 

• 67... triplet playing method, 3-2 division 

Offset: The value range in this parameter stretches from -100 to +100. By changing 
the offset values, you move the whole quantization grid. Negative values move the 
quantization to the left, i.e. forward in time; positive values move to the right i.e. 
further in time. The maximum of 100 corresponds with an offset of half the grid width. 

Presentation of blue grid points in the dialog and the grid in the MIDI editor directly 
reflects changes to these values. 

Humanize: The "Humanize" parameter creates another variation option, i.e. notes are 
able to be assigned according to the randomization principle up to a specific interval 
to positions around the exact quantization value. The setting occurs in % of a 16th 
note. The value specified therefore determines the possible interval between the 
quantized notes and the exact quantization value. 

Soft Q: This value sets the strength or "Soft Q" value of the quantization. 

• "100" moves the event precisely to the quantize grid point, 
• "50" shifts the event to the middle between the current position and the 

quantization grid point, 
• "0" means no movement -> Quantization off 

The command "Soft Q" command considers the current level value in the quantization 
options. The simple quantization command always occurs at 100%. In this manner, 
you can always select between approximation (soft) and a harder quantization 
without having to adjust the quantization options every time. 

Standard quantization settings: Select from a list of quantization actions (see MIDI 
functions) that are listed by clicking the "Quantization" button. 

Reset quantization: All notes are rest to there original positions. 

Standard settings: Restores the default values. 

MIDI functions 
The "MIDI functions" menu contains advanced quantization (More information can 
be found in the section "Quantization settings" on page 94) and editing functions for 
MIDI notes. 

The commands in the "MIDI functions" menu always affect the selected notes. If no 
notes have been selected, all functions are applied to all notes. 

Legato: Notes may be sustained until the next note, i.e. legato. 
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Quantize notes (default):  A default quantization is applied to all of the selected 
notes. If no notes are selected, then all notes will be quantized. The default action may 
be specified in the Quantization settings (view page 94) dialog. "Quantize notes 
(start and length)" is the default. This function can be accessed via the "Quantization" 
button in the MIDI editor. 

Advanced quantization 
This submenu contains additional quantization commands. 

Start Q: Selected notes will be quantized corresponding to the set grid quantization 
value. Note lengths remain unaffected. 

Start and length Q: Selected notes will be quantized corresponding to the set grid and 
length quantization values. Hard quantization always occurs at 100%.  

Soft Q: This command considers the current level values in the quantization options. 
The simple quantization command always occurs at 100%. In this manner, you can 
always select between approximation (soft) and a harder quantization without having 
to adjust the quantization options every time. 

Length Q: Selected notes will be quantized according to the set length quantization 
value. The start time remains unaffected. 

Quantize notes to grid: The end of selected notes will be quantized according to the 
set grid quantization value. The start time remains unaffected, but the note lengths 
will change. 

Reverse quantization: With this command, you can reverse all completed 
quantization steps. This functions even after the arrangement has been saved. 

Quantization settings: Opens the selection dialog for the Quantization settings (view 
page 94). 

Quantize controller events: Allows you to quantize controller events (view page 92) 
to reduce their number. 

Mute notes (Mute): Mutes and unmutes notes or selected note groups with a click. 

Remove overlaps (polyphonic): Notes may be shortened so that there no longer are 
any overlaps. Chords (simultaneously played notes) are recognized and not 
corrected, i. e. chords are not split up. 

Remove overlaps (monophonic): Notes may be shortened so that there no longer are 
any overlaps. Forces monophonic voice leading. 

Convert sustain pedal to note lengths: This function converts sustain pedal controller 
events (controller 64) into note lengths. All notes which were started after a "Pedal 
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pressed" event (CC64 > 64) will be extended to the "Release pedal" event (CC64 < 
64), and the pedal events removed. 

MIDI editor techniques 
You can cut-and-paste MIDI notes within the editor and between MIDI objects. The 
notes are always inserted at the play cursor’s position.  

Duplicate: The selected notes are copied and inserted after the next grid point if the 
quantization grid is active (menu "Options -> Quantization grid on"), or immediately 
after the selection if the grid is inactive.  

Create pattern from selection ("Ctrl + P"): The length of the pattern is quantized if 
the grid is active. The pattern can be "painted" into the MIDI object using the mouse 
mode "Pattern painting".  

To directly select notes with a specific pitch, double click on an empty area in the 
piano roll editor or in the keyboard ruler.  

MIDI Editor shortcuts 
Playback/Stop Space 
Stop at position '0' (Number block) 
Delete all selected events Ctrl + Del 
Delete selected MIDI notes Del 
Select all non display-filtered notes (piano roll) or 
events (list) 

Ctrl + A 

Mute notes Ctrl + M 
Create pattern from selection Ctrl+W 
MIDI recordings Ctrl+R 
Undo (Undo) Ctrl + Z 
Restore (Redo) Ctrl + Y 
Cut Ctrl+X 
Copy Ctrl+C 
Insert Ctrl+V 
duplicating Ctrl+D 
Imported standard MIDI file Ctrl+I  
Exported standard MIDI file Ctrl + E 
Fade in/Out Event Editor Ctrl+L 
Fade Velocity In/Out Ctrl + T 

Show Quantization grid Ctrl+K 
 
Mode selection Ctrl + 1 
Drawing mode Ctrl + 2 

Drum (Draw Mode) Ctrl + 3 
Pattern (Drawing) Mode Ctrl + 4 
Change velocity Ctrl + 5 
Delete Mode Ctrl + 6 
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Zoom Tool Ctrl + 7 
 
Quantize Ctrl + Q 

Quantization options Alt + Q 
Select previous Note/Event Up/Left arrow 
Select next Note/Event Tight/Down arrow 
Play selected notes Ctrl+N 
End all notes Ctrl+P 
Grid on/off Ctrl+G 
Auto-scrolling during playback Ctrl+F 
Vertical zoom in Ctrl + Up arrow 
Vertical zoom out Ctrl + Down arrow 
Horizontal zoom in Ctrl + Left arrow 
Horizontal zoom out Ctrl + Right arrow 
Horizontal scrolling Mouse wheel 
Vertical scrolling Shift + Mouse wheel 
Zooming Ctrl + Mouse wheel 
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Drum Editor 
After opening the MIDI Editor (double-click on the MIDI object), switch to the 
corresponding field  

 

in the Drum Editor  by clicking. Instead of the piano keys to the left, you now see a list 
of drum instruments. 

 

Note: If a drum map is active in the Arranger track (recognizable by the word "map" 
in t he MIDI area of the Track Editor), the Drum Editor is loaded automatically when 
the MIDI Editor is loaded. 

Drum Editor track box: In the individual track boxes of the Drum Editor you can 
individually adjust MIDI channel, grid, quantization length, display width in cell mode 
and velocity scaling for each drum instrument in %. 

Velocity scaling: The velocity value of each note is multiplied by the V value/100 and 
adjusted to the MIDI velocity between 1 and 127. Scaling is audible, however, it is not 
visualized further. Scaling is audible, but is not visualized further. 

Cell Editing Mode: (view page 100) When the Drum Editor opens, Cell Mode 
activates by default. In addition, you can individually set the display width for each 
track box in the Drum Editor. 
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Switch to Drum Editor Mode and back. 
After opening the MIDI editor (double click the MIDI object), switch to 
"Drum editor" mode by pressing the drum editor button.  

Instead of the piano keys to the left, you now see a list of drum instruments. 

When you switch from "Drum editor" mode back to the normal piano roll, you will be 
asked if you wish to apply mapping or not. If you add mapping, all mapping settings 
(which makes a note sound different to how it is displayed) will be applied to the 
MIDI object. If notes, for example, are routed through channel 10 (GM drum channel) 
via mapping, the notes will be replaced by corresponding "real" note events on 
channel 10. 

Cell mode 
"Cell" mode serves to improve the overview as it limits the display to only the most 
important information, note starting points, and velocity. 

Each time position of a bar is displayed as a row of cells in on/off states. The note 
length is not displayed, but rather a unified display width is used. This way, it all looks 
similar to the step sequencer of a drum computer (see Robota (view page 121)). 

The set quantization grid can be read from the width of cells. "Swing" and "Offset" 
settings of the quantization options are also made clearer thanks to cells of various 
widths and by repositioning. 

The height of cells displays the velocity of the note. When drawing new drum notes 
the velocity can be specified via the vertical drawing position within the cells. In 
connection with the "Drum draw" mode, increasingly loud drum rolls can be drawn in 
easily. 

By clicking on the upper edge of a cell and dragging it vertically with the mouse, the 
velocity can be adjusted directly without having to use the controller editor. In 
"Velocity" mouse mode ("Ctrl + 5") it's even easier; all you need to do is click 
anywhere on the cell. 

Drum Editor trackbox 
In the drum editor, each individual note has its own trackbox, and individual settings 
can be specified for each instrument. When zoomed out, each trackbox can be 
increased in size with a simple mouse click. 

 

S/M: Each individual instrument can be played solo (S) or muted (M). 



 

MIDI Objects 101  

 

Note number: The output note from the instrument can be set here. This can be 
different to the note currently displayed in the MIDI object so that individual drum 
instruments can be substituted. To put the display of notes back into the usual order 
(deep notes at the bottom, highs at the top), click on "Map" at the top and use the 
"Sort drum map" command. 

Instrument name: Double clicking on this field lets you rename your drum instrument. 

 Quantization options/colors: Use this menu to assign any one of the eight 
different colors to the cells of a drum instrument. The dialog for the instrument's 
quantization options is also opened here. 

The dialog is the same as for global quantization options (view page 94), but the 
settings only apply to the individual quantization options if an individual grid value is 
set for the note as well.  

K Output channel 
# Quantization grid, "Glo" refers to the global value (More information can be found 

in the section "Quantization settings" on page 94) 
L Note length, # corresponds to the grid value, "Glo" to the global value 

 Length of the notation, # corresponds to the grid value (i. e. the entire cell width), 
"Glo" refers to the global value of the note length 

V Velocity scaling: The velocity value of each note is multiplied by the value set here 
in %. 

Scaling is audible, but is not visualized further. The purpose of this setting is the 
customization of the volume ratio between the individual drum instruments. Software 
instruments usually provide their own mixers. 

Drum Maps 
Drum maps specify individual instruments, e.g. bass, drum, hi hat, snare, etc. An 
individual output note, MIDI channel, and velocity scaling can be set for each of these 
instruments. 

 The drum map can be set in the drum editor by clicking 
the "Map" field. 

To split the drum names a "General MIDI" map is used by default. It may be the case 
that your synthesizer (regardless if real or virtual) uses a different mapping setup. 

This means that when you play the drum event, the sound you wish to hear may not 
be heard (for example, instead of a bass drum, you get a high tom). In this case you 
will have to re-sort your mapping setup. The settings for individual instruments can be 
specified in the trackbox. For more extensive changes we recommend using the drum 
map editor. There you can save your drum map as a file. 

A project may contain various different drum maps. All drum maps saved in the 
project can be selected via the menu. If you require a drum map from a *.map file, you 
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will have to load it into the drum map editor first so that if can be shown in the menu. 
You can edit the individual drum maps in the drum map editor. 

Drum Map Editor 
The drum map editor can be used to create and edit drum maps. 

The "Drum maps" list on the left-hand side displays all drum maps which are available 
to the project. The drum map GM General MIDI is always available to start off with. 

New: Creates a new, empty drum map. 

Copy: Creates a copy of the existing map. This way you can quickly create variations 
of a drum map with various note allocations which can then be toggled via the drum 
editor. 

Load/Save: Use this to save a drum map (*.map file). This way you can use a drum 
map you created for a synthesizer in other projects as well. All loaded maps will be 
displayed in the "Map" menu of the drum editor. 

Delete: Removes the selected drum map from the project. 

Use the name field to rename the selected drum map. The settings (mapping) of the 
individual notes for each drum map will be displayed below this in tabular format. 

Pitch: This is the incoming MIDI note. 

Instrument: Displays the name of the drum instrument, e.g. "Bassdrum 1". 

Grid: If desired, you can set up a grid for the starting point of the drum events. 

Length: In this field you can set the grid for the note length. 

Output note: This is the note value to which the drum instrument (the incoming MIDI 
note in the "Pitch" field) should be routed or mapped. 

Channel: You can set up an individual channel for each instrument here. 

Quantization options: This opens the dialog for the each instrument's quantization 
options (view page 94). 

Instrument, grid, length... apply to all: This applies the corresponding setting of the 
selected instrument to all other instruments. 
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Software Instruments 
MAGIX Music Maker 2013 has many software synthesizers and synthesizer plug-ins 
(VST instruments) for creating  your own sound material. The synthesizers are either 
VST plug-ins that are controlled by MIDI objects or Synth objects that can be 
arranged with other objects in the tracks. 

Here's an overview: 

Synthesizers Type Use scenario 
Atmos Synth object Background noise 
BeatBox 2 or 
BeatBox 2 plus (Premium 
Version) 

Synth object Nature and electronic beats 

Loop Designer (view page 111) Synth object Breakbeats, bass lines 
Livid Synth object acoustic drums (complete song 

parts) 
Robota Synth object electronic drums 
Revolta 2 
(only Premium-Version) 

VST Plug-in Synthesizer leads, pads, sequence 
figures 

Vita VST Plug-in Nature instruments, guitar, bass, 
acoustic drums, piano, strings, 
horns 

Vita Solo instruments VST Plug-in  

VST plug-ins VST Plug-in depends on plug-ins installed 
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Opening the synthesizers 
The software synthesizers can be loaded just like any other objects in MAGIX Music 
Maker 2013 through the Media Pool.  To do this open the Instruments settings for the 
Media Pool. 

 

You will find icons for all available software synthesizers in the Media Pool. The upper 
section contains all the VST instruments; the lower section displays the object 
synthesizers. 

Synth objects 
MAGIX Music Maker 2013 contains many internal synthesizers for creating your own 
drum patterns, break beats, bass lines, or ambient noise. The synthesizers are 
represented either by internal synth objects that can be arranged together with other 
objects on the tracks. 

Every software synthesizer can be loaded into the arrangement via drag & drop. A 
synth object appears in the appropriate track and the synthesizer interface opens, and 
synth objects can be programmed via this interface. You should also read the sections 
about the individual synthesizers. 

You can start or stop the playback with the space bar. If the synth object has a play 
button of its own (e.g. BeatBox), the plug-in can start it solo without playing the other 
arrangement tracks. 

If the synth objects melodies or rhythms are programmed, you can close the the 
control console and arrange the synth object in the track. Synth objects are handled 
like normal objects and can be edited with all available effects (view page 132), drawn 
longer or made shorter using handles, or have their volume adjusted. 
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The interface of any synth object can be opened for further editing by double clicking 
it. In addition, any number of synth-objects from the same software synthesizer be 
dragged onto the track and programmed separately. You can also split up synth 
objects. 

BeatBox 2 
BeatBox 2 is a 16-voice drum computer with hybrid sound synthesis and a step 
sequencer. The proven handling concepts of the "old" BeatBox like matrix 
programming with auto copy have been expanded with comfortable editing of 
velocities and significantly improved sound synthesis, including a multi-effects 
section (one effect per drum instrument). 

A drum sound is created in BeatBox 2 using a sample (analogously to the old 
BeatBox) which is combined with a synthetic sound that can be created using up to 
three different synthesis models (hybrid sound synthesis). BeatBox 2 plus enables 
detailed editing and automation of all sound parameters. 

There are two styles of interface in BeatBox 2. While closed, you can listen to included 
sounds or those you've made in BeatBox 2 without using too much window space. 

 

Only the most important control elements are displayed when the program window is 
minimized. 

 Volume controller: Controls the volume. 

 Peakmeter and preset name: The peakmeter lets you visually control BeatBox 2. 
Click on the triangle beside the preset name to open the preset list. 

 Next/Previous preset 

 Save preset: The preset includes the drum kit in use, the pattern, and any possible 
automations. 

 Play/Stop: The playback controller in BeatBox 2 starts BeatBox without playing 
the arrangement, too.  

 Edit button: The edit button opens BeatBox 2 for you to program your own beats 
and sounds. 
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Maximized BeatBox 2 window 

 Drum kit: This section loads drum kits (collections of different drum instruments) 
and the individual drum instruments. 

 Selected drum instrument: The settings in the synthesis section (6) and 
velocity/automation (5) always affect the selected drum instrument. 

 Pattern editor: Programs the beat sequence. In the top part, different patterns 
(sequences) can be loaded and saved as well as different settings for the view 
and function of the pattern editor. The matrix is where the beat is programmed: 
One line corresponds to a drum instrument, and a column matches a specific 
time position within 1-4 beats. If a cell is clicked on, then the respective drum 
instrument will be triggered at this position. 

 Velocity: In the velocity section, the velocity levels for the selected instrument's 
beats are displayed as a bar for detailed editing. 

 Synthesis: Selected sound parameters and the level of the effect for the selected 
drum instrument can be edited here. 

In the following, the sections of BeatBox 2 will be discussed individually: 
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Drum kit 
This section loads drum kits (collections of different 
drum instruments) and the individual drum instruments. 
You can also try out an already programmed pattern 
with different kits or exchange individual drum 
instruments. 

 

 Select drum kit: Use the <> buttons to switch through the different drum kits. A 
drum kit is a collection of percussion instruments with matching sounds, e.g. 
rock kit or electronic drums à la TR 808. By changing the drum kit, you can add 
an entirely different sound to the rhythm you have already created. 

 Save drum kit: Use this button to save the current collection of drum 
instruments as a kit. 

 Drum kit list: Click on the arrow right of the name to open a complete list of 
available drum kits. 

 Select drum kit: The arrow buttons function analogously to those of the drum 
kit. The sequence of drum instruments in the kit can be resorted via drag & drop. 

 Mute/Solo: The "solo" button switches a drum instrument solo, i.e. all other 
instruments which are not "solo" will be muted. The "mute" button mutes a 
drum instrument. 

New drum or effect sounds can by added to the current drum kit by drag & drop from 
Windows Explorer. Drag a wave file to a drum instrument to create a new drum 
sound based on this sample. BeatBox 2 copies the sample into the sample folder to 
make sure that the instrument or kit created can be used again later. You can drag a 
complete folder with wave files to the drum kit to create a kit based on those samples. 

Context menu 
Right clicking a drum instrument always opens a context menu: 

• Copy/Paste: Copy an instrument from a track and paste it to another one. 
• Empty instrument: An empty instrument is added. No sound is played, it has no 

name, and is used to clean up an unused track. 
• Default instrument: The standard instrument is added. It has the standard 

parameter for all synthesis shapes and serves as the starting point for your own 
sounds. 

• Reset automation: BeatBox 2's own presets contain automations. These are 
dynamic sound parameters like filter curves or pitch changes. This command 
allows you to completely remove these for the selected instruments. 
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Pattern editor buttons 

 
 Pattern: Use the <> buttons to switch through the different patterns. The arrow 

to the right opens a list of all available patterns, and the save button stores the 
current pattern. 

 Clear track/all: All events for the selected instrument (track) or all events for 
the pattern (all) are removed by clicking this button. 

 Bar selection: The bar you wish to edit can be selected via the corresponding 
number button. Use the “Follow” button to select follow mode, i.e. the step 
display follows the steps of the currently played beat. All shows all bars of the 
pattern. 

 "1>2-4" Auto copy: If more than one bar is set as the pattern length, "Auto 
copy" mode makes sure that the drum notes set in the first bar are 
automatically placed into the next bars. This also makes it easy to create a 
continuous beat, even with a loop length of four bars. Notes set in the bars 
further back are not affected by the "Auto draw" function, which, for example, 
makes faint variations detectable only in the fourth bar. 

 Bars: The maximum length of a drum pattern is four beats. The length can be 
selected via the small scroll bar. 

 Shuffle: This controller changes BeatBox 2's timing. If the fader is turned to the 
right, the eighth of a rhythm is played more and more like a triplet. If that 
sounds a bit too abstract – simply try it out, ideally with a pure 1/16 hi hat 
figure; you'll soon see what the shuffle fader is capable of. 

 Grid: Here you can set the time resolution of the BeatBox. You can choose from 
1/8 notes (only for very simple rhythms), 1/16 (default), 1/32 (for more refined 
constructions). 

 

Pattern editor - matrix 

 

This is the heart of BeatBox. A click on any position in the drum matrix creates or 
deletes drum notes (events). Clicking and dragging draws in a series of notes. 
Together with the velocity editing options (view page 109) (velocity), you can easily 
create drum rolls. 

If "Shift" is held when you click on notes in the range, a rectangle can be drawn out 
which selects the notes contained within this rectangle (lasso selection). Selected 
notes can be copied by dragging them to a new position. If "Ctrl" is also held down, 
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then existing notes will remain at the target position. Delete all selected notes by right 
clicking. 

A simple mouse click cancels the selection. The selection is automatically canceled 
after copying. If you want to keep your selection, hold down "Ctrl" while copying. 

Keyboard shortcuts 
Many functions in BeatBox 2 can be controlled with the keyboard, for example a beat 
can be triggered with the "Enter" key live in a running pattern. Here's a complete list 
of the keyboard commands: 

General Key command 
Open/Close editor e 

Pattern editor - options 
"1>2-4" Auto copy a 
Follow f 
Display bar 1... 4 1... 4 
Show all bars 0 
Grid finer/rougher +/- 

Selected drum instrument 
Previous/Next Cursor up/down 
Preview p 
Live input Enter 
Mute on/off m 
Solo on/off sec 
 

Velocity 
The velocity section serves for editing the velocity of the individual drum notes for the 
selected drum instrument. 

 

 Reset: Sets all velocity levels to 100% 

 Random: The random parameter adds random variations to the set velocities. 
This helps make your beats sound more natural. 

 Velocity level: Every set note for the selected instrument is displayed as a 
column and can be edited. Multiple columns can be edited at once - see 
Editing velocity values (view page 109). 
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Editing velocity values 
Hold down "Shift" and select any number of columns with the mouse. 

 

The "Copy" button copies the selection to the clipboard. If you select this or that track 
in another editor, then you can paste the notes there now from the clipboard. If the 
target selection is larger than the contents of the clipboard, then it will be inserted 
again. This lets you quickly add a short section throughout the complete length of the 
pattern. 

The three handles allow the velocity values to be edited together. 

 

The middle handle increases or lowers the values together. 

 

An object can be faded in or out with the handles to the left and right upper corners of 
the object. 

 

If you move the handles horizontally you can change the curve shape of the transition. 

A single click in the velocity section cancels the selection again. 

Note: A selection of velocity values matches the selection of corresponding notes in 
the matrix editor. 
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Synthesizer 
In the lower section of BeatBox, you can set the sound for the selected drum 
instrument. 

The synthesis in BeatBox 2 consists of a combination of a simple drum sampler and a 
synthesizer. There are three different synthesis models possible for the synthesizer: 
"Phase Distortion Synth" (FM synthesis), "Filtered Noise", and "Physical Modeling". 
The mixed signal of both components is then processed by a multi-mode filter. An 
envelope curve ("envelope generator") time-dependently controls modulations of in 
all components. 

 

 Preview drum istrument 

 Mix: Mix relationship between drum sampler and synthesizer. 

 Parameter controller: All six sound parameters for a drum sound can be directly 
set and automated via the parameter controllers. The parameters in question 
depend on the drum sound currently loaded. 

 Effects level: Each of BeatBox 2's drum instruments includes an effects unit which 
is fed in after the actual sound synthesis and editing. The type of effect depends 
on the selected drum sound. 
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Loop Designer 
The loop designer unites both stellar design elements of drum'n'bass style in a 
"device": turned-up beats and rumbling bass lines. With the Loop Designer you can 
create authentic drum'n'bass sounds without any specialized knowledge. 

Tip: Drum'n'bass tracks usually have between 160 and 180 BPMs. The Drum&Bass 
Machine can also be used for other music styles.  e.g. for BigBeat (120 BPM) or 
TripHop (80-90 BPM). 

Loop Designer: overview 

 

The top half of the synthesizer controls the rhythm section, the lower half - the bass 
section. You can mute both sections using the M symbol on the left border. This way 
you can, for example, turn off the bass section in order to take only the drum section 
into the arrangement. Only the drum section will then be added to the mixdown file 
when mixing down the arrangement. Next to this are the volume controls, which 
control the volume of both sections. 

You can preview and stop your drum'n'bass creations using the "play" and "stop" 
buttons.  

Additional buttons: 

 Loads a saved pattern with all settings. 

 Saves a pattern.  

 Undo for all settings made in all sections.  

 Makes random settings changes in both sections. You can change 
settings later as you wish.  
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Drum section (top half). 
Here complex, authentic-sounding Jungle-Breakbeats can be put together easily. In 
professional recording studios Jungle-breakbeats are made by chopping up arbitrary 
drum loops and putting them back together in a different order. These laborious work 
steps are significantly simplified by Loop Designer.  

The new sequence is determined in the top row, the so-called "step" row. The grey 
cells represent the individual sections ("counts") into which the loop is separated. 

Pick a different note or playback by left-clicking a grey cell. Various notes will be 
represented with a light bar which "grows" toward the top with each mouse click. This 
way, each time you click on the grey cell, the bar expands by one step.  

 

1 of 4: Play Drum Loop starting from the first note. 
 

 

2 of 4: Play Drum Loop starting from the second note. 

 

3 of 4: Play Drum Loop starting from the third note. 

 

Full bar: Play Drum Loop starting from the fourth note. 

 

Reverse icon: Play backwards from this position 

 

Stop icon: Stop playback 

 
The right mouse key deletes settings of a step bar and the Drum Loop is played in its 
original order. 

 
Pressing the double-arrow button generates a random step sequence. 
You can change this rhythm as you like.  

 

 

Clicking into the blue field in the left part of the drum 
section opens a pop-up menu where you can pick the 
sound of the Drum Loop. When you select another drum 
loop it will load and be played in the way you 
programmed it. 
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Tip: You can also send a loop from Soundpool or a wave file to Loop Designer. To 
do so, select the desired loop or file and drag it into the field while holding down the 
mouse key ("drag & drop"). 

In the field under the "steps" row the sound of the loops is defined. The intensity of 
the settings is determined with a control similar to a peakmeter. The higher the bar, 
the stronger the influence on the loop is. With the help of the left mouse key, values 
can be smoothly adjusted. "Volume" controls the loudness (full = loud, empty = 
quiet), "filter" the filter strength (full  = clear, empty = muffled). In the "Flam" row you 
have the option to make the note repeat itself twice in quick succession. This is how 
to program rolls and fill ins.  

Using the top arrow buttons at the right edge you can load pre-defined pattern 
settings. The originally set loop will not be changed. The two lower arrow buttons 
offer presets in the form of standard curves for "volume" and "filter".  

 

The "Filter type" controller selects the type of the filter sound: 
"BP" stands for "bandpass", "LP" for "low pass" and "HP" for 
"high pass".  

 

Bass section (lower pane) 
The bass section produces suitable bass lines. 

• The first row of the "Notes" row, determines the order of the sounds i.e. the 
series of notes. Select a cell with the left mouse click, where the lowermost 
represents the lowest note and the topmost  - the highest. A right mouse click 
deletes a cell.  

• In the "Octave" row you can specify the octave of the bass. The slide control 
positions represent the various octave values. If the controller is down, a deep 
sound is produced, if it is in the top position, you will get a high tone. If the 
controller is in the middle, the pitch will be balanced.  

Just like in the drum section, here you will also find arrow buttons on the right side for 
opening pre-defined patterns and and a double-arrow button for setting arrows. The 
filter can be set analogously to the drum section. The arrow button next to the filter 
area select presets in the form of standard curves.  

You can determine the bass sound in the blue selection field at the left side. You can 
drag loops and WAV sounds into the field using drag & drop just like in the drum 
section.  

Additionally, there are two slide controllers for sound changes to the right: 
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The "Vibrato" slider makes the bass tone's pitch change. When 
the control is to the far right, the sound vibrates more, if it's to 
the far left pitch isn't changed at all. 

 

The slider "Decay" determines how long should it take to for the 
sound to subside. Set to the far right the sound is very fast 
(about 1 / 4 of a second), on the far left the sound lasts longer. 

 

LiViD - Little Virtual Drummer 
MAGIX LiViD helps you to turn your ideas into songs. Enter a few basic details and 
LiViD will play a full drum track, complete with intro, verses, choruses, fills, bridges 
etc.; the entire song structure is laid out for your convenience. Brilliant stereo drum 
samples recorded by professional studio musicians and a freely adjustable 
“Humanize“ function will  create an authentic drum feel with perfect sound quality. 

LiViD features four styles (pop, rock, funk, latin), each of which is subdivided into four 
further substyles, as well as six song sections for each substyle (intro, verse, bridge, 
chorus, outro, fill-in). 

 

Scramble: A random sequence of four one-bar patterns is generated internally for 
each style/substyle/song section. “Scramble” generates a new pattern order. 

Shuffle: Shifts the second and fourth 16th note of a beat back by a freely definable 
amount (100% = triplet rhythm). 
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Humanize: Randomly shifts all events backwards or forwards, or leaves them 
unaffected. Note: these shifts are very subtle and not always immediately perceptible! 

Snare: Sets the snare stick style to “normal”, “side stick” (stick hits the rim while 
resting on the skin) or “rim shot” (sticks hits the rim and skin simultaneously). 
Exception: the snare’s quietest velocity level ( the "ghost notes") is always “normal”. 

Hi-hat: Sets the hi-hat sound to “soft” (fully closed) or to “hard” (half-open). 
Exception: completely opened hi-hat (pop, type1, verse). 

Ride: Sets the ride cymbal sound to “ride” (cymbal is hit on the rim) or “ride bell” 
(cymbal is hit on the bell at the center). 

Robota 
The Robota is a four-part drum computer with virtual analog and sample-based sound 
production. Virtual analog sound production means that the sounds are synthesized 
in real-time, i.e. produced with a synthesizer to recreate the typical analog sounds of 
classical drum computers, such as the Roland Tr-808 and Tr-909, or more recent 
devices such as the Korg Electribe or the Jomox x-cousin. Sample sound production 
uses drum sound recordings (or even other recordings) as the basis for sound 
production.  

After selecting the elementary sound production technique, the sounds of each of the 
4 parts (or instruments) can be edited using modulators.  

The step sequencer programmed with incident lighting helps Robota to play. 4 beats 
in sixteenths (or 2 beats in thirty-seconds) are processed as a loop. At each beat 
position, the playing positions can be set by clicking a button. In "Event" mode, the 
instruments are distributed within the beat pattern. In "Snapshot" mode you can 
adjust additional instrument sound settings.  

Sound synthesis 
The four instruments of the Robota are built identically. Each instrument can create all 
kinds of drum sounds –  from hissing hi-hats to phat bass drums.  

During elementary sound production, you can choose between an oscillator with 
selectable wave shapes (sine, triangle or saw tooth) or a sample. In addition, you can 
add a noise generator can be added. The oscillator has a pitch envelope (pitch env.) 
and a volume envelope (attack/decay). It can also be frequency and ring-modulated. 
The depth of the modulation can be controlled via an envelope parameter (Fm/rng 
dcy). There’s also a “Lo-fi” section consisting of distortion (Rectify), bit rate reduction 
(Crush) and sampling rate reduction (down sample). 

Temporal control via an envelope (lofi dcy) will get the best out of the lo-fi effects. A 
multi-mode filter (low-pass/band-pass filter/high-pass) with 12/24 dB steep-side. A 
comb filter can be inserted. The filter frequency can be likewise modulated via an 
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envelope. For extra pressure, an adjustable compressor (compressor, comp resp) is 
included, as well as tube amplifier simulation (tube).  

Parameter (1): To simplify matters, not all parameters 
can be changed on a sound - only those that are 
meaningful for the selected drum sound may be 
changed (snare, kick, high etc.). There are four selected 
variable parameters coordinated exactly with the 
selected preset sound.  
Oscillator waveform (2): The fundamental waveform of 
the Oscillators is selected here. You can choose from  
sinus/triangle/sawtooth/sample. If you have selected 
"Smpl" you can use the rotary knob to select a sample, 
i.e. a previously recorded drum sound. These samples 
are saved in the folder /synth/robota/samples/. If 
select custom samples, they will appear in the selection 
list. 
(3): For each part you can regulate: Filter Cutoff, 
Resonance, Tube, Volume and Panorama (view page 
118). 

 

 With select choose the instrument for editing in the step sequencer.  

 “M” mutes the instrument, “S” makes it solo   

 The loudspeaker button allows you to hear a preview. 

Master Section 
Volume regulates the total volume of the Robota. Distortion adds an adjustable tube 
distortion to make the sound “dirtier” and more powerful. The peak meter helps 
control the output level – when it enters the red area, reduce the total volume.  
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Schematic illustration of the Robota synthesis 

 

Here is a detailed circuit diagram of a Robota voice with a description of all control 
parameters.  

Pitch envelope (pitch env) 
Controls the pitch envelope level. 

Tune 
Tunes the instrument. 
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Oscillator shape (osc shape) 
The shaper adds additional frequency shares to the basic sound of the oscillator by 
artificially reshaping the wave shape. A sine wave (shape = 0) can be reshaped up to 
a square curve (shape = max). 

Oscillator waveform 
The fundamental waveform of the oscillators is selected here. You can choose from 
sine/triangle/sawtooth/sample. If "Sample" is selected, you can use the controller to 
select a sample, i.e. a previously recorded drum sound. These samples are saved in 
the folder /Synth/robota/samples/. If you select custom samples, they will appear in 
the selection list. If you are playing your own samples, they will appear in the selection 
list. 

Noise 
Adjust the ratio between the oscillator sound and the noise generator. 

Attack 
Adjusts the attack time. The greater the set value, the softer the attack of the sound. 
The attack rate is also applied to the lo-fi and filter envelope curves. 

Decay 
Adjusts the decay curve. The greater the value, the slower the instrument will decay. 

FM/Ring modulation frequency (Fm/rng frq) 
The fundamental frequency of the frequency or ring modulation.  

FM level (fm lvl) 
At a low frequency FM first adds vibration to the sound, at high frequencies and low 
levels it creates bell-like sounds, as the level increases metal sounds, and finally noise. 

Ring modulation level (rng lvl) 
Ring modulation creates typical auxiliary frequencies. 

FM/Ring modulation decay (Fm/rng dcy) 
Time constant of  FM/ring modulation by-product. Only the beginning of the drum 
sound is affected by the modulation.  

Rectify 
Distorts the audio signal. 

Crush 
Bit rate reduction. Digital artifacts become audible with higher settings.   

Down sample (dwnsmple) 
Sample rate reduction. Ideal for creating the "old school sound" of older digital drum 
machines. As it is increased, the result becomes darker. 

Lo-fi decay (lofi dcy) 
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Time constant of the by-product of the three lo-fi effects which makes the sound 
"dirty". Only the beginning of the drum sound of the lo-fi effects is affected if the 
decay is low. For instance, this makes the kick of a kick drum sound more interesting. 

Filter modes (flt mode)  
Filter mode: High cut – sound portions above the cut-off frequency are filtered out. 
Band pass (BP) – Sound portions above and below the cut-off frequency are filtered 
out. Low cut - All sound portions below the cut-off frequency are filtered out. This 
mode is set as a preset and can not be changed. 

Filter frequency (flt freq) 
The cut-off frequency of the filter. 

Filter resonance (flt reso) 
Filter resonance which increases the sound portions at the cut-off frequency of the 
filter. If the resonance is high, the filter itself can also be used as an oscillator. 

Filter modulation -/+ (flt mod -+) 

Regulates how much and in which direction the filter envelope curve moves the filter 
frequency in which direction. 

Filter-Modulation decay (flt mod dcy) 
Decay time of the filter curve. Smaller values with high resonance create a "zapping" 
sound of the filter, greater values create the typical sweep sound. 

Filter modulation velocity (flt mod vel) 
Specifies how much the filter modulation depth depends on the velocity. If this value 
is increased, louder beats will generate higher filter curves than quieter ones. 

24 dB 
The filter can operate with a slope of 12 dB or 24 dB. This mode is set as a preset and 
cannot be changed. 

Comb filter (comb filt on) 
You can activate a comb filter, a feedback delay that creates resonance-like sounds 
comparable to a plucked string. The delay time and feedback levels are permanently 
linked fo the filter parameters (frequency and resonance). This comb filter is set as a 
preset and can not be changed. 

Compressor 
Controls the compressor strength. This lets you increase the "power" of the drum 
sound. 

Compressor response (comp resp) 
Controls the compressor time. The lower the value, the faster the compressor follows 
the volume. 

Tube 
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Controls the level of the tube amp simulation. It "saturates" the output signal of the 
voice and adds warmth to the sound if the settings are moderate. Increasing the 
settings makes the sound "dirtier". 

Volume/Pan 
Controls the volume and panorama position of the drum instruments. 

Sequencer 

  

Incident lighting is used to control the drum patterns just like in all classical drum 
computers and groove boxes. The step sequencer consists of 16 individual step 
buttons with LEDs corresponding to the appropriate partitioning of a beat:  

16ths or 32nds (a half beat is in each case displayed). A button lights up to indicate 
the releasing of the instrument at this point in the beat (= step).  

A left click turns on the step, a further left click deletes the step again.  

 

A pattern can be a maximum of 4 beats long. The length can be modified 
using the fader on the button bar. 

 

The beat to be edited can be selected with the applicable “edit” button. The “Follow” 
button specifies whether the step of a beat is in time. 

"1 > 2-4" auto draw: If more than 1 beat is activated as the loop length, the "Auto 
draw" mode ensures that the drum note set in the first beat is set automatically for 
the following beats. This makes it very simple to produce a continuous beat from a 
loop length of 4 beats. Notes set in the rear beats are not affected by auto draw.  

How to program a drum pattern: 

• Select the pattern length with the fader. 
 

• Select “Event” mode. 

 

• If you edit during playback, turn off “Follow”. Select the beat with the “Edit” 
buttons.  

 
 

 • Use “Select” to choose an instrument to edit.  
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 • Use the “Clear bar” button to delete all steps in the selected 
instrument. 

 

 

• Turn on the appropriate step buttons, and use the “Velocity” 
controller to adjust the beat velocity.  

 

• Repeat the procedure with the other instruments  

Snapshots 

In addition, you can automate programming of the editable sound parameter of a 
drum sound via so-called "snapshots". You can thereby save the sound parameters of 
a drum instrument on the step buttons of the sequencers. 

Automating the drum instrument with snapshots.: 

 

• Set the edit mode to “Snap”.  
• If you edit during playback, turn off “Follow”. Select the beat with the “Edit” 

buttons.  
• Select an instrument and edit the sound. You can control the sound of an 

instrument even when playback has stopped by using the loudspeaker button. 
• Save the sound as a snapshot to one of the step buttons. 
• Change the sound of an instrument and save the settings to other step button 

Warning: The parameters are not changed abruptly but are faded internally instead, 
in order to avoid crackling. If two snapshots with extreme parameter differences are 
too close together, the drum sounds will sound differently when the pattern is 
played. 

• Using the arrow keys, you can jump between the individual 
snapshots during stopped playback.   

• Press “on” to activate snapshot automation.  

Groove Control 
The secret behind “groove” beats lies in delay. That is, individual beats are either 
anticipated or delayed according to patterns. For example house beats use the 
“shuffle” whereby straight 1/16s are delayed at certain times. 
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In the Robota there are groove velocity and groove swing presets. Groove velocity 
presets contain for each step of a beat a certain offset to increase or reduce the 
original beat velocity. Groove swing presets contain for each step a time alignment 
that is either anticipated or delayed. The result is a livelier-sounding sequence. The 
strength of the effect can be adjusted with the % regulator.   

Setups, drum kits, presets, and patterns 

  

A single instrument sound is saved as a 
preset.   

 

Presets containing all four instruments 
are saved as drum kits.  

 

All note information plus the snapshots 
are saved as a pattern.  

 

Together (drum kit + pattern) they are 
know as a setup.  

Load/Save 

Presets, drum kits, patterns and setups can be selected with the continuous rotary 
regulators next to the display area. For storing, click on the  “Save” button. Then 
specify a new name in the input field. To store, press “Enter”.  

Note: A drum kit stores only the names of the presets, not the actual parameters. If 
you want to store your own drum sounds that were created by changing existing 
presets, you must first store them as new presets and then as a new drum kit! The 
same applies to the setups, which contain only the pattern and drum kit names. 

If necessary, always store in this order: preset -> drum kit -> pattern -> setup. This 
applies only when creating your own “templates”. If you store your arrangement 
normally, the complete current status (synthesizer + sequencer) of the Robota is 
always stored and correctly loaded later with the arrangement. 
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Atmos 
Atmos is a synthesizer which can be used to easily create realistic nature sounds in 
no time. From thunder and lightning to animal sounds and traffic noise, Atmos helps 
you design natural-sounding atmospheric noises for your projects. 

 

• In the upper border window, select the top category "Scenario". You can select a 
desired nature sounds category (for example, "Thunder and Lightning"). 

• In the middle of the window, a collection of control elements appears for 
designing the desired "Ambience". Each element has its own description (e.g. 
"Thunder") and two faders, i.e. "Volume" and "Intensity". The "volume" control 
adjusts the loudness portion of the element. The "Intensity" fader controls the 
behavior of the sound, depending on controller element. For example, with 
"Thunder", you can set how often thunder and lightning should sound; with 
"Rain", the strength of the rain can be regulated (if moved to the far left, light rain 
can be heard, while if moved to the far right, a downpour with loud splashing 
noises is audible). 

• At the bottom right border you will find a master volume fader with which the 
master volume of the synthesizer can be set. Furthermore, the "Randomize" 
setting is also located here. This way you can change the settings of the control 
elements by yourself. 

Synthesizer plug-ins 
MAGIX Music Maker 2013 includes Vita and the Revolta, two VST plug-in-based 
software synthesizers (see below). Compared with other synthesizers that are 
addressed via synth objects, these feature several differences: 

• Generally, VST instrument plug-ins (VSTi) do not feature sequencers of their 
own and are controlled via MIDI objects.  
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• VST instruments are always loaded onto a certain track, and all MIDI objects on 
this track control this VST instrument. The MIDI objects cannot be moved 
between tracks freely like synth objects. 

• Effects may be only applied on the track level. 

Nevertheless, these are much more easier to manipulate in MAGIX Music Maker 
2013 due to MIDI control, and sequences may also be recorded (view page 86) using 
MIDI keyboard. 

What are VST and DirectX plug-ins? 
A plug-in is an independent program section which can be added to another program, 
to broaden its range of functions. Various standards were developed for including 
plug-ins. "VST" and "DirectX" have become the most widely used. 

"VST" stands for "Virtual Studio Technology". VST plug-ins offer an elegant way of 
copying and making virtual devices that are normally used in recording studios. 

"DirectX" is a Microsoft standard for plug-ins similar to VST plug-ins. 

The advantages: 

• Purchasing expensive synthesizers or effect devices is no longer necessary. 
• An expensive sound card is no longer necessary for high-quality recordings from 

external devices. 
• VST instruments and VST/DirectX effects provided by lots of third party 

providers are better value or are even made available as freeware. 

The disadvantages: Each of these plug-ins uses up processor power. The more a plug-
in is used, the faster your computer should be. The required processing power is, of 
course, also dependent on the size, state, and complexity of the plug-in. 

Using VST instruments 
VST instruments are loaded via the Media Pool. These appear in the area below the 
"Synthesizer" setting (synthesizer track). 

If you have just freshly installed MAGIX Music Maker 2013, then you will not see any 
additional synthesizers here at first (other than those that were included). You will 
have to enter the folder first in which Music Maker should look for VST instruments. 
VST plug-ins may be installed in any folder on your hard drive. 

Click "Add" (on the right edge of the Media Pool) and find the VST folder. If you use 
other programs with VST plug-ins or if you have already created a folder for your VST 
plug-ins, you can enter the folder here. You can add another extra folder at any time 
in case you you have installed additional plug-ins in another folder; plug-ins that have 
already been "identified" will always be located regardless of the path set. Pressing 
OK causes Music Maker to scan the folder for usable plug-ins that are available in the 
Media Pool. 
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Vita and Revolta 2 (Premium version only) feature their own icon in the 
Media Pool; all other VST instruments use a standard icon. To use VST 
instruments, drag the VSTi Synth into a free track in the arranger. 

A preset MIDI object will appear in the track and the MIDI Editor will open. 

You can open Vita and Revolta 2 (Premium version only) directly by selecting 
one of their preset sounds in the instrument menu of the track box. At the very 
bottom in the menu, a sub-menu is provided for software instruments that 
lists the other VST instruments. 

 

To use the MIDI objects and the MIDI Editor, please read the chapter MIDI Objects 
(view page 80). 

VST Plug-in Editor 
The VST Plug-in Editor can be opened by right-clicking on the instrument's name in 
the MIDI Editor, via the corresponding plug-in slot in the Mixer, or via the "VST 
Instruments Editor" entry in the instrument list. 

The Instrument Editor has two views, the so-called "GUI" of the plug-in (Graphical 
User Interface) and the parameter view. This is either automatically activated when 
the VST plug-in does not have its own GUI or can be used if the GUI of the plug-in is 
too unclear or takes up too much space on the screen. The parameter view displays 
the eight parameters of the plug-in as sliders. In the File menu you can change 
between these views (plug-in dialog/plug-in parameter). 

Load/save patch/bank: The instrument settings can be saved and loaded in the 
patch formats typical for VST plug-ins (*.fxp) and bank formats (*.fxb). 

Random parameters: This function can be an important source of inspiration. 
However, before using it please save the current preset you've just created as this 
feature does not ask before it is applied. 

Menu program: Here you can select the presets integrated into the plug-in or loaded 
via the File menu. 

MAGIX Vita 
MAGIX Vita Synthesizer specializes on realistic playback of "real" instruments for 
which it uses sampling technology. This means that short samples of real instruments 
in different pitches, playing techniques and volumes are used, combined, and played 
again at the correct pitch. 
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The Vita interface 

 

1. Layer selection/Peak meter: The Vita sounds, also known as layers, can be selected 
here using the arrows. Right-clicking on the display opens the layer menu. 

2. Main parameter: Here the volume, panorama position, pitch characteristics 
("transpose") and the fundamental frequency ("master tune") can be set. 

3. AMP: This is the volume envelope. With this you can control the timing of a 
sound's volume. A(ttack) stands for the volume increase at the start, D(ecay) for the 
length of time the decrease in volume takes on a section set with S(ustain) at the 
maximum volume. R(elease) is the length of time it takes for the sound to fade out. 

 

4. FILTER: Here you can switch on a filter which influences the sound. With FILTER 
TYPE you can select the kind of filter you want to use. Cutoff controls the filter 
frequency and "Resonance" controls the strength of the emphasized filter frequency. 
"Velocity" indicates how much the velocity influences the filter frequency, using 
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"Gain" you can balance the volume. The filter envelope (ADSR slider) influences the 
filter frequency depending on the time. 

5. DELAY: Here you can switch on an echo effect. "Time" controls the delay time and 
"Level" controls the strength of the echo sound. 

6. REVERB: Here you can switch on a reverb effect. "Time" controls the delay time 
and "Level" controls the strength of the echo sound. 

7. TUBE DISTORTION: This is a tube distortion effect like those found in guitar 
amplifiers. This is normally used for electric guitars but you can also get creative and 
use it for other things. "Drive" controls the strength of the distortion. "High-cut" and 
"Low-cut" filter out the high and low frequencies. 

8. VALUE DISPLAY: This always displays the exact values of the parameter that was 
just adjusted. 

9. DYNAMIC RANGE: Usually the relationship between the created volume and the 
MIDI velocity is proportional. You can compensate for the fact that some MIDI 
keyboards need to be pressed forcefully to produce loud sounds (or conversely 
produce loud sounds with a soft touch) using the "MIDI Input Curve". Using 
"Dynamic and "Dynamic curve" you can manipulate the dynamics of a sound, i.e. the 
relationship between the loudest and quietest sounds. 

10. Voices: Here you can control the number of voices played simultaneously. If notes 
are no longer played, as is the case in some fast passages, you can increase the 
number of voices at the expense of performance. 

11. Keyboard: Here you can preview the Vita sounds. This only works during playback 
or recording. 12. lets you hide the keyboard. 

Additional Vita Solo Instruments 
Additional software included in MAGIX Music Maker 2013 such as the Rock Drums 
or String Ensemble are sampler, whose sounds are prerecorded. The advantage to the 
virtual synthesizers such as Robota is that the sounds don't have to be recalculated 
each time, which frees up a lot of computation capacity. They are "simply" called up, 
instead of being created anew. The disadvantage, however, is that the finished sounds 
don't sound as "professional" as those produced with virtual "sound magic".  

The basic controls are identical for all synthesizers.  
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One click on the arrow symbol opens a fold-out menu where you can determine the 
general sound of the instrument. If "ECO" appears in the description, this refers to 
especially performance-improving settings which may not sound so "smooth". In 
addition, you can also save your settings and add them to a favorites list for later use.  

 

You can control the overall loudness of the instrument.  

 

You can turn the instrument keyboard on or off with this controller.  

Because these samplers are enhanced for each instrument by tuned effects, the rest 
of controls function analogously to the already familiar synthesizers such as Vita. If 
you would like to know which result certain effects have, you will find explanations in 
the Essential FX (view page 149), Vintage Effects (view page 156), Reverb (view page 
142) and Distorsion & Filter (view page 145) chapters.  

Additional information is also available in  the Synthesizer plug-ins (view page 124) 
chapter.  

Articulation 
Some Vita Solo Instruments have a special feature: In a bass octave (on the keyboard 
(C0-H0), there are special notes, which let you control the playing style 
(articulation). An alternative sample set is loaded, which lets the bass sound even 
more realistic using various playing styles such as note bending and flageolet. 

Articulation is switched on and continues until normal articulation is switched on 
again through the corresponding note (C0).   



 

130   

www.magix.com 

   

On the keyboard at the bottom of the synthesizer interface are the buttons to switch 
articulation, displayed in different colors. In the MIDI Editor appearing above, you can 
watch a practical application of articulation. The notes on 1:4 and 4:1 will be played 
back with varying articulation. Before the next "right" note, normal articulation will be 
switched on again through C0. 

Automation of Vita and Vita Solo instruments 
In MAGIX Music Maker 2013 it is possible to automate Vita Solo instruments. This 
allows you to change a specific value during playback using an automation curve 
automatically. Below we describe how to work using an automation curve.  

1. Right-click on an effect knob. This opens a context menu where you can select a 
MIDI controller number for the automation using "midi ctrl #". A few standard 
controller settings are preset, e.g. 7 for volume, 10 for panorama, 91 for reverb.  
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2. Open the MIDI Editor (Y key) and switch into the "Velocity/Controller Editor". 

 

3. At the bottom right you can now select the pre-selected controller number in the 
MIDI controller selection field.  

 

4. You can now draw the desired automation curve. 

Additional information can be found in the Controller Editor - Select and edit events 
(view page 90). 

Tip: If you are using an external controller, you can also use it to control and 
automate values. To do so, select "Learn MIDI" in the Vita Solo Instruments context 
menu. Also read the Using external equipment (view page 81) chapter. 
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Audio effects 
MAGIX Music Maker 2013 offers you a multitude of infinitely variable and intuitively 
adjustable audio effects. 

Effects 
The effects in MAGIX Music Maker 2013 allow the sound spectrum of all of the audio 
objects and synthesizers to be thoroughly manipulated. Since most effects operate in 
real time, the effects offer ideal room for experimenting with creative sound design.  

Real-time effects 
Real-time effects are calculated the first time the object is played back. The audio file 
(original material) itself remains unaffected. The effect is recalculated in real time 
each time it is played back. The object always retains its original status when real-
time effects are applied. 

To change a real-time effect, open the effects rack or the effect's settings dialog and 
drag the respective control elements; the changes will be audible immediately. 

The lower edge of an audio object in the arranger lists all currently active object 
effects with abbreviations. 

 

Effect devices controls 
Some effect options open a graphic window, which has the appearance of the studio 
effect device that it simulates (such as the "Echo/reverb" or "Timestretching" effect 
menus).  

These virtual effect devices are controlled either with common sliders, knobs and 
buttons or alternatively with graphic sensor fields. 

 

Sensor fields: Sensor fields can be controlled intuitively with mouse 
movements, with the graphic and the corresponding effect setting 
changing in relation to each other. 

 

 

Power switch: Every effect device in the rack may be switched on or off 
separately. This button allows you to directly compare the neutral, unedited 
sound of the audio object with the effect setting you have chosen. 
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 Reset: Every effect has a reset button that restores the effect device’s initial 
default. In this state, the effect is not calculated into the sound, and the 
effect is not rendered. 

 

Preset selection list: Each effect device has a selection of 
proven presets which can be selected from a drop-down 
menu. 

 

 A/B: The A/B button compares two settings with each other. If you have 
selected a preset for the effect and make manual changes to it later, you can 
compare the original preset sound with the new settings by using the A/B 
button. 

Note: The displayed graphics serve only examples and can differ from device to 
device. 

Non real-time effects 
A few audio effects are not calculated in real time; instead, after the settings dialog is 
closed, copies of the audio material are added for calculating the effect. This way, no 
additional calculations will be required during playback. 

To change these effects, use the undo function. 

The following effects don't work in real time: Freely-drawn filters, gater, reverse, invert 
phase. 

Using audio effects 
Audio effects can be added at different positions in the arrangement, at object level, in 
a complete track, or in the master (i.e. everything you can hear). 

Audio object effects 
Object effects do not affect the entire arranger track, but rather individual objects. The 
advantage to this is that effects which are only required at a specific point in the 
arrangement only use up processing power at that particular point.   

There are several ways to apply audio effects to individual audio objects: 

1. Drag & drop: In the Media Pool setting "templates", the following folders are 
visible "Audio FX", "Vintage FX". These contain presets for the most important 
effects. These presets have a preview function and can be dragged & dropped 
on an audio object in the arranger.  

2. Right clicking on an audio object or via the "Effects -> Audio" menu opens 
individual audio effects via a menu command. 
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3. Double clicking on an audio object opens the audio effects rack (view page 
136). The most important effects are compiled into one dialog and some 
special functions are still available, as is the option of saving all of the effects 
settings. 

Track effects 
Besides the object audio effects, a separate track effects rack with equalizer, 
reverb/echo, compressor as well as the Vintage Effects Suite plug-ins can be used. 

There is also a separate 6-channel parametric equalizer (view page 
139) that may be opened via the small EQ button beside the panorama 
controller. 

The plug-ins are loaded via the plug-in slot. 

 You can open the track audio effects rack with the FX button.  

A bright blue track effects button signifies that effects are active in the track. 

The track effects can also be applied without having to open the mixer. 

 The arranger's trackbox (view page 31) also features the track FX 
menu. In it, you will find presets for track effects (view page 134) 
sorted according to the instrument type. 

Track effects always apply to all audio objects of a track. In comparison to applying an 
effect to each object individually, this saves storage space. The effect itself works the 
same way as object effects.  

Master effects 
Master effects influence the mixed sum of all audio tracks. For this purpose a Master 
Audio Effects Rack and further plug-ins are installed in the Mixer window. Also 
included: the special MAGIX Mastering Suite for perfect sound. 

Effect curves 
Many effects can be adjusted using the effect curves for a more dynamic application 
of the effect. This means that certain effect settings can be changed during playback. 
The effect curves are available as object curves and track curves. Object curves are 
always object-related, i.e. they only apply to one object and are moved or copied 
together with the object. The track curves are saved in the track and affect all of the 
objects the track.  

To learn more about editing effect curves you can refer to the chapter „Effect curves“. 
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Using plug-in effects 

For introductory information about plug-ins, please read the section Synthesizer 
Plug-ins (view page 124) in the "Synthesizers" chapter! 

At different positions in MAGIX Music Maker 2013, you can also utilize effects from 
third-party developers in the VST or DirectX format. Several of the included effects 
(EssentialFX, Vintage FX Suite, Vandal SE) are also applied as plug-ins. 

Track effects 
Track effects can be selected and specified in the Mixer. They refer to all objects in 
the corresponding track. 

Tip: An effect set in the Mixer uses up processing power at every playback position 
in the arrangement. Consider whether or not it would be enough simply to use an 
effect as an object effect. 

 
Two slots for track effects are located in the channel strip of the mixer 
for the corresponding track as well as in the FX tracks (view page 181).  

If you click on the small triangle here, MAGIX Music Maker 2013 compiles a list of 
available effects. Now you can select any effect from the list. 

The list consists of multiple subfolders: Direct X plug-ins, VST plug-ins, and the 
MAGIX plug-ins folder for the included plug-ins Vintage Effects Suite (view page 
156), Essential FX Suite, and Vandal SE.  

Select "No effect" to remove a plug-in from the slot. Left clicking temporarily disables 
the plug-in. Active plug-ins are displayed in light blue. Right clicking on the slot opens 
the settings dialog of the plug-in. 

Object Effects 
The audio effects rack can be opened by double-clicking an audio object. 

  

The module at the very bottom enables two plug-in 
effects to be used. This functions just like the mixer's 
plug-in slots: 

1. Click on the box. 
2. Select the effect you want. 
3. Adjust the effect settings in the dialog. 
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The effect relates to the selected object (in contrast to track effects)and only needs 
computing power when the object is played. 

Master Effects 
In the master channel you can find two slots for selecting a master effect. Often, for 
example, compressors are used in the master so as to give the whole signal a more 
booming and louder sound.Effects selection here is the same as by the track effects: 

1. Click on the box 
2. Wait until the list of available effects is compiled 
3. Select effect and configure 

Object and master effects rack 
The audio effects rack for objects can be opened by double-clicking the audio object. 
The audio effects rack for the individual tracks or for the entire sound ("master 
effect") can be opened using the FX buttons in the mixer window ("M" key). 

In addition to the most important effects like the 10-band equalizer, reverb/delay, 
compressor, time processor (objects only), filter and stereo enhancer (track only), the 
following features are also available: 

Object Volume 

 

Here you can set the master level for the selected object. With some effect 
combinations undesired distortion may appear as many effects increase frequency 
ranges. In this case, you can reduce the master volume. 

 
The faders for each stereo channel are usually moved together. 

If you deactivate the left button, the object can be made into stereo panorama by 
separate volume controlling for left and right. 

Load/Save 
The current settings for each applied effects device in the rack can be saved as an 
effect preset, e.g. so that it can be used for other objects. Only the rack effects that 
were used will be saved and loaded during this process. This means that effects 
presets can also be combined. 

This function is not yet available for the track effects rack. 
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Effects plug-ins 

 

If external plug-ins are installed on your 
computer, then you can activate them via the 
button to the bottom right. These buttons 
also open the effects in the Vintage Effects 
Suite (view page 156). 

For more information about plug-ins, please read the chapter Using VST/DirectX 
effects (view page 135). 

Apply (destructive editing) 
With "Apply" the current setting of an effect or of an entire effect rack can be 
"calculated into" the audio object. 

This has the advantage that no more processing power will be required for the effect. 
The object will be replaced by a new audio file which contains the sound of the object 
with the effect. This will then only be played – processor-heavy "realtime" effect 
calculation is no longer required. 

The disadvantage: Changing the effect settings is not a simple any more. You can 
undo these "destructive" changes straight after using the Undo function in the Edit 
menu (like every editing operation in MAGIX Music Maker 2013). After saving the 
project this is no longer possible. 

In the master effects rack there are no Apply buttons. Instead, the function can be 
found in the Edit menu (Audio Mixdown (view page 214)) 

Play object/Play arrangement 

 

To the bottom right of the Audio FX Rack you will find two 
playback buttons which either play the selected object or the 
entire range. This lets you preview all effect settings in realtime. 

 

Equalizer 

 

The 10-band equalizer subdivides the frequency spectrum into ten areas ('bands') and 
equips them with separate volume controls. This way it is possible to create many 
impressive effects, from a simple boosting of the bass to complete elimination of a 
certain range of frequencies. Note: If low frequencies are boosted too much, the 
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overall sound level is heavily increased which may lead to distortion. In this event, 
adjust the overall volume downward by using the 'master volume' control situated at 
the bottom center of the effect rack. 

Slider control: Each of the ten frequency ranges can be separately boosted or turned 
down with the ten volume controls. 

Link bands: Using this button randomly combines the frequency ranges with each 
other in to avoid artificial-sounding overemphasis of an individual frequency range. 

Touch screen (right EQ section): This is the 'sensor field' of the EQ. Here you can 
draw any type of curve with the mouse. This will be immediately translated into a 
corresponding control setting on the left side of the EQ. 

Compressor 

 

The compressor is an automated dynamic volume control. It limits overall dynamics, 
maintains the volume of loud passages so they stay loud, and increases the volume of 
low passages. A compressor can be put to good use for e. g bass recordings and 
vocals, but also as a master effect in the mixer for subsequent editing of the overall 
sound.  

Processing is carried out using a "look-ahead" method, similar to high-quality studio 
appliances.  There are no peak overmodulations or other artifacts as the algorithm can 
never be 'surprised' by sudden level peaks. 

Ratio: This parameter controls the compression level. 

Threshold: This sets the volume threshold below and above which compression is 
applied. 

Attack: Sets the algorithm's reaction time to increasing sound levels. Short attack 
times can create an undesirable "pumping" sound, as the volume is quickly reduced or 
increased correspondingly. 

Release: Sets the algorithm's reaction time to falling sound levels. 

Gain: The gain controller amplifies the compressed signal. 
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6 Band Equalizer 
The parametric equalizer has six filter bands that you can use to shape the sound of 
the music track. Each band is a filter with a typical "bell shape". Within a certain 
frequency range around an adjustable middle frequency you can increase or reduce 
the signal level gain. The width of this frequency range is called bandwidth. The 
bandwidth is defined by the Q value. The higher the Q value, the narrower and 
steeper the filter curve.  

You can influence the basic sound of the mix by increasing and decreasing the 
broadband so as to give it more "depth" (lower center 200-600 Hz) or more "air" 
(Highs 10Khz). You can also decrease the narrowband width (high Q-value) in the 
frequency response to remove disruptive frequencies. 

 
Sensor field: The sensor field displays the resulting 
frequency response of the equalizer´. The frequency 
is displayed horizontally and the increase or decrease 
of the respective frequency is displayed vertically.  

The blue bullets 1-6  symbolize the six frequency bands. You can move them around 
with the mouse until you find the frequency response you want. 

 

You can control the output level of the equalizer with the Peak Meter . With the 
Master Gain Controller beside it you can offset the level changes resulting from the 
EQ adjustments. 



 

140   

www.magix.com 

You can access additional settings for each frequency band by clicking on the bullets. 

 

You can use the knobs to set the values for each band. There is also a numeric field 
for each parameter where values can be entered. 

Gain: This controller allows you to raise or lower the filter. Setting the controller to 0 
deactivates the filter so it does not use any CPU power. 

Freq: The center frequency of the individual filters can be set between 10 Hz and 24 
kHz with the frequency controller. Freely choosing the frequency enables multiple 
filters to be set to the same frequency in order to have a greater effect. 

Q (Bandwidth): Here you can set the bandwidth of the individual filters to between 10 
Hz and 10 kHz. 

Bands 1 and 6 are special: Their Filter Curves can be edited in three different modes. 
The four editing points in the graphic have different functions in each mode. 

 Peaking: Here the effect curve is brought closer to the working point (which 
represents the peak of the curve) from both sides simultaneously. 

 Shelving (Basic setting): Here the working point displays the beginning of the 
filter curve. From this point on there is a gentle increase or decrease in the 
frequency. 

 High or Low Pass:In Band 1 the working point displays the frequency which is 
filtered out of particularly high or low frequencies.  

 

Enhancer 
The Enhancer enables the justification of the audio material in the stereo panorama to 
be adjusted. If the stereo recordings sound unfocused and undifferentiated, an 
extension of the stereo base-width can often provide better transparency. 
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Use the maximize function to move the echo and improve the stereo picture, for 
example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the complete 
panorama. The reduction of left and right levels is displayed under the control 
buttons. 

Pan-direction: Use this controller to move the sound source from the middle into 
stereo panorama. The signals at the outer edges of the sound picture remain 
unchanged. 

Multiband: This option switches from "Stereo FX" to "Multiband" mode. Stereo 
editing only applies to the middle frequency, the bass and highs remain unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono (extreme 
left), unchanged base width (normal stereo), and maximum base width (wide, 
extreme right). Raising the bandwidth (values over 100) diminishes the mono 
compatibility. This means that recordings edited this way sound hollow when listened 
to in mono. 

Maximize strengthens the spatial component of the recording, which also increases 
the stereo transparency without influencing the mono compatibility. 

Stereo meter (correlation gauge): This provides a graphical display of the phase 
relation of the audio signal. You can use it to review the orientation of the signal in the 
stereo balance and the effect of the stereo enhancer. To maintain mono-compatibility, 
the "cloud" shown should always be higher than it is wide. 

Invert phase 
This function moves the object to the rear loudspeakers of a dolby surround system. 

Quite an impressive effect for the audio tracks of video productions.  
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Reverb 

 

The reverb effect device offers newly developed and very realistic reverb algorithms 
to add more room depth to your recording. 

Reverb is probably the most important but also the most difficult effect to generate. 

Fundamentals 
Our everyday experience shows that not every room matches every instrument. Thus 
we have designed “virtual” rooms. However, it still remains important to find the 
correct parameters. Here are some examples of parameters that are decisive for the 
sound impression in real and virtual rooms: 

• Size of room: The larger a room, the longer the sound travels between walls or 
objects. Our brain “calculates” the size from the time difference. The size 
impression is mainly determined from so-called first reflections and the discreet 
echo. We don’t notice a (diffused) reverb. 

• The reverberation time is mainly influenced by the composition of the walls, 
ceilings and floors. This reverb time is highly frequency-dependent. For instance, 
the highs and mids are dampened more in rooms with curtains, carpets, furniture 
and some corners than in an empty and tiled room. 

• The density of the reflection: The sequence of the first reflection is particularly 
important. A room with many individually recognizable echoes feels alive, 
especially if they are quite far apart. 

• The Diffusion: Simple reverb machines do not take into account that reflections 
become more and more complex as they develop. They blur the first echoes at 
the beginning, which sounds artificial and “two-dimensional” for many signals. 
Our reverb effect works like a real room instead where individual echoes can still 
be heard at the beginning of the reverb but then reflect amongst each other more 
and more until they disappear in the signal sustain as a so-called “diffused hiss”. 

The 24 presets include many rooms that were designed for certain instruments and 
applications and whose internal parameters have been optimized for these 
applications. However, you can influence most of the characteristics of the room 
using the provided sliders. 

In addition to the rooms we have modeled two device types in the reverb effect that 
allow you to create an artificial reverb for a longer time: Plate Reverb and Spring 
Reverb. 
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Plate Reverb: A plate reverb consists of a large metal plate (often 0.5 to 1m2 thick or 
more), that is put into motion by a magnet and coil system (similar to a loudspeaker). 
On the reverb plate so-called “taps” are positioned at different locations. These are 
pick-ups comparable to those on a guitar. Reverb plates have a very dense sound 
(high diffusion); no direct echo can be heard. They are therefore ideal for percussive 
metal. With vocals a plate reverb generates a smooth “wellness effect”. 

Spring Reverb: You probably remember Spring Reverb from guitar and keyboard 
amps, particularly older ones. At the bottom of these amps a unit consisting of two to 
four spirals is mounted on a vibration-free carriage. As with the reverb plate it uses 
systems for transforming the electric signal into a mechanical one. There are different 
designs and sizes of spring reverb; however, they all have the same quite peculiar 
sound: the typical “bloing” sound when the springs are moved, similar to splashing. 
When the reverb dies away the basic pitch of the spring(s) can usually be heard quite 
clearly. Furthermore, the frequency range is considerably limited due to the losses in 
the spirals and in the used pick-up/transmitter. Despite this, the sound is special and 
some of the latest music styles (e.g. dub & reggae) would hardly be possible without 
spring reverb. 

Parameters 
The reverb effect has the following parameters: 

Size: defines the size of the room (or the system for the plate and spring). With some 
low “size” settings you can also reduce the distance between the individual 
reflections. This allows resonance to develop (accentuated frequency ranges), which 
can sound oppressive if the reverb sustain is too long. The proper size for each 
instrument can be gauged by taking into account the interplay between the room and 
the resonance. 

Time: reverberation time. With this controller you can define how far the echo will be 
absorbed, i.e. the time for the reverb to die away. Turning this knob to the left 
minimizes the time. You will then only hear the first reflection. Turning the knob to the 
right minimizes the absorption and thus results in a long sustained reverberation. 

Color: within certain limits you can influence the sound characteristic of the effect. 
The effect of this controller depends on the used preset. In rooms “Color” controls the 
dampening of the highs in the reverb (from dark to bright) as well as pre-filtering of 
the signal. The controllers for plate and spring presets also determine the dampening 
of the basses. 

Mix: this controller sets the mix ratio between the original and the edited signal. For 
rooms you can therefore quite easily move a signal further into the room by increasing 
the effect share. The last four presets are intended for use in an AUX channel of the 
mixer and are set to 100%. 
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Presets 
The presets are primarily sorted by instruments; however, you can (and should) 
choose which preset you want to use for which instrument. The rooms in particular 
have completely different characteristics which are noticeable for some and more 
subtle for others. Generally we recommend reverb with many individually audible 
reflections and slight diffusions for dense arrangements. On the other hand you can 
use Plate Reverb for minimally arranged songs in order to create a dense atmosphere. 

However, you should avoid adding reverb to too many instruments. Sometimes some 
extra mixing is sufficient to move an instrument slightly away from the total sound. It 
is often recommendable to adjust the sustain to the song tempo, i.e. the faster the 
track, the shorter the reverb. Otherwise the sound easily sounds washed-out and 
indifferent. 

Here is a list of the presets and their characteristics: 

Drums and percussion 
Drums: Studio A: small room, high diffusion, e.g. for percussion instruments 
Drums: Studio B: slightly larger & more lively than A, medium diffusion, distinct first 
reflections, signals seem closer than A 
Drums: Medium-sized room: medium-sized room, moderate reverb, medium 
diffusion, relatively few first reflections 
Drums: empty hall: medium-sized empty hall, medium diffusion 
Drums: Snare reverb plate A: plate reverb, high diffusion, relatively bright sound 
character, typical hissing of a reverb plate. 
Drums: Snare reverb plate B: reverb plate, high diffusion, slight dampening of highs & 
basses, sound moves more to mids with time, stereo panorama narrower than for A 

Vocals 
Voice: main hall A: standard hall, e.g. for monitoring/recording, medium-sized room, 
medium diffusion, minimum sustain time 
Voice: main hall B: like A, but as a small hall (longer delay times than A), distinct 
reflection pattern, longer reverb time 
Voice: early reflections: medium-sized room, low reverberation share, very distinct 
early reflection pattern, e.g. for spreading vocals 
Voice: warmer room: small, intimate room, dark character 
Voice: studio reverb plate A: reverb plate with medium diffusion, slight dark 
adjustment, comprehensive sound characteristics 
Voice: studio reverb plate B: Like A, but more diffusion and bright to medium sound 
adjustment, slight vintage character 
Voice: large hall: large hall, medium diffusion, relatively long reverb time 
Voice: cathedral: delayed attack, slight diffusion, complex echo pattern, some hard 
reflections, dark voice adjustment, long reverb sustain 

Guitar 
Guitar: Spring reverb mono A: spring reverb simulation, typical oscillating sound of 
the springs, limited frequency range 
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Guitar: Spring reverb mono B: Like A, slightly broader frequency range, greater 
diffusion 
Guitar: Spring hall stereo A: similar to spring hall mono A, but one 
spring/transmission system per channel (L/R)As a result of the mechanical 
interlinking of the systems, the reverberations meet at the middle of the stereo field 
Guitar: Spring reverb stereo B: Like stereo A, slightly broader frequency range, 
greater diffusion 

Keys (Piano, Synthesizer) 
Keys: Stage reverb: Larger room with stage, high amount of complex first reflections, 
slightly delayed attack, medium reverberation 
Keys: piano reverb: concert hall, long reverberation, medium diffusion, minimum dark 
adjustment 

Aux (to be used as a send effect in a mixer FX track) 
Aux: Room: Standard room for the aux path, mix 100%, medium-sized, medium 
diffusion, some distinct first reflections, low reverberation 
Aux: Hall: Medium-sized hall (100% wet), medium diffusion, short reverberation 
Aux: Reverb plate: Reverb plate (100% wet), high diffusion, light bright adjustment 
Aux: Spring reverb: Reverb spring (100% wet), stereo, high diffusion, slightly medium 
sound characteristics 
Delay (echo) 
The echo effect is defined more closely with ‘delay’ and ‘feedback’ and calculated into 
the original sound by means of ‘mix’. 

Delay: Here the period of time between the individual echo’s can be determined; the 
more you turn the control to the left, the faster the echo’s will follow each other.  

Feedback: Here the number of echo’s can be adjusted. Turned completely to the left, 
there is no echo at all; turned completely to the right there are virtually endless 
repetitions.  

Sound Warper 

 

Distortion 
This is a distorter, which over-modulates the audio object.  

Gain: With these controls you adjust the degree of distortion. ‘Gain’ designates the 
prestage to an amplifier. 
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Cut off: Here you adjust the frequency ranges that are to be distorted.  

Volume: Here you can adjust the volume of the distorter.  The higher you set the 
‘gain’ control, the louder the distortion when compared to the overall volume.  

Filter 
Similar to an equalizer, the filter controls the volume of certain frequency ranges. It is 
however also possible to completely suppress frequencies so that very impressive 
distortions are possible. 

Frequency: Here you set the frequency that is to be filtered. 

Level: Here the filtering intensity is adjusted. 

Resonance: Here you set the range (band width) around the frequency which is to be 
boosted together with the frequency.  

Volume: Here the filter volume can be adjusted separately. 

Gater 

 

This special effect "chops up" a sample into a given number of parts (16-128) Select 
the number of steps, which will then be distributed over the duration of the sample. 
Additionally you can set the volume for each individual step using the fader, so that 
the hard sections can be produced in the same way as soft levels. 

The Gater function can also work as a filter to create interesting sound deformations 
which are particularly good for Techno! This is useful when you want to create a cool 
sample from a sound without its own rhythm. 
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In "Division" you can set more than 16 sections to produce even more variations in the 
 sound. . The fader settings are then repeated which means that step 17 has the same 
value as step 1 etc. 

A real-time monitoring function allows immediate musical control of any fader 
change. 

Principally, there are two operating modes which can be combined with each other: 

Volume or filter progressions 
The objective of this function is to change the volume or the sound character of the 
audio material in 16 or more steps with the aid of the 16 faders. The default setting of 
every fader corresponds with one sixteenth of the audio material – i.e. a sixteenth note 
in a 1 bar loop or an eighth note for a two bar loop, etc. 

This leads to interesting rhythmic results, e.g. by lowering the volume of individual 
faders or through stepped volume increases. Various progressions can also be quickly 
created with the help of the random function. The real-time screening function 
permits constant acoustic control while this is being done! 

Gater progressions make it very simple to create rhythmic sounds from a simple 
strings or synthesizer section or to emphasize or tone down certain beats in a drum 
loop. 

Reordering 
The playback sequence of the 16 steps can be changed with the colored key fields 
located below the faders. This makes it possible to repeat a beat from the first 
sixteenth in the fourth sixteenth. To do this, the number under Fader No. 1 must be 
the figure 1. The fact that item 4 will now play back the material in item 1 is shown in 
color.  

Does this sound complicated? 

If so, simply try the Random function. It instantly pronumerous variations. If you have 
the Real-time screening function running, you can then quickly decide for yourself, 
which groove you like better! 

You can use the Re-order function to derive totally different variations from a drum 
loop quickly and impressively. 

Backwards 
When Backwards is applied the sound file will be played in reverse. This way you can 
create very interesting effects, not to mention the “hidden messages” in many songs... 
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Timestretch/Resample 

 

This effect device changes the object’s speed and/or pitch.  

Pitch: This control changes the pitch independently of the object’s speed (‘pitch-
shifting’). 

Tempo: This control changes the tempo independently of the pitch ("time-
stretching"). The object acts as if it were compressed or stretched on the track. 

Tones/BPM: These fields are used to numerically enter the pitch or speed change. 
Only MAGIX Soundpool files are suitable for numeric entries because they are 
equipped with information regarding pitch and speed. 

Setup: This button opens a setup dialog where you can select various pitchshifting 
and timestretching procedures. 

• Standard: Timestretching and pitchshifting in standard quality. This method is 
suitable for audio material without a pronounced beat. Existing beat markers are 
evaluated to improve audio quality. 

• Smoothed: Timestretching and pitchshifting for audio material without pulsing 
elements. The method is suitable for several voice orchestra instruments, 
surfaces, speech and singing. Beat markers will not be evaluated.  

• Beat marker slicing: Beat-synchronous timestretching and pitchshifting via 
splitting and temporal repositioning. Precisely set beat markers are required at 
the beats or transients. Markers can be generated in real time (automatically) or 
read out from the source file, as long as they are available (patched). In the 
Premium version's included MAGIX Music Editor, a patching tool is provided for 
users to set the markers themselves. 

• Beat marker stretching: Beat-synchronized timestretching and pitchshifting in 
high audio quality. The material is stretched between beat markers positions so 
that the impacts or attacks at the beat markers positions are not impaired by 
stretching. The markers can be generated in real time from the audio material 
(automatically), provided they are present (patched).  

• Beat marker stretching (smoothed): Beat-synchronized timestretching and 
pitchshifting in high audio quality, even with extreme time extension. Beat 
markers are used at the beats or transients. The markers can be generated in real 
time from the audio material (automatically), or read out from the wave file, 
provided they are present (patched). 
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• Universal HQ: Universal method for timestretching and pitchshifting in very high 
audio quality. Suitable for all types of audio material. 

• Monophonic voice: Time-stretching and pitch-shifting for vocal solos, speech or 
solo instruments. 

• Resampling: Pitch shift and tempo cannot be changed individually. This method 
requires comparably little CPU time.  

essential FX 
MAGIX essential FX is a collection of "bread and butter effects" for the most 
important applications. They are embedded as VST plug-ins (MAGIX plug-ins 
directory) and may be used in the object or in the track. For object application, see 
"FX plug-ins (view page 137)" in the "Audio effects" chapter or "Track effects (view 
page 134)" in the "Mixer" chapter. 

These are simple but solid tools with clear feature sets for daily application. They 
include fewer controllers and require less resources. 

MAGIX Plug-Ins 
Console 
Some MAGIX plug-ins show a so-called "Console at the top edge when they are 
opened – a display bar for managing presets with expanded settings options. 

 

A menu containing available presets is located behind the display. To the right is a 
prev/next button, which lets you leaf through presets. 

 Presets can be saved with this button. MAGIX  plug-ins use its own save 
format (*.fxml) 

 
You can return the presets to their initial settings by clicking on the 
"Reset" button. 

 
Bypass switch: Routes the signal directly to the output instead and 
bypasses processing. Internally, processing is continued so that you can 
toggle between processed and unprocessed material anytime. 

 
A/B comparison: Very useful for trying out settings. The controller setting 
"A" memory is normally activated when the interface is opened. 

As this is the initial status, "B" also contains the same settings. If you would like to 
experiment without losing the current setting, press the "B" buttons and try other 
settings. To transfer the values to "A", press the copy button between the two letters. 

 
"?" button: This opens the online help for the plug-in. 
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Parameter Smoothing 
Each plug-in offers soft controlling. Pot settings are softly faded internally from the old 
value to the new one. This is particularly noticeable when playing in "Live" mode. Due 
to performance reasons, switches (e.g. on/off) and some settings of VariVerb Pro 
that change delay times directly or indirectly are excluded from this action. 

Vpot Controls 
Some controllers snap to the middle setting, which may be useful for quickly returning 
to a "neutral" status. It is extremely difficult to adjust the fine settings within close 
proximity of this snap point. You can temporarily deactivate this snap mode by 
holding "Shift" before touching the controller. 

Use the mouse wheel to adjust the controllers. A combination of the mouse wheel 
and "Shift" key reduces the increase/decrease by factor ten. 

Apropos the controller movement, note that all plug-ins follow the host settings 
regarding linear or circular mouse movement.  You can usually choose whether you 
prefer up/down or a circular movement to adjust the value. 

essentialFX presets 
By clicking on the tool symbol in the graphic display, you can open the presets.  

Under "Tweak" you can find specific settings options for each effects device. 

Under "eFX Globals" you can find settings options for graphic level display as well as 
mouse control. 

 

eFX Globals 
These settings are valid for all essentialFX. 

Metering: Here you can set the meter display.  
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• Decay Time controls reaction speed.   
• Peak Hold controls the hold of the highest peak. 
• Brightness controls the display brightness. 

Mouse: Here you can set the display reaction to mouse movements in the essential 
FX graphic display. 

• Linear mode lets the faders move in response to vertical and horizontal mouse 
movements. 

• Circular mode lets the faders be controlled by circular mouse movements. 
• Mode As Host lets the faders move in response to the mouse exactly how mouse 

settings in MAGIX Music Maker 2013  specify it. 
• [Shift] Factor specifies the factor for fine adjustment of individual faders with the 

mouse with simultaneously held Shift key. 

Chorus/Flanger 
This plug-in offers a simple way to make signals sound more interesting, "spacier", 
thicker, etc. by modulating or delaying the pitch - the classical domain of application 
is for guitars, Hammond organs, electric pianos, or synths. 

Chorus and flanger are two closely related effects, which are combined into a single 
plug-in. They normally differentiate in terms of delay time, type of modulation, and 
degree of internal feedback. 
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Chorus flanger parameters 
IN / OUT: Here you can set the input and output level. 

mode: 

- Stereo chorus:  Compared to mono chorus, two copies of the original are created, 
modulated against each other in pitch, and then fed accordingly to the set mix ratio to 
the left and right output channel. 

- Mono Flanger & Stereo Flanger In contrast to the Chorus Effects the lower delay 
periods and a slightly changed modulation are processed. 

- Ensemble: This creates a denser chorus, similar to Boss/Roland CE-1: Instead of two 
voices, six are generated. Two internal sine LFOs for de-tuning, whereby for both 
LFOs the second and third voice phase length by 120°. This results in a denser-
sounding effect that is also less warped. 

• Rate: This specifies the speed of the modulation. Lower rates provide slight 
hovering effects, and high speeds produce a wobbling, typically distorted 
"underwater" sound. 

• Depth: This parameter specifies the depth of the modulation, i. e. the maximum 
deviation of the modulation and the resulting pitch bending. 

• phase: This fader moves the right channel's oscillator phasing relative to the left, 
wave is put back to the right. So that the Tremolo effect drifts apart in the stereo 
field with ever increasing values. At 180° both oscillators work in reverse, 
therefore the stereo effect is at its strongest. 

• Feedback: This parameter defines the portion of the delay that is sent back to the 
input. Feedback causes the effects of modulation to be more drastic and cutting. 
Nullification of the feedback is set at the middle of the fader. Set to the right, the 
feedback is fed to the input equi-phasal; to the left, the feedback occurs. Both 
variants may sound very different depending on the signal, since they prefer 
different frequency ranges for dissonance. 

• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  

• Low Cut: This knob sets the filter frequency of a high-pass filter. Signal 
components below this frequency will be filtered out. 
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Phaser 
The phaser is often mistaken for a flanger due to its typically sharper and cutting 
effect. In any case, the pitch is not modulated. Instead, the modulation process 
burrows multiple notches into the frequency response, somewhat like a comb filter. 
Just like an airplane taking off, the phaser functions with a similar jet effect. It is 
suitable for enduring signals like synth surfaces or for producing sound designs to 
create atmosphere or distortion effects. 

 

Phaser parameters 
IN / OUT: Here you can set the input and output level. 

Mode: The selection includes a number of filter stages. At 4 stages/8 stages, a more 
plastic effect is achieved, and more complex patterns are reached at 16 stages. Please 
note that the more stages are involved, the more computing time will be needed. 

• Rate: Speed of filter modulation. The essential effect is the same for both chorus 
and flanger. 

• Depth:  Similar to chorus/flanger, whereby it's the filter notches that are 
addressed, and not the pitch modulation. 

• phase: This fader moves the right channel's oscillator phasing relative to the left, 
wave is put back to the right. So that the Tremolo effect drifts apart in the stereo 
field with ever increasing values. At 180° both oscillators work in reverse, 
therefore the stereo effect is at its strongest. 

• Feedback: The feedback portion produces a more drastic effect in this case. 
Similarly to the chorus/flanger, co-phasal or opposite-phase feedback is possible.  
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• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  

• Center Freq: Sets the mid-frequencies of the phaser. The filter modulation acts on 
these frequencies. 

 

Stereo Delay 
The stereo delay is a simple too for typical bread and butter delay effects. The stereo 
delay offers the "analog algorithm", which features the sound of echo devices of 
yesteryear. 

 

Stereo delay parameters 
IN / OUT: Here you can set the input and output level. 

Mode: This selects between the essential algorithms. 

Digital: Normal, transparent delay 
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- Analog tape: Analog tape delay simulation. In this mode, a band echo is simulated 
with a typical compression and saturation behavior, including phase shifts with high 
feedback settings. 

Analog BBD: Simulation of a bucket brigade delay (BBD, bucket brigade delay). These 
devices, which originate from the pre-digital era, used analog building blocks for 
storage. The signal was held for a short time in a relatively simple circuit and then 
moved on to the next. This "bucket brigade" principle created a longer signal delay. 
BBDs create different delay times by varying the system beat (clock), meaning  that 
for short delays the beat is faster, and for longer it is slower. 

• Tempo sync: If this button is active, the plug-in is directed at the host/sequencer 
tempo. In this mode, changes are made to the delay period via the L/R delay 
using the musical snap grid (e. g. 1/4 note). 

• Delay L/Delay R: Specify the delay period for the left and right channels here. 
• Damping: This specifies the cut-off frequency at which the highs are dampened 

during the delay. This useful  for making the delays reverberate more naturally or 
for creating special effects (reggae/dub-style effects). 

• Feedback: This parameter regulates the internal amplitude of the delayed signal 
that is fed back to the input. In "Digital" mode, this process is completely 
transparent; in "Analog", on the other hand, higher values, a very loud input 
signal, or the sum of these will make the use of dynamics compression audible. In 
both modes, the nullification of the feedback parameter is in the center of the 
fader. To the right, the plug-in works in "Dual delay" mode (both sides work 
independently), and to the left, "Ping pong" mode will be activated (the delayed 
signal alternates between the left and right sides). 

• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  

• Feedback Low Cut: This control sets the filter frequency of a high-pass filter for 
the "feedback". Signal components below this frequency will be filtered out.  

• Tape / BBD Noise: Here you can control system noise for both analog modes. 
Especially if you work with high feedback rates, noise can create quick or stable 
oscillation, making the effect even more authentic. 

• BBD Stages: Here you can determine the count of  For very long delays, chips 
with many memory cells are used. This explains why bucket brigade echoes with 
long delays sound so muffled and dirty. Please keep in mind that the shorter the 
delay, the faster is the "virtual" system beat. For performance reasons, the system 
beat is limited. The limit is displayed below the delay control (with deactivated 
"tempo sync") as soon as it is reached, e. g. 46 ms (min). 

• BBD Compander: Here you can simulate Compander settings. Due to per-cell 
loss, BBDs have low system dynamics. For this reason, some have an integrated 
compander (compression at the input, counter-expansion at the output). Strong 
compander settings interact noticeably with the input signal, especially with high 
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feedback, because the input effects the expansion ration at the output, even 
when there is no signal at the input. 

• BBD Clock Drift: This parameter can add drift (during audible jitter effects) by 
slightly varying the system beat of BBD cells. It works similarly to an LFO, but is 
randomized. 

 

Vintage Effects Suite 
If you're a guitar, bass or keyboard player, you'll probably recognize the look of our 
new "vintage effects" suite. They are accurate digital models of analog "standard 
effects" used by live musicians. Although we have adopted the appearance of stomp 
boxes and have given these effect a typical analog sound they are ideal for studio use. 

All effects of the Vintage Effects Suite are subject to a soft rule behavior – internally, 
parameters are softly faded from the old to the new value. This is particularly 
noticeable when presets change and is of a particular benefit when playing in live 
mode. 

In the following we will present the effects of this suite and explain how and where to 
use them. 



 

Audio effects 157  

 

Analog Delay 

 

This delay offers creative playing along with common delay effects. "Analog" in this 
case means, for instance, that you can change the delay times while playing without 
the risk of typical, scratching artefacts developing. Instead, the times are softly faded 
out, similar to the old tape echo machines that used the tape speed to change the 
delay and where the system also had a certain sluggishness.  

"analog" in terms of this delay also means that typical tape echo sounds can be 
mimicked, e.g. tape speed fluctuations and reduced highs during playback 
("feedback"). The feedback has a two-band filter that can be used to create dark, high, 
or mid repetitions depending on the settings.  

These properties can be useful, for example to create "wild" dub/reggae-style delays 
that move towards the center of the sound with each repetition and even grind 
slightly. In this case, "analog" means that you cannot digitally overdrive the delay. 
Even in a 'looped' repetition, the signal cannot be distorted indefinitely, but it is 
compressed by an increasingly slight degree and distorted similar to a tape. 

Analog delay parameter 
Analog delay has the following parameters: 

Delay type 
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Delay type (l + r): Left and right delay times can be controlled separately (see below). 
You can choose a note value for the control pots to snap to. Even and syncopated 
note values from 1/2 to 1/32 are available. Note that the delay times are always in 
relation to the project’s current tempo. 

 Link button (lock symbol): Press this button to control the “delay type” pots for 
both channels simultaneously. 

Mix: Adjusts the ration between the original signal and the echo. 

Modulation 

Speed: The tape warble speed. Low values result in very light fluctuations, high values 
result in drastic warbling. 

Depth: The warble intensity. When this control is turned all the way to the left, there 
is no pitch modulation. For a subtle "analog" feel, we recommend a setting between 
the 9 and 11 o’clock position. 

Filter 

"Low" This control progressively reduces the bass frequency as it is turned 
to the right, making the signal sound "thinner". 

"High"  Once turned all the way to the right, the control only attenuates the 
treble very lightly; turned completely to the left, the delay repetitions 
become progressively less treble. 

Feedback 

Width: This controls the stereo width of the delay repetitions. When you turn 
“Width” to the right, an additional effect is produced: the panning of the delays 
increases. This is commonly referred to as a "ping-pong" delay. 

Drive: When this control is turned all the way to the left, the delayed signal is 
repeated only once. Turned all the way to the right, the feedback is seemingly endless 
and the repetitions continue for a long time.  

The actual strength of the effect is dependent on the material, since the feedback loop 
(as explained earlier) is addressed via compression and uses a "tape saturation" 
effect. If you send a "loud" signal to the delay, then the feedback will sound longer 
than at a lower level as compression "brings it up" to a certain level. If you are used to 
"purely digital" delays, then this might take some getting used to, but it will probably 
sound "livelier". 
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Flanger 

 

The "Flange" effect is similar to that of the chorus, but does have a different technical 
and historical background. It came about by chance: Someone (various sources say 
John Lennon) slowed down one of two running interconnected tape machines in a 
studio with his hand. The result: The rather brief delay of the second signal compared 
to the first resulted in cancellations within the frequency spectrum, leading to a so-
called comb filter effect (the sum of both signals creates "peaks" and "lows" in the 
spectrum that look familiar to the teeth of a comb).  

Flanging is basically a chorus effect, but it has a lower delay time (less than 10 ms). 
"Release" or signal doubling is not highlighted here; the result is a much more creative 
frequency response deformation.  

A "complete" flange effect will definitely require feedback: The flange portion is 
returned to the input to increase the effect. People often talk about the "jet effect", 
since it resembles a jet on take-off. 

Flanger parameters 
Speed: Modulation speed. 

Depth: The overall amount of modulation. 

Feedback: The volume of the internal feedback loop. 
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Mode:  

Normal: Flanging. 

Dual: Two parts, panned left and right.  

Quad: Four parts, alternately panned left and right. 

Quad pan: Like “Quad”, but the “Depth” control also sets the intensity of the signal’s 
pan movements between left and right. 

Filter 

 

"Filter" is a "modulation" effect like chorus and flanger. However, it controls the 
frequency response of a modulation source as well as the pitch. There are various 
filter types and modulation sizes available for this.  

Possible areas of application are synthesizer sounds (filter sweeps on pads) or 
creative distortions of drumloops (e.g. for variations, fills, etc). With guitars you can 
create typical 'wah' effects: either by tempo modulation or in a special mode, 
modulation via the envelope curve. The decisive factor is the current signal strength 
above the frequency set for the filter. 
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Filter parameters 
Speed: The modulation speed is set by note values ranging from 1/1 to 1/16 (even or 
dotted). Similar to analog delay, the tempo information is automatically provided by 
the arrangement.  

A peculiarity of the final position of the controller:  
Tempo synchronization stops and modulation is controlled via the signal level. 

Freq: This is the base frequency for modulating the filter, and generally takes place 
above this frequency, i.e. the modulation increases the filter frequency. 

Depth: This control determines the modulation depth, i.e. the amount by which the 
speed control (or envelope mode, as described above) increases the base frequency. 
For extreme effects, turn “Freq” all the way to the left and “Depth” all the way to the 
right. 

Filter modes 

Low-pass A filter with a slope of 24 dB/octave and a small amount of 
resonance. The treble frequencies above the base frequency 
(cut-off frequency) are filtered steeply. This is great for 
filter sweeps on synth pads and drum loops. 

Band-pass Only the frequencies around the base frequency are passed 
through the filter (24 dB slope with resonance). Use this 
mode to create wah-wah effects for guitars. 

Band 
elimination 
(„Notch-Filter") 

Two parallel filters (–36 dB) with linked base frequencies 
create two ‘notches’ in the frequency spectrum. This allows 
you to create interesting sounds (e.g. guitar chords), and it 
sounds similar to a phaser. 

High-pass This mode achieves the opposite effect to the low-pass 
filter. Frequencies below the base frequency are filtered 
steeply. If you ‘thin out’ sections of your track (for example, 
a drum track) with a tempo-based modulation, this can 
sound very effective when contrasted with the full-range 
frequency spectrum (for example, if the filter is turned off 
for the next object). 
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Chorus 

 

The chorus pedal creates characteristic "floating" sounds which one typically 
recognizes from guitar or synth pads. You can add acoustic "depth" to an instrument 
to add more power to the sound or to create the illusion that it exists multiple times.  

The chorus sound is created by using the so-called Doppler effect. You probably have 
noticed this phenomenon daily life: The sound of an approaching ambulance sounds 
higher than when it is moving away. This effect is a result of the speed of the sound 
which first increases and then decreases, thus also changing the sound pitch. If there 
were a second siren at your location, an oscillation would develop between both 
sounds (just like when two instruments are out of tune). 

Chorus also splits the signal in at least two: direct sound and effects part. The double 
effect is created by a short signal delay of the effect.  

This delay is within the range of 10-30 ms (as in this one), this means that it is short 
enough to be perceived as an "echo". The times would also be similarly short if you 
were to double a guitar track for instance. A short delay in the mix already sounds 
"doubled" but is not authentic. This is where the above-mentioned "out-of-tune" 
effect comes in: The pitch of the effect signal is slightly modulated by gently "drifting" 
forward and backward in the delay curve. The result is a floating effect where the 
speed is influenced by drifting 
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Chorus parameters 
You can enter the following parameters to control the floating effect: 

Speed: Modulation speed. Low speeds create an even, continuous development. High 
speeds produce vibrato-like qualities, but can also result in an "underwater" effect. 

Depth: Modulation depth. This determines how strongly the speed affects the pitch 
modulation.  

Mix: This sets the balance between the direct signal and the effects signal.  

Mode: You can choose between four operating modes of the chorus effect:  

“Normal” is a combination of the direct signal and the detuned delay signal.  

“Normal, low-pass” is designed for bass-heavy signals like bass guitar. The bottom 
end of the signal stays clear and well-defined, the effect is only audible for the mid 
and treble frequencies.  

“Dual” makes the source sound more lively than a single "part". The sound is spread 
over the stereo panorama, which makes this mode seem "wider". The character of the 
sound becomes livelier than with a single voice only, and it is also distributed over the 
stereo panorama, making the mode sound "broader". 

“Quad, low-pass” is ideal for creating sounds such as deep synth pads with tight bass 
frequencies. 

Tip: Similar to the stomp boxes our vintage effects are modeled on, there is a 
"footswitch" below the pedal’s logo that can be clicked to turn the effect on or off for 
A/B comparisons. All the effects of the Vintage Effects Suite have been designed 
like this. 
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Distortion 

  

The distortion pedal is a "high gain" distorter for crunch and lead guitar sounds. If you 
like typically "British" amp sounds and want to quickly record a guitar track with little 
effort, this pedal is for you. 

An entire valve pre-amp circuit has been modeled, including the typical EQ curve. The 
amplification is "valve-typical", i.e. it doesn't start quickly but is harmonic and soft. 
Even at full power the pedal still reacts softly to a guitar and its settings (e.g. pick-up 
choice and tone controller). For instance, you can influence the distortion even more 
by using the volume knob on the guitar. 

There are only three parameters on this effect; however, these interact with each 
other and can thus generate quite a variable sound: 

• Low: The "bass" controller. This allows you to set the share of basses, even after 
the distortion. The type of prefiltering is important for guitar amps in particular, 
and is characteristic for the basic sound. You should set the bass controller 
depending on the basic sound of the guitar and the sound you are aiming for 
("powerful" or "cut"). 

• High: Mainly controls the share of highs before and after the distortion. If you are 
not using an external guitar speaker as a monitor, we recommend setting the 
controller to the middle position or even moving it slightly to the right. This way 
the "sharp" highs disappear, which all guitar amps generate without the suitable 
loudspeaker. At the same time the mids stand out more, which gives the sound 
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more "kick". On the other hand you can further emphasize the highs if you want 
the sound to be more neutral.  

• Drive: The level of distortion. This controls the amplification used to operate the 
"virtual valve circuit" (max. 60 dB). As the level increases, the valve goes into 
overdrive and generates typical distortions. For a slightly distorted sound 
("crunch"), it's sufficient to set the controller to 10-11 hours at maximum; the 
modeled circuit also provides the usual "weight" for power rock chords, and 
more. The further you turn this controller to the right, the more the mids of the 
signal move to the fore so that the "high-gain" lead sound is better heard.  

You can also use the distortion effect in combination with the amp simulation! 

BitMachine 

 

Audio material can always be edited into high quality with MAGIX Music Maker 
2013. Nevertheless, there are some situations, for example, a more imperfect lo-fi 
sound would perfectly suit a drum loop or a synthesizer sound. 

Remember, for example, the first hardware samplers from the 80s that usually only 
ran at 8 or 12-bit rates and at low sample rates. With the BitMachine, changing the 
sound with such an "antique" device is no problem. 

You can use the BitMachine to bring back to life the times when minimalist and 
scratchy soundchips in home computers were commonplace. 

The BitMachine opens up a gateway to "acoustic time travel" where you can 
encounter bit and sample rate reduction and downstream filters based on analog 
models.  

Furthermore, the effect has a modulation section with which you can control 
individual parameters using an oscillator (LFO) or the input signal.  

We have designed a range of "typical" presets to demonstrate the time travel abilities 
of the BitMachine. These can be opened at the top right of the interface 

The following section describes the details of BitMachine: 

"Reduction" section 
Bits 
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This dial controls the resolution of the audio material. Turning the dial to the left 
results in 16-bit quantization (CD quality). The further it is turned to the right, the 
lesser the signal dynamic becomes. In extreme cases (1-bit), there are only "on“ or 
"off“ states.  

At the intermediate levels, you’ll notice an increase in the background noise and a 
decrease in the dynamics. For example, 8-bit quantization will exhibit dynamics of 
only 48 dB. Quieter points in the material sound noisy and very quiet points sound 
"capped“. This effect is amplified the more you turn the dial to the left until it starts 
crackling or "groaning". 

Sample rate 

The audio material is "down-calculated" with this dial, i.e. the internal sample rate is 
reduced. A new separation ratio between old and new rates is created. In relation to 
this ratio, a sample from the data stream will be "dropped“ at the various points. 

Note: The two smaller dials from this section are explained under Modulation. 

"Filter" section 
The filter in the BitMachine is a digital model of one of the most well-known filters in 
music electronics, i.e. the "Chamberlin 2-pole" filter used in old Oberheim 
synthesizers. These types of filters sound exceptionally musical. They can also be 
used quite creatively in the BitMachine, but should not be used exclusively to smooth 
out existing artifacts.  

The filter works in the so-called "high-pass" mode, i.e. it lets through deep frequency 
(or medium) material according to setting, and dampens highs and medium areas. 

Freq: 

You can specify the cut-off frequency of the filter using "Freq". Filtering starts above 
this frequency. 

Reso: 

The signal in the area around the cut-off frequency can be strongly elevated to just 
below self-oscillation. Sharp, cutting sounds are possible at this level, and the effect 
becomes even clearer when you vary the cut-off frequency. 

Drive: 

Both of the individual filters of the connections mentioned above have the ability to 
overmodulate themselves internally. With the "Drive“ dial, you can regulate the 
amount of overmodulation. The more you turn this dial up, the more the signal is 
overmodulated. In this case, the parameters of the internal workings of the filter 
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interact with one another. Increasing drive weakens the resonance, but, at the same 
time, the signal gets more volume, more bass and becomes acoustically fuller.  

Note: The two smaller dials from this section are explained under "Modulation". 

"Modulation" section 
You can automate your effects via the settings in the modulation section. 

Here, you’ll find the so-called low frequency oscillator (LFO), which resonates with 
adjustable speed. You can influence the speed and type of resonance. 

To influence the resonance, use the two small dials in both the reduction and filter 
areas. These four dials display modulation targets.  

Example: You’ve left the dial for the sample rate at its default setting. Change the 
small dial beneath from its middle position to either side. The modulation for the dial 
value is added to the sample rate: The LFO now controls these parameters 
proportionately and the sample rate reduction resonates at this modulation. 

You can use this technique on other dials as well. You just have to make sure that the 
main dial isn’t turned up to full, because then the modulation wouldn’t have any 
effect. The modulation is always added to the set value. 

Example: Turn the small dial beneath the "bits" dial fully to the left (Value: -50) and 
the one beside it (beneath "sample rate") to the right (+50). You’ve now assigned a 
modulation to both parameters with the LFO. They are not changed uniformly, but 
rather opposite to one another: A negative setting is nothing more than an inversion 
of the modulation, so you’re effectively turning down the control signal. 

Waveforms of the modulation section 

We’ve already explained this example with the help of sine oscillation. The LFO can 
be in: 

• Sine form 
• Square wave (0 or 1, no intermediate level) 
• Random value (an internal randomizer will be queried at the set speed) 

Oscillator speed 

The LFO speed is specified with the "speed“ dial. If the "sync“ button is active, then 
the LFO adapts to the song speed, and the dial locks musical values into place (e.g. ¼ 
note). Rhythmic paths of the sound distortion are therefore enabled. You can also 
switch off this synchronization and set the speed manually (in Hz).  

Modulation with the "Envelope follower“ 
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In the modulation section you’ll find a fourth button, the audio input signal. If this 
mode is active, then the signal itself can be called upon to extract “modulation 
tension”; a so-called "envelope follower" continuously scans the volume of the input 
signal. 

Note: The BitMachine doesn’t recognize the type of audio signal automatically. For 
this reason, you should set the input sensitivity roughly with the "gain“ dial. To do 
this, use the control LED: With accurate detection of the signal dynamics, assigning 
the four small dials to modulation lows is easier and you can use the full control 
range.  

In envelope mode, the "speed“ dial is used to control the response speed of the 
envelope (the display now switches to milliseconds). Lower times result in a faster 
response, higher times make the envelope rise (and fall) slower. You should 
experiment with the signal according to its complexity. The presets provided can only 
point you in a rough direction. 

Vandal SE 
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Virtual Guitar & Bass Amplification 

VANDAL is a complete simulation suite for guitarists and bassists. The plug-in is 
capable of simulating the entire signal chain, from input to stomp boxes, amplifiers, 
microphone loudspeaker boxes and post-processing studio effects, all in top quality. 

Quick start via preset selection 
Would you like to know about everything that's possible with Vandal SE? Play 
yourself or use some of the presets. These are available via the list in the upper edge 
of the interface.  

A preset includes all settings for the main elements of Vandal SE: Stomps, amp 
settings, cabinet simulation, and studio effects. 

 

Tuner 
The best amp or the best simulation is useless if the guitar is out of tune. VANDAL 
offers its own chromatic tuning device for this. You can use it like any analog device: It 
automatically displays the note that has been struck (in octave) and the display 
visualizes deviations (in cents). 

 

The following describes the major components of VANDAL. The stations are 
described according to their position in the signal chain. 

Input 
The station that you will most likely want to activate first is the input controller. Just 
like with a genuine guitar or bass setup, it's important to ensure the highest possible 
input level, in order to work optimally. This is even more important for distorted 
sounds and natural high-gain playing styles. Use metering  for this, too.  
As required, activate the noise gate and adjust it so that it lightly suppresses the input 
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signal during pauses in playing. VANDAL does not cut the input on classic gates too 
hard, but rather regulates them finely via the signal energy beginning at the highs 
(where noise is most audible). 

 

Stomp boxes 
The real world has produced a series of effect devices popular with guitarists and 
bassists in the "stomp box" format. We've also included a rich palette of these 
devices. Vandal SE includes four "stomp slots" that can be equipped with effects from 
the list. The signal flow within this chain runs from left to right. Since all of the 
controls are self-explanatory, we won't describe them here. 

 

Vandal - Amplifier 
Vandal SE basically offers 2 different amplifiers: Guitar Amp and Bass Amp. The 
amplifier type depends on the selected preset. 

During development, a large selection of famous amplifier brands and models were 
not included. To guarantee that you are nevertheless able to get a number of different 
sound characteristics out of your Vandal SE amp, the amplifiers are set up variably. 
Internally, circuit designs work absolutely the same as the real devices. In several 
ways, however, Vandal SE goes in its own direction in terms of the sound it offers. 

Guitar amp 
The Vandal SE guitar amp offers three different pre-amp modes and two switchable 
end stage models. These basic configurations differ according to the selected preset.  

The guitar amp is set up with three channels. These may be set up with the pre and 
post gain controllers per channel (Clean, Crunch, and Lead) for the desired mix ratio. 
Don't worry about switching things around: The amplifier will remember the gain 
settings when channels are changed. These are the gain presets for the different 
playing styles within a song. 
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Voicing: We have provided Vandal SE pre-amps with something that we call Curve 
EQ. For example, if you take a simple EQ pedal and shape the signal a little before the 
amp, then this may change the sound quite drastically. Curve EQ does something 
similar: It's located (in some cases multiply) at strategically important points between 
individual amplifier stages and filters the signal, before it is distorted by the next 
stage. Move the curve in both directions and navigate through the spectrum using the 
"Freq" controller. This will give the amp a completely different character... 

Equalization: The actual sound control (the "tone stack") functions rather 
conventionally: Vandal SE offers low, mid & high settings. Everything functions like 
the passive sound regulation network in genuine amps, so that the controllers 
influence each other to produce numerous variations. 

Reverb: Surf and twang simply need on-board spring reverb. We relied on well-known 
reverb springs for modeling. Everything sounds natural with complete authenticity. 

Bass amp 

 

After roughly setting the Gain controller, the bass signal will first be treated with the 
Contour circuit. This filtering stage works similarly to the "Loudness" function by 
cutting the (lower) mids and lifting the deep bass and highs. It's sort of like an "instant 
slap". 

Next, the signal passes through the compressor stage (Comp). This is a simple but 
extremely musical, visual design: The bass triggers a light source that is coupled with 
a photo resistor which dampens the signal. This may already be familiar to you from 
the most famous studio compressor for bassists, i.e. Urei LA2A, which functions 
according to the same principle. 

After any possible compression, Drive provides the option to take the bass sound to 
the next level. Saturating the signal takes place depending on the frequency: In spite 
of a possibly high level of distortion, the basses remain relatively clean and contoured. 
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The equalization stage offers 4 frequency ranges, whereby the two mid bands are 
variable. The final master volume controller specifies the volume of the final stage. As 
with the guitar amp, the end tubes are also engaged in this case as much as remains 
sensible. 

Rack effects (FX1/FX2) 
There are effects that don't always work well before the amp, e.g. reverb or delay, 
especially when they are distorted. Normally, these effects are better placed at the 
end of the signal chain. 

For final processing and enriching, we offer two separate studio-quality effects units 
just like real 19" rack devices. 

Many algorithms create a stereo signal. Take care that the sequencer track operates 
the duct in "stereo" mode. 

 

Effects units may be selectively operated one behind the other (serial) or parallel. 
Switching may be changed via the mode switch. 

The following algorithms & effects are available: 

• Mono delay (msec & tempo sync): Possibly a simple delay with free selection of 
delay time or synched to the sequencer tempo with a musical raster. In case of 
high feedback values, a reduction of the damping frequency is required to provide 
naturalness to echoes. 

• Stereo delay (msec & tempo sync): Like mono delay; features two models. 
Repetitions may take place on separate channels (feedback controller to the right: 
dual delay) or in ping-pong mode (controller to the left), whereby the signal 
alternates between the sides.  

• Chorus: Produces a typical "floating/shimmering sound" by modulated detuning 
of a signal to "thicken up" its sound or spread it across the stereo field. Detuning 
is achieved by a short delay, the length of which can be varied by the modulation. 
This produces the so-called "Doppler" effect and broadens the signal. 

• Flanger: Algorithmically similar to chorus, but different in that the delay time is 
significantly lower and delay works with repetitions (feedback). A flanger sounds 
more "cutting" and up-front than a chorus. 

• Phaser: A modulation effect just like chorus & flanger, but in this case no 
detuning takes place. Filter components periodically alter the signal's "phase 
response" (principle of the "phase shifter"). Characteristic notches are produced 
in the frequency spectrum response (comb filter effects). 

• Room reverb/hall reverb: Reverb offers realistic simulation of realistic 
reverberation. Room creates the impression of a small to mid-sized recording 
room, while Hall produces the sound impression of a concert hall. A particular is 
that both effects algorithms provide a modulation parameter, which may remove 
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possible resonance at low dosages and can produce a soft chorus effect at higher 
values. 

• LoFi: This algorithm gives the sound a little bit of "grit", or a certain measure of 
signal destruction depending on its setting. Turn down the internal sample rate as 
much as you like to steal a few bits from the sound's resolution. This is definitely 
unconventional... 

• Vintage compressor: Ideal for thickening up the signal a little. The algorithm 
emulates an older popular circuit design that is similar to studio legends like the 
Urei 1176 or simple compressor pedals. A so-called "FET building block" controls 
the volume via the input level simply, effectively, and quite musically, as well as 
the set compression ratio and the attack and release. 

• 3-band EQ: This sound controller works like a conventional mixer with controller 
for bass, highs, and two controllers for the (variable) mids. This adds the final 
polish to your sound. 
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Video and Bitmap Objects 

Video and bitmap formats 
MAGIX Music Maker 2013 can load and export videos in the following formats: AVI, 
Windows Media (*.wmv, *.asf), MAGIX Video (*.mxv) and Quicktime Movie (*.mov).  

Graphics can be loaded and exported in BMP and JPEG formats. Also RTF text files 
can be loaded and used as subtitles. 

On the content media you will find the included image and video files. You can also 
use your own files or even record your own videos. 

To get the best results with video effects, you should save the video and bitmap files 
used in True Color (24-bit color). 

Video monitor 
The video monitor can be opened by clicking on this button or 
pressing the F3 key. 

 

 

Both video monitors can even be positioned 
freely on the screen and adjusted for size. 
To adjust the size, right-click on the monitor 
screen and select the size you want in the 
context menu or make your own (user-
defined). Please note that larger video 
monitors require more computing power. 

The video monitor's size can be increased to the full size of the screen by double-
clicking on the video monitor or by pressing Alt-Enter. You can end fullscreen by 
pressing Escape (Esc). Apart from the video monitor size, you can also add a large 
time display on the video monitor. Select “display play time” in the context menu and 
the current playback marker position is displayed on the video monitor. Foreground 
color, background color and transparency are selectable 

Audio peakmeter 
The video monitor is transformed into an analyzer which displays the 
sound as a graphic. 

 

Shortcut:   Shift + F4 
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Overview 

 
In the Overview mode, you can view the whole arrangement and you 
are also able to access any object you want in a split second; zoom in 
directly to the video monitor or move around the clip displayed in the 
arranger. 

 

Shortcut:   Shift + F2 

Infobox 

 
The InfoBox mode shows help text in the preview monitor if you hold 
the mouse pointer over a button on the screen. 

Shortcut:   Shift + F1 

Loading and editing videos and bitmaps 
Video and image objects can be loaded and edited just like other objects. In order for 
you not having to decide which file is to be loaded, you can use the preview function 
on the video monitor. Simply click on a video or graphics file in the Media Pool: The 
corresponding video or graphic is displayed or played in the video monitor.  

• Via the context menu (right mouse-click into the list) you can choose between 
different views ("List", "Details", "Large symbols"). In the "Large Symbols" view 
the videos are displayed with a preview frame – very useful to preview the 
available images.  

• If you want to use the video for your arrangement, drag the video or bitmap file 
onto a track in the arranger while holding the mouse key. During playback in the 
arranger, the entire video and image material on all tracks, including all effects, is 
played back in real-time.  

• Video and image objects can be edited in the same manner as other objects: You 
can touch and move them with the mouse, fade them in or out with the handles 
at the top corners, or change their brightness with the middle handle, etc. Please 
also read the chapter "Arranging objects (view page 50)". 

Simplify object presentation 
With the TAB key you can switch between two object presentations. The objects in 
the alternative presentation are not displayed frame by frame in the arranger, but in 
simplified form. This saves working memory and improves overall play performance. 
Scrolling and zooming in the arranger as wee as various object manipulations are far 
quicker in TAB mode. The video display in the video monitor is not influenced by the 
simplified object display. 
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Video scrubbing 
The scrub mouse mode is particularly useful for quickly finding certain positions 
within a video. To do this, activate the scrubb mode in the mouse mode bar and drag 
the mouse pointer over a video object while holding down the mouse key. The video is 
played back according to the speed and position of the mouse, including all effects. 

Extract sound from videos 
Video with sound material appears in the arranger on two tracks as two objects (an 
audio object and a video object). The two objects automatically form a group. 

To edit the video and audio material separately from one another, the objects can be 
separated with the Ungroup (view page 213) function in the "Edit" menu or button in 
the arranger. Now you can replace the audio or the video track, or process each file 
separately. Rejoin/regroup the tracks with the ”Export arrangement” function. 

Video effects 
All video effects work in real time. In principle, almost any combination of effects may 
be assigned to any video or image object: For example, mix mode stanzas with a false 
color effect and a double playback velocity. 

By overlaying of multiple videos or bitmaps, MAGIX Music Maker 2013 proceeds 
from the bottom up. The background video object must be placed in the upper track. 
It will be overlaid by and mixed with objects lying below. 

Example, if you want to put a dancer on a landscape, place the landscape on track 1, 
the dancer on track 2 and activate the Blue Screen effect for the dancer. 

Video effects are stored in the ”Video FX” directory. Open the directory by clicking 
"Templates" in the Media Pool. All video effects have a preview function and can be 
dragged & dropped on a video object into the Arranger. 

Title Editor 
Text objects and title templates 
MAGIX Music Maker 2013 includes a function which simplifies insertion and editing 
of titles. Titles are shown as text in music videos, usually animated, for example to 
display the artist and song names. 

The basis of these titles is the titles templates settings in the "Templates", and these 
may be reached via the "Titles" button. To integrate a title template into your project, 
proceed as follows: 
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• Select a file. As usual, a simple click generates a preview in the video window. 
This way, you can see how certain title settings will look and the effect they will 
have in advance. 

• Once you’ve found the right title for your purposes, drag & drop it onto a track in 
the arranger. It will now be displayed there as a title object. Several title 
templates (e.g. YouTube templates) contain additional image objects, these titles 
require two tracks. 

• The title editor (see above) opens automatically. You can open it again later by 
double clicking (or by right clicking in the context menu below "Title Editor"). 

Video Compression 
Compressed video data is typically saved in AVI files. AVI stands for ‘Audio and 
Video Interleaved’, i.e. mixed picture and sound. Depending on the compression rate, 
high data rates will be required – a good video starts at about 2 MB per second, 
equivalent to compression of about 1:10 as opposed to uncompressed video with 20 
MB per second data flow rate. High quality video systems only work with a 
compression of 3 or 2 – i.e. creating up to 10 MB per second data for video flow. Even 
uncompressed video can be used. MAGIX Music Maker 2013 can also process such 
high-resolution video data completely. Within MAGIX Music Maker 2013, video data 
is processed in uncompressed format – all effects, mixes etc are carried out in the 
highest quality. It is possible that replay of a project with several videos or realtime 
effects may ‘jump’ more than is the case with smaller videos. This does not harm the 
end result though – video export is calculated frame by frame. 

General notes on AVI videos 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! 
Rather, it is a so-called "container", where the conventions for transferring audio and 
video files to the program are only loosely defined. The codec (coder/decoder) 
actually defines what storage format is used. A codec compresses audio/video data 
into its own unique format which can only be read by the codec itself and is decoded 
when the film is played.  

In concrete terms, a computer-generated AVI file can only be loaded by and played 
on a different computer if the same codec is installed on it. 

Many codecs (e.g. Intel Indeo® video) have now become standard components of the 
Windows™ installation. Others like the popular DivX codec are not standard. If you 
are generating an AVI file for future play on another computer using one of these 
codecs, you should first install this codec on the other PC. The best method available 
is to copy the codec installer to your export directory and burn it every time you 
create a video disc (slideshow disc) for play on computers. 
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You may encounter some problems when using older video editing cards with codecs 
which only function with the card’s hardware. Such AVIs can only be used on the 
computer which was used to create them. Try to avoid using this kind of codec. 
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Mixer 

 

MAGIX Music Maker 2013 includes a real-time mixer with a master effects section 
that professionally mixes all the tracks within an arrangement. The Mixer can be 
opened by pressing the "M" key or via the toolbar in the main window (also: "View" 
menu > "Mixer").  

The Mixer displays eight tracks simultaneously by default. With the «/» buttons 
beside the scroll bars at the bottom, the Mixer can be increased or reduced in size. 
You can view further tracks using the scroll bar. 

 The limiter, which prevents overmodulation, can then be 
connected. 

 

Fader 
Every channel has its own volume or brightness fader. As a result, the volume can be 
lowered quickly and accurately, to add more bass or to fade out a video that is just 
playing. This fader also acts on any linked MIDI files.  

 

The stereo position for each track can be defined with the Pan 
controls. 

The "Solo" button switches a track to solo mode, i.e. all other tracks are muted. Mute: 
The mute button mutes the active track. 

Double clicking on each of the controls resets it to the passive basic setting, in which 
no processor output is needed. 
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Control groups 
The volume, panorama, and FX send faders of the various tracks can be compiled into 
control groups. To do this, first click on a fader and then, while holding down "Ctrl", 
click on all other faders that you wish to include in your group. If you select "Shift", all 
faders in between the first one selected and the next one will be grouped. 

Now you can set the volume of multiple tracks together without having to change the 
volume ratios of the tracks. For example, you can set the volume of an individual 
instrument of a drumset (kick, snare, HighHat) in such a way that they can harmonize 
with one another. Now, if you group together the volume faders of the tracks, you can 
set the master volume of the drumset. 

To ungroup a fader from a control group, click the instrument and press "Ctrl" again. 
There may only be one control group active at a time, creating a new group 
automatically deactivates an existing group. 

Track effects 
Besides the object audio effects, a separate track effects rack with equalizer, 
reverb/echo, compressor as well as the Vintage Effects Suite plug-ins can be used. 

There is also a separate 6-channel parametric equalizer (view page 
139) that may be opened via the small EQ button beside the panorama 
controller. 

The plug-ins are loaded via the plug-in slot. 

 You can open the track audio effects rack with the FX button.  

A bright blue track effects button signifies that effects are active in the track. 

The track effects can also be applied without having to open the mixer. 

 The arranger's trackbox (view page 31) also features the track FX 
menu. In it, you will find presets for track effects (view page 134) 
sorted according to the instrument type. 

Track effects always apply to all audio objects of a track. In comparison to applying an 
effect to each object individually, this saves storage space. The effect itself works the 
same way as object effects.  For more information on using and controlling the 
individual effects, please read the chapter Audio effects (view page 132). 
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VST and DirectX audio plugins 
MAGIX Music Maker 2013 supports VST and DirectX audio plug-ins. Most of these 
are effects modules such as reverbs, equalizers and so on, but there are also many 
software synthesizer modules as well as other types of controller modules. Thanks to 
their standardized formats, these plug-ins can also be used in the mixer section of 
MAGIX Music Maker 2013.  

Before DirectX plug-ins can be used, the DirectX system needs to be installed on your 
computer. Manual installation is rarely required as most Windows installations 
include DirectX. If, however, your computer does not have DirectX or just an older 
version, you can use the up-to-date DirectX installer provided on the MAGIX Music 
Maker 2013 installation CD. 

Naturally, the DirectX plug-ins themselves also need to be installed before they can 
be used! Installation procedures may vary from plug-in to plug-in. 

 

Two so-called slots for track effects are located in the channel strip of 
the mixer for the corresponding track as well as in the FX tracks.  

Clicking on the small triangle will let you select an effect from the list. Select "No 
effect" to remove a plugin from the slot. A left-click temporarily disables the plug-in. 
Active plug-ins are displayed in light blue. Right-clicking on the slot opens the settings 
dialog of the plug-in. 

FX tracks 
Two FX send controllers (FX1 and FX2) are located below the plugin slots.  

You can determine the volume at which you want the signal to be routed to the two 
available FX tracks.  

An FX track is a complete, additional mixer track which provides a complete track FX 
rack and two plugin slots for use as a send effect. 

A send effect differs from a normal effect found in the track (Insert) insofar as it can 
edit the signals from multiple tracks or objects simultaneously.  

The FX are usually hidden in the Mixer. They will be displayed as soon as one of the 
FX send controllers is used. 
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In the first FX track the hall function is activated as standard as it is the most 
important application of the send effects. 

The volume controllers serve to regulate the volume of the FX track and corresponds 
to the old AUX return controller. The mute button is used to switch the FX function 
on and off. The solo button enables you to single out FX individual tracks. The peak 
meter of the tracks, which send to the FX track, are displayed in grey. 

Live monitoring 
 Click the speaker button in a mixer channel to activate "low latency" monitoring. 

Instead of the objects, the channel now plays the audio signal arriving at the sound 
card’s input – through all the channel’s effects and without latency! This also applies 
to the AUX and master effects.  

You can now add effects to your vocal or instrumental performance while recording 
them, and you can ‘jam’ along to a complete arrangement in real-time. (Please note 
that this only works during recording and playback, not while the arrangement is 
stopped.) 

This monitoring method requires an ASIO driver to be installed. ASIO drivers are 
usually supplied with professional sound cards. For all cards without a proprietary 
driver, MAGIX has included a MAGIX Low Latency driver. This provides an ASIO 
driver for any sound card (or on-board sound chip) that can use WDM drivers. For 
further information, please refer to the chapter "Menu File – Settings/Information – 
Playback parameters…"  

The MultiMax effect has a high-latency design, which is why it is deactivated during 
live monitoring. 

Master track 
The FX button and the plug-in slots function exactly like in the tracks. The FX button 
will open the Master Audio Effect Rack. The complete mixer settings including the FX 
tracks can be reset with the "FX reset" button.  

Both faders control the total volume. 

Link button: If you deactivate the Link Button, you can control the 
volume of the right and left channels individually. 

Master limiter: Effectively prevents overmodulation. 
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Reprocess arrangement 

Export wizard 
The export wizard can be opened through "File" > "Export" > "Common export 
options". 

This bundles different options for exporting your arrangement in different formats, for 
burning onto CD, or publishing on the Internet with different platforms. 

 

Export as MP3: This selection exports the arrangement in the popular MP3 format for 
use on the Internet or on mobile playback devices (MP3 players, mobile phones, etc.). 
More details about the export dialog are provided in the "Export" (view page 191) 
section of the "File menu" chapter.  
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Burn to CD/DVD: This selection exports the arrangement in the best possible quality 
and opens an additional program for burning an audio CD. The option is also available 
to backup the entire arrangement with all involved files onto CD or DVD. See Burn 
audio CD (view page 189). 

Upload to MAGIX Online Album laden: Uploads the arrangement to MAGIX Online 
Album. This platform enables friends and acquaintances to experience your work. The 
MAGIX Online Album online player may also be embedded into any other websites. 
More information about MAGIX Online Album is available in the"File menu" (view 
page 199) 

Publish on Facebook: You can send the arrangement directly to your Facebook 
profile. It will then appear as a post on your wall.  

Publish on YouTube™: This selection uploads the arrangement as a music video to 
YouTube. To use video in MAGIX Music Maker 2013 read the chapter Video and 
Image Objects (view page 174). More info about YouTube export is available in 
"Export to YouTube" (view page 187) in this chapter. 

Publish on Soundcloud: The arrangement will be uploaded to Soundcloud. Additional 
info about this innovative music environment can be found in the Upload audio to 
Soundcloud (view page 188) chapter. 

Send by email: Converts the arrangement into Windows Media and adds it as an 
attachment to an email. An email program (e. g. Outlook Express) must be installed 
and setup.   

Note: You cannot use this function if you only access your email through a browser.  
However, you could invite others to listen to your uploaded music via email to your 
MAGIX Online Album or Youtube™. To do so, you will have to use the functions of 
the respective website (for MAGIX, this is MAGIX Online Media Manager). 

Export as E-Mail attachment 
The option "Send arrangement as email" in the "File" > "Export" menu creates a file in 
the Windows Media format. Your mail program is activated simultaneously and the 
created file is added as an attachment of an opened message. Thus, any arrangement 
can be compressed without intermediate steps and sent as an email immediately. 

Export as ringtone 
With MAGIX Music Maker 2013 you can produce your own individual ringtone 
melodies. Once completed, export the arrangement using the "Audio as 
Wave/ADPCM"  or "Audio as MP3" option in the File menu under "Export". Exactly 
which format to choose can vary depending on the capabilities of your phone. 
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Take a look at the "File menu"chapter for more information on the audio export dialog 
and the for specific export format settings. 

Some advice on creating ring tones 
Audio material: When designing your ring tone please take into account that the 
loudspeakers of your mobile phone can only poorly reproduce bass tones. High tones 
are also heard more easily in a loud environment. If your ring tone includes MIDI 
Objects, you should activate VST Instruments on the respective tracks in the 
arrangement, so that MIDI information included in your ring tone becomes audible. 

Some manufacturers offer VST effects which simulate the loudspeaker of your mobile 
phone on the PC. 

Length: Typical ring tones have a length of about five to sixty seconds. MAGIX Music 
Maker 2013 lets you create longer ring tones; however, you should note that large ring 
tone files require sufficient memory in your mobile phone. 

File format: First, select a format suitable for your mobile phone from the Export 
dialog. If several formats are possible, please note that the resulting audio quality will 
vary. In general, the quality increases in tandem with the size of the file. If your mobile 
does not support stereo audio playback, you can activate the "mono" export option 
which reduces the required memory space by about half. The size of the file that will 
be generated using your current settings is displayed in the Export dialog. 

Transferring the ringtone to your mobile phone: Depending on the type of mobile 
phone and the items included in delivery there are several possibilities to transfer your 
ringtone from the PC to the phone: 

1. Wireless via infrared (IrDA) or BlueTooth link 
2. Using a data cable and, if applicable, the transfer software supplied by the 

manufacturer 
3. By WAP or MMS  

Transfer with Bluetooth  

Note: The procedure described here refers to Windows XP with Service Pack 2!  
Dialogs may be different depending on the Bluetooth driver and operating system 
version, or their order may vary (e.g. for password allocation) when transferring to 
your mobile phone. However, the process is usually similar if other drivers are used. 
Read more on this in the help files or the corresponding chapters of your operating 
system's manual and Bluetooth adapter. 

• Should you own a Bluetooth device, you can export the movie straight to your 
device. For this to happen, your device and your PC must both have Bluetooth 
interfaces. If you system has a Bluetooth device, you can activate the Transfer via 
Bluetooth option  
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• After converting the movie into the desired format, the Bluetooth file transfer 
assistant opens. 

• The first time you try to transfer files to your device via Bluetooth, you have to 
specify your device as the receiver in the dialog by clicking on the Browse... 
button and selecting your device. The name of your device in the Bluetooth 
network is specified in the Bluetooth settings of the device. Check your device 
manual for this. Select your device and confirm your choice by pressing "OK". 

• Now enter a password of your choice, which you will later have to confirm on 
your device and click on the "Continue" button in the assistant. Since connections 
between multiple Bluetooth devices can be set up simultaneously in a room, the 
password serves to identify certain connections as well as to safeguard your data. 

The order can also be the other way around depending on the Bluetooth device 
driver, and the device will then request a password which must be confirmed on 
your computer. It's important that you use the same password in each case. 

• You may be asked once again to enter the file name and path of the movie. In this 
case we recommend, when exporting the file, using a folder that you will be able 
to find again quickly (for example, "...My Files/My Videos"). 

• Click on "Browse...".Now, in the assistant, click on the "Continue" button. In the 
assistant, click on the "Continue" button. 

• Next, you may have to activate the reception of files on the device and re-enter 
the password. Afterwards, the transfer of the videos will begin automatically. 

• Once the transfer has been completed successfully, "1 new message" will display 
on your device. Read more on how to save and play videos in the corresponding 
device manual. 

Note: We only recommend activating data reception via Bluetooth on your device 
once this function is actually required, for example, for transferring files. Once you 
have completed the uploading process you should deactivate Bluetooth again, as 
permanently activated Bluetooth reception can constitute a security risk! 

Transfer with Infrared 
For devices with infrared interfaces, the transmission of movies works similarly to 
using the Bluetooth transfer method. To do this, your PC and your device have to have 
infrared interfaces. Many notebooks are already fitted with such IrDA interfaces. 

• Before starting the export, an infrared connection must already be established 
between the computer and the device. Activate the infrared interface on your 
device and establish the connection to your computer. You can check if a 
connection has been established via a corresponding symbol in the task bar. 
More information on this can be found in the Windows help under the keyword 
"Wireless connection". 
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Note: Some devices deactivate the infrared interface when no data is exchanged 
after a certain amount of time. In this case, you can search for the exported movie in 
the Media Pool again, reactivate the infrared interface of your device, open the 
context menu of the file, and then send the video to your device again by clicking 
"Transfer". 

• Open the "Export" dialog via the export button, and under "Play after export", 
select the option "Export with infrared". Confirm with "OK". A window will now 
be displayed which informs you of the current status of the transmission. 

• Once the transfer has been completed successfully, "1 new message" will display 
on your device. Read more on how to save and play videos in the corresponding 
device manual. 

Community upload 
The menu entries featured under "File" > "Export" >"Community upload" or via the 
Export assistant allow you to upload the finished song to different web communities. 

Export to Facebook 
You can export your arrangement from MAGIX Music Maker 2013 directly to 
Facebook. 

The command opens a dialog where the arrangement name (displayed according to 
the settings in MAGIX Music Maker 2013), a description and search words (tags) can 
be entered. After confirming this data with "OK", the arrangement will be exported 
and uploaded to Facebook. For connecting and transmitting the video file, you must 
login with your Facebook username and password.  If you aren't registered on 
Facebook, first open your browser and create a Facebook account. 

After a successful upload, your browser will open to show you your video's info page 
so you can check the entered data once again. If everything is as you want it, you can 
leave the page and the new video will now appear in the list of your own videos.  

Export to YouTube 
You can upload your arrangement to YouTube® directly from within MAGIX Music 
Maker 2013. 

You can find this function in the menu "File -> Export -> Youtube". 

The command opens a dialog where you can set the name of the arrangement for 
YouTube (default is the same as in MAGIX Music Maker 2013), description, 
keywords (so-called "tags"), and the category for the video. After submitting this data 
by pressing "OK", the arrangement is exported and uploaded to YouTube®. This is 
why you have to enter your YouTube® account access data (username, etc.) to 
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connect to YouTube®. If you don't have an account open your browser and go to 
YouTube® to sign up for an account first. 

If uploading was successful, your browser will open the info page for the video you 
just uploaded to YouTube® to double check your description and tags. If everything 
looks correct, just leave this page and the new video is already listed under your 
videos. YouTube® takes some time to process the video for online presentation, but 
after this period you and every web user around the world will be able to watch it. 

Title templates for YouTube 
If your arrangement does not contain a proper video, then you can still upload it to 
YouTube® with an attractive still image.  

In the Media Pool, under the setting "Templates" you will find the subfolder 
"YouTube" under the "Title". This contains spezial title templates for use with 
YouTube videos. These templates feature neutral designs or match the style of the 
Soundpool (hip hop, rock etc.), and contain standard text for artists, title, album, and 
comments. These titles also appear throughout the entire length of the arrangement. 

 

Upload song to Soundcloud 
Soundcloud is a community that is especially designed for musicians. The free version 
provides 120 minutes of storage space for your songs. Every song may be embedded 
as a player widget into external websites; the widget even allows comments along the 
timeline of the song and an optional download of the original song. 

If you have an Internet connection, then you will see the Soundcloud player here 

For more information about the possibilities provided by the Soundcloud community 
and the different premium accounts see www.soundcloud.com 
http://www.soundcloud.com. 

http://www.soundcloud.com/�
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Additional editing 
You can send your arrangement directly into other MAGIX programs for further 
editing. In the "Mixdown" menu you can find the applications available in Music 
Maker.  

MAGIX Music Maker 2013 Premium lets you use your arrangement  

• as background music in slideshows and videos 
• to be added to an existing music collection, for example in MAGIX MP3 deluxe 17 
• to be edited with an external editor such as MAGIX Audio Cleaning Lab 17 deluxe 

Note: to use this function, the corresponding MAGIX program must be installed. If 
this is not the case, not all options may be available. You can find out which 
programs are necessary for each option in the Edit Manu (view page 225) chapter. 

Burn audio CD 
To burn an Audio CD, export your arrangement as a wave file: Click on "File" and 
select the "Export arrangement" option > "Audio as Wave/ADPCM". The WAV file 
created can be burned as an Audio CD with any burn program.  

In the Premium version, the burner program <goyaburn> as well as the <Music 
Editor> are at your disposal. You can load your arrangement into the MAGIX Music 
Editor with the help of the option from the menu command: "File" > "Export 
arrangement" > Burn arrangement on audio CD-R(W), and burn an audio CD using 
this CD mastering tool. Or you can open <goyaburn>, for example, with the help of 
the context menu in the Media Pool. An MP3 data CD can also be created with 
<goyaburn>.  
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File Menu 

New arrangement 
A new MAGIX Music Maker 2013  arrangement is created with this menu item, with 
16 tracks. More tracks can be added via the menu “Edit”.  

Shortcut:  Ctrl + N 

Load arrangement 
A previously saved MAGIX Music Maker 2013 arrangement is loaded with this menu 
item. Please note that the object files for the arrangement must also be available! 
MAGIX Music Maker 2013 will look for the sounds and videos that were used first in 
the path where they were located when the arrangement was saved. If they are not 
found there, then the MAGIX Music Maker 2013  Arrangement will look for the 
objects in the same directory as the arrangement itself.  

Shortcut:  Ctrl + O 

Save arrangement 
The current arrangement is saved under the existing name. If no name has been 
selected, then a File requester opens, where the path and name can be defined. 

Shortcut:  Ctrl + S 

Save arrangement as... 
A dialog opens where the path and name of the arrangement can be specified. 

Shortcut:   Ctrl+Shift+S 

Import 
Import audio CD tracks 
You can simply import one or more CD tracks like a regular file from the Media Pool 
via drag & drop. If this convenient method fails for some reason, then this menu 
command may be accessed via the CD manager to insert tracks from audio CDs 
directly into the arrangement. More on this can be found in the section "Importing 
Audio CDs (view page 61)" in the "Audio objects" chapter. 

Shortcut:  C 
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Audio recording 
See Audio recording (view page 58). 

Shortcut:  R 

Export 
Common export options 
You will find a quick selection of the most common export options here. 

Please read more on this in the section Export wizard (view page 183). 

Keyboard shortcut:  X 

Burn audio to CD-R(W) 
With this option the arrangement will be exported as a WAV file and loaded into an 
additional program called MAGIX Music Editor.  From there it can be burned straight 
to disc. 

Shortcut:  Shift + C 

Audio export dialog 

 

File 

In File you can enter the file name for you exported file. 
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 Use the folder symbol to select the folder into which you want to export it. The 
dialog will remember the export path for future exports. 

 Use the "home" symbol to restore the original preset (More information can 
be found in the section "Folders" on page 209) path. 

With "Overwrite file automatically" you can perform multiple exports from the same 
file.  

Options 

Only export the area between the start and end markers: Set the option if you wish 
to export only one of the clippings from the arrangement. 

Bit rate: The "Bit rate" selection specifies the level of compression: The higher the bit 
rate, the higher the quality of the exported audio file. On the other hand, the bit rate 
determines the final file size: The smaller the bit rate, the smaller the files. 

Mono/Stereo/5.1 Surround: Most mobile devices have only one loudspeaker. To save 
on memory, you can export in mono as well. In 5.1 Surround Mode (see Mixer in 
Surround Mode) you can also export in MP3surround. 

Advanced: Here you can open the advanced settings dialog for the corresponding 
audio format (see below). 

Normalize: This function should always be activated. It guarantees that the music is 
not too loud/overmodulated or too quiet.   

Transfer format: 

Here you can state whether you want to send he exported arrangement to mobile 
devices via Bluetooth, infrared or email. Read more in the Reprocess arrangement  
(view page 183)chapter. 

Audio as WAV/ADPCM 
The audio material is exported as a standard wave file. This is the conventional format 
for further use on Windows PCs. These files are not compressed and retain their full 
sound quality. 

Compression (IMA ADPCM): This option compresses the WAV file in to the 
ADPCM format. This format is needed for playing WAV files on mobile phones. A lot 
of mobile phones also need a lowered sample rate. (usually 16000 Hz). 

Note: You can also export single tracks. TO do so, simply "mute" those tracks that 
you don't want. Then, only the active tracks will be exported with this function.  

Shortcut:   Shift + W 
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Audio as MP3 
MAGIX Music Maker 2013 supplies an optional MP3 encoder for especially fast, top-
quality conversions into the popular MP3 audio format. 

Hint: The MP3 encoder cannot be used as a codec for audio tracks from AVI audio 
files.  

Transfer format: 

Here you can specify how you wish to send the audio file to the mobile device. Read 
more on this under Transferring files (view page 184). 

Options 

In the "Options" section you can set the format and the compression of the audio file. 

Bit rate: The "Bit rate" selection specifies the level of compression: The higher the bit 
rate, the higher the quality of the exported audio file. On the other hand, the bit rate 
determines the final file size: The smaller the bit rate, the smaller the files. 

Mono/Stereo/5.1 Surround: Most mobile devices have only one loudspeaker. To save 
memory, you can also export in mono. In 5.1 Surround mode (see Mixer in Surround 
mode) you can also export in MP3 Surround. 

Note: Before you can use the MP3 encoder for MP3 Surround, you will have to 
activate it first. Activation is fee-based! For more information, read the Activate 
additional functions chapter. 

Normalize: This function should always be activated. It guarantees that the music is 
not too loud/overmodulated or too quiet. 

Shortcut:   Shift + M 

Audio as Ogg Vorbis 
"OGG Vorbis" is a license-free open source audio codec with very good sound 
characteristics for comparably small files – similar to the MP3 file format. 

In the settings under "Advanced" you can still choose from three various encoder 
modes and bit rate. Set quality. Constant bit rate enables streaming and maximum 
compatibility; with variable bit rate a better audio quality with the same size files can 
be achieved.  

Shortcut:  Shift + O 
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Audio as Windows Media 
Exports the arrangement in Windows Media Audio format. Please read more on the 
advanced settings in the Windows Media Video Export (view page 197) section. 

Shortcut:   Shift + E 

Audio as AIFF 
The audio material is exported as an AIFF file. This is the most commonly used audio 
format for Apple™ computers. 

Shortcut:  Shift + I 

Audio as FLAC 
FLAC is the abbreviation for "Free Lossless Audio Codec". This is a freely savable 
format that can be used to compress your audio data to 50% of their original size. 
Unlike lossy compression methods like MP3 or OGG, the full sound quality is kept 
intact with FLAC. 

Shortcut:  Shift + F 

Audio tracks as single waves 
Opens the WAV export dialog with activated "Export single tracks" option. Clicking 
on OK saves each track as a separate wave file in the export folder. 

Shortcut: Shift + U 
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Video export dialog 

 

You can export your arranagement into various video formats. The options on offer 
can vary according to the selected format.  

Presets: Under "Presets", you'll find the typical settings for the selected format for the 
most important applications.  

You can save your personal settings by pressing the "Save" button and 
remove them by pressing the "Delete" button. 

Export settings: You can set up the general export parameters like resolution, page 
proportions and frame rate in the dialogs. Select the most-used values from the list 
field, to set your own values click on the "..." button. The "Advanced" button opens 
the specific settings dialog for selected video format (see below).  

In File you can enter the file name for you exported file. 

 Use the folder symbol to select the folder into which you want to export it. The 
dialog will remember the export path for future exports. 

 Use the "home" symbol to restore the original preset (More information can 
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be found in the section "Folders" on page 209) path. 

With "Overwrite file automatically" you can perform multiple exports from the same 
file.  

Options 

Shut down PC automatically after successful export: Use this option to have the 
computer switch off automatically after lengthy export processes. 

Only export the area between the start and end markers: Set the option if you wish 
to export only one of the clippings from the arrangement. 

Play after export: Here you can state whether you want to send he exported 
arrangement to mobile devices via Bluetooth, infrared or email. Read more in the 
Reprocess arrangement  (view page 183)chapter. 

Video as AVI 
When exporting to AVI video you can set and configure the size and frame rate of the 
AVI video and the compression codec for audio (audio compression) and video 
(Codec). Please also observe the general information on AVI video formats (view 
page 177, view page 196) in the PDF manual. 

Shortcut:   Shift + A 

General info on AVI videos 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! It's 
rather a so-called container where very general conventions can be specified like 
audio and video data and sent to a program. The exact memory format of the files is 
specified via the codec (coder/decoder). A codec compresses audio/video files into 
its own private format with which only the codec can work and decodes the files on 
playback again. 

This means that an AVI file created on your computer can only be loaded/played on 
computer B if this computer has the same codec installed. 

Many codecs (for example, Intel Indeo video) have now become standard 
components of the Windows installation, others, such as the popular DivX codec are 
not. If you create an AVI file with such a codec and you wish to use it other 
computers, install the corresponding codec on them as well. 

On older video editing cards certain codecs that function only with the hardware of 
the corresponding cards can be problematic. This type of AVI can only be used on the 
computer on which they were created. Avoid using this type of codec when possible. 

Video as MAGIX video 
Exports the project in MAGIX video format. 
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This format is used for video recording by MAGIX Music Maker 2013 video software 
and is optimized for digitally editing high quality video material. 

Shortcut:   Shift + X 

Video as Quicktime Movie 
Exports the movie in Quicktime Movie format. This format enables streaming 
playback of audio or video files via the Internet. 

Like with Real Media Export, you can make corresponding settings for video size, 
frame rate and codecs for Quicktime export. However, the export dialog doesn't offer 
the option of saving comments for the video.  

Tip: For Quicktime files (*.mov), the Quicktime library must be installed. 

Shortcut:   Shift +Q 

Video as Windows Media 
Exports the arrangement in Windows Media format. This is a universal audio/video 
format from Microsoft. The setting options in the "Advanced"dialog are 
correspondingly complex. 

Manual configuration 
Audio/Video codec: Various codecs are available, corresponding to the various 
Windows Media versions (7, 8 or 9). Should compatibility problems arise on 
playback, try an older codec with a lower version number. 

Bitrate mode: Constant and variable bitrates are possible; most devices and 
streaming applications demand constant bitrate. For VBR two pass modes the movie 
is compressed in two passes in order to optimally use the bandwidth for highly-
compressed movies for the Internet. 

Bitrate/quality/audio format: The bitrate determines display and audio quality. The 
higher this is, the better your videos will look and the larger the files and the required 
encoding time will be. For variable bit rates, the bit rate is adapted dynamically to the 
requirements of the corresponding picture or sound material. Either the quality value 
can be set between 1-100 or, for two-pass encoding, an average or maximum bit rate. 
For audio, the bit rate is set additionally by the audio format. 

Import from system profile (export type): For the most used methods (other than 
playback on mobile devices,for which you should use the supplied presets), like 
Internet streaming, etc., Microsoft provides diverse system profiles to choose from. If 
you have the Windows Media Encoder 9 installed, which is available from Microsoft 
as a free download, you can edit the profiles or create your own. These can be loaded 
by pressing the "Import from profile file" button. 
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Go to Clip info to insert title, author name, copyright details, and a description.  

Shortcut:   Shift + V 

Single picture as BMP 
Exports the picture located at the current start marker and displayed in the video 
monitor as a bitmap (.BMP) file. 

Shortcut:   Shift + B 

Picture as JPG 
Exports the image located at the current start marker and displayed on the video 
monitor as a jpeg file. 

Shortcut:  Shift + J 

Sending your arrangement as an email. 
This option creates a compressed file in Windows Media format. Your mail program 
is activated simultaneously and the created file of an opened message is added as an 
attachment. This lets you compress and send your arrangement immediately without 
having to go through any intermediate steps. 

Backup 
Load backup arrangement 
Using this command you can load a backup arrangement. Backup arrangements are 
created automatically by MAGIX Music Maker 2013 and can be used when, for 
instance, a program crashes in order to recover the last status of files. This type of 
automatic backup gets the file extension MM_ (underscore). This command is also 
useful if you unintentionally saved your change and wish to return to the previous 
version. 

Save arrangement and used media 
With this menu point, you can put a complete MAGIX Music Maker 2013 
arrangement, including all used multimedia files into one folder. This is especially 
useful when you wish to reuse or archive such an arrangement later on or when the 
files can be found on multiple CDs so that on loading you continually have to change 
CDs. Furthermore, the effect files used are saved in one folder with the other files. 

A dialog opens where you can specify the path and name of the arrangement. 

Shortcut:   Ctrl + Alt + S 
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Save arrangement and used media (audio as OGG Vorbis) 
You can create a backup copy as an OGG file, whereby all audio files used will be 
compressed into OGG format. This way you can compactly archive your song or put it 
on the web as a remix kit. 

Shortcut:  Ctrl + Shift + C 

Burn arrangement and used media onto CD/DVD-R(W) 
Use this option to burn the arrangement as well as all the relevant files to CD or DVD. 

Even larger arrangements can be burned straight to disc. The arrangement, if 
necessary, will then be split up and burned automatically to multiple discs. A restore 
program which is burned to the first disc of such a backup, guarantees easy re-
recording of the backup. 

Shortcut:   Ctrl + B 

Burn manually selected files to CD/DVD-R (W) 
Opens MAGIX Speed burnR to burn videos or other files onto CD/DVD. File selection 
is done via drag & drop from MAGIX Speed burnR's Explorer. 

Keyboard shortcut:  Ctrl + B 

Internet 
MAGIX Online Album 
In the MAGIX Online Album, you can post your favorite photos online and then send 
the link to your friends. All photos are immediately available from anywhere in the 
world on a professionally-designed photo website, in well-organized photo galleries, 
as full-screen slideshows, or in the form of a personal photo e-card.   

• Personalized photo website in many designs.   
• Unique Internet address (URL). 
• Upload your pictures directly from a camera phone, send the link, and share the 

picture with other camera phone users. 
• Full-screen online slideshows with fade effects and music. 
• Send custom designed e-cards with your own photos. 
• Share your photos with friends, including Internet management and password 

access to private albums. 

Your photos online 

MAGIX Online Album is available in three versions, of which the smallest (the FREE 
album with 500MB webspace for your photos) is entirely free.   
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The larger versions (CLASSIC or PREMIUM) are available for a monthly charge, but 
also come with many handy features, such as a faster website, 2,000 MB or 5,000 
MB storage space, more website designs or access by mobile phone/PDA. 

More information about prices and included services is available at www.magix-
photos.com. 

Just three easy steps: Within minutes your first pictures will appear on the Internet: 

1. Select photos 

Choose your favorite photos directly from the program and optimize them in just a 
few clicks. Put completed photo albums together and integrate music of your choice. 

Do it all offline on your PC - saves you money! Then select "Services" from the 
program's menu bar "MAGIX Online Print Service -> Send selected".   

2. Upload photos 

In order to upload photos to your MAGIX Online Album simply log in using your 
email address. Naturally, access is protected via your personal password. 

If you still don't have access, click on Register now! to activate your own album in 
just a few minutes. Then off you go! 

3. Done! Your own personal photo website is finished 

and your best photo memories are on the net. As a photo gallery or fully automatic 
slideshow (fullscreen).   

Now, invite all your friends with just one click or show your photos on the road using 
your WAP-compatible camera phone. 

Using your MAGIX Online Media Manager, you can quickly manage your photo 
website, upload photos and music, create new albums, add designs and text, and 
much more. All online without even having to download any extra software! 
Worldwide, easy, and quick in just a few clicks. At http://www.magix-photos.com 

The following options are also available: 

Send e-cards and photo emails 

Send your photos as unique e-cards with great designs, or as a photo email to your 
friends and acquaintances. 
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Order photo prints and gifts 

Order paper prints or great photo gifts from your MAGIX Online Album and have 
them delivered directly to your home, or pick them up from a photo lab in your area. 
Delivery time is usually just 2 - 3 days. 

Download media 
This command loads files from MAGIX Online Album to your PC.  

Open my online album... 
This command opens your own MAGIX Online website. You must login and enter the 
page's Internet address (URL) to continue.  

MAGIX Website Maker 
Not only is Internet surfing easy! Thanks to MAGIX Website Maker creating websites 
also becomes child's play! 

This service offers: 

• Your desired domain (www.desiredname.com) and a subdomain  (http://your-
name.magix.net/website). 

• 250 MB memory space with 5 email accounts, 1 GB each. 
• Website Maker with website templates, intros. Also animations, text effects, 

form and design objects, picture and graphic templates, and buttons. And 
everything without any ad banners! 

• Photo (*.jpeg), video (*.wmv) & music (*.mp3) options. 
• Additional software: MAGIX web mail for managing your email inbox.  

MAGIX Website Maker offers 3 months of free, non-binding service. This way, you 
have enough time to find out everything about MAGIX Website Maker and all 
existing possibilities for editing and managing your homepage. 

MAGIX Website Maker offers everything for the perfect Flash website: 

• Design templates: Numerous high-quality website templates in the latest 
professional Flash® design with pre-finished, customizable subpages, start pages, 
profile pages, photo pages, video pages, and much more.  

• Text & text effects: Freely positionable text fields with fantastic fonts and 
animated text effects can be added and individually formatted with ease.  
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• Multimedia content: Select your favorite photos, spectacular slideshows, videos 
and an online video player with your own background music, or integrate it all as 
an online music player with playlists. 

• Decorative elements: Attractive design objects, plenty of vector shapes, 
background images, buttons, and much more offer more possibilities for 
designing unique websites than ever. 

• Animation objects: Large selection of dynamic, impressive animation objects for 
breathtaking, moving websites. 

• Links: Easily add links to your own or external websites.  
• Top extras: Enhance your website with a visitor counter, guest book, contact 

form, and many other useful extras. 
Export function: Conveniently add individual components of your website (e.g. 
video player, slideshow, online music player) or even the entire website to 
external sites as an embedded website. 

Proceed as follows: 

After registering your desired domain, you can start creating your website right away. 

1. First, select a design for your website in MAGIX Website Maker 
2. If you would like to place an intro (start animation) at the start of your domain, 

select your intro as a next step. 
3. Now you can replace the mock text with your own text as you see fit. All free-

standing elements on all webpages can also be moved as you please. To do so, 
click to select the element and move it using your mouse. 

4. Once everything is just how you want it, you can put your page online, so that 
your domain can be accessed.  

Catooh – the Online Content Library 
Catooh provides you with high-quality photos, videos, and music for every theme, 
expanded by intelligent iContent with professional Soundpools, DVD menu 
templates, and brilliant MAGIX ShowMaker styles to help you make your photo, 
video, and music projects reality. All of this is available directly from your MAGIX 
software. 

Just choose "Share" from the menu "Catooh" to set up an Internet connection. 

Browse through the thematically sorted categories or view the results directly by 
entering a keyword. After downloading, you can drag the objects from the Media Pool 
directly into your arrangement. 

Tip: Read the introduction online http://rdir.magix.net/?page=JRF6LASAR2Z3! 

Find media and download in the arrangement... 
Opens Catooh and loads your files directly into the arrangement. 

http://rdir.magix.net/?page=JRF6LASAR2Z3�
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Shortcut:  O 

Import media backup 
iContent (for example, 3D transitions) which you buy and download from Catooh is 
stored directly in your central My files\MAGIX Downloads\Backup directory. If you 
have downloaded these files from other MAGIX programs, then you can use the 
command "Import media backup" to make them accessible for use in MAGIX Music 
Maker 2013. 

Manage login details 
These are options for managing user names (email addresses) and the associated 
passwords so that you are able to access your Online Services without having to enter 
the details each time. 

This information applies to all of my Online Services: If this option is activated, then 
the account details you have entered will be applied to all Online Services. Deactivate 
this option if you have different details for individual services, then choose the 
corresponding service via "Select service and enter the associated login details.  

Find out more about MAGIX Online World 
Opens an Internet browser at the MAGIX Online World website. 

Settings 
Arrangement settings 
In this dialog, the general properties of the arrangement can be set. Statistical 
information about the arrangement is also displayed. 

Shortcut:  E 

General 
Name: Here you can enter the name of the current arrangement. 

General arrangement settings 
Path: This is where you determine the folder on your hard drive in which your 
arrangement is saved. 
Save automatically: Saves the arrangement automatically according to the settings 
used for automatic backups in the program settings. 
Use settings as presets for new projects: The settings entered in this dialog are 
applied to all new projects. 
Number of tracks: Here you can set the number of tracks you want to use.  
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Audio sample rate: The sample rate determines the pitch and the speed at which 
audio objects are played back. The sample rate you can use depends on your sound 
card (some sound cards even permit changing the sample rate during playback). The 
sample rate you can use depends on your sound card (some sound cards even permit 
changing the sample rate during playback). If you halve the sample rate, wave audio 
objects are played one octave lower.  
Time signature: Several types of bars are available to choose from, for example ¾ 
beat. With various grid settings you can also set additional time signatures. For 
example, with a set 3/4 beat and a 1/8 note grid a 6/8 beat would be the result. 
Video resolution: Here you can specify the presets for the video resolution used and 
the video format.  

Synchronization 
Options for Synchronization and ReWire support. 

Information 
Name/Path: See above 
Created on: Displays the time the arrangement was created.   
Last changes: Displays the time when last saved. 
Number of used objects: Displays the number of all objects in the arrangement. 
Used files: Here the names and paths to all multimedia files used in the arrangement 
are shown. 

Audio recording 
See Audio recording (view page 58). 

Keyboard shortcut:  Shift + R 

Program settings 
Here you can set MAGIX Music Maker 2013 according to your needs and wishes. 

Shortcut:  P 

General options 
Autoscroll: If autoscroll is activated, the screen view automatically shifts when the 
playback marker reaches the right edge of the screen, which is particularly useful for 
longer arrangements. Scrolling requires constant recalculation of the screen view, 
which may lead to interrupted playback if the amount of system RAM is too low. If 
this happens, simply deactivate the autoscroll feature. 

Simplified Object Display: This option determines whether the objects are displayed 
with one or two waveforms. When it is activated, the waveforms are displayed in 
stereo, i.e. with a right and left channel. 

Shift: Ctrl + Alt + Z 
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Automatic saving of backup arrangements: Here you can the time intervals at which 
automatic backup arrangements will be saved. 

Soundpool 

Hide unavailable loops: All Soundpools are saved into a database automatically. The 
Media Pool lists all loops saved in the database, i.e. also those which originate from 
external media (Soundpool discs) that may not be in the drive at the moment. These 
results can be hidden, but this slows down the search results in the Media Pool. 

Hide instruments which are left empty in the style selection: Instrument groups for 
which there are no loops present in a certain style are completely hidden in the Media 
Pool (instead of being grayed out). 

Clean up Soundpool: Every detected Soundpool (on CD/DVD or on the hard drive) is 
added to the database and displayed there, even if the corresponding medium is 
currently not in the drive or if the Soundpool has been deleted or moved. This option 
helps to remove these entries in the database. 

Reset Soundpool: Deletes the Soundpool database. You have the option of 
maintaining the included and installed factory-provided Soundpool in the database. 

Hide advanced tooltips: The additional information for the detected loops in the 
Media Pool will be hidden. 

Instruction dialogs: In its newly installed state, MAGIX Music Maker 2013 displays a 
number of security queries at various parts of the program. Every one of them can be 
switched off by clicking the small box at the bottom that says "Don't show this 
message again". To display these warning messages, select the "Reactivate dialogs" 
option.  

Program interface 

Darken screen when dialogs are opened: Darkening signals modal dialogs which 
need to be closed before the rest of the program can be operated. This can be 
deactivated if it disturbs you. 

Hide news: This option deactivates the MAGIX News Center in the main interface of 
MAGIX Music Maker 2013.  

Import 
Preview samples (Wav, OGG): Preview Wave files while playing the arrangement: 
Here you can switch off the preview when a playback is running (Smart preview). 

Adapt waves automatically to the BPM: When loading to the arrangement or 
previewing, MAGIX Music Maker 2013 tries to adapt the samples to the speed of the 
arrangement. This always works properly with newer MAGIX soundpool samples as 
the tempo information is saved in the wave file. It usually works with all other loops as 
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well, provided the loops are clean, that is, they are cut to entire bar lengths (see the 
Arranger chapter).  

With "For patched samples only", automatic timestretching can be deactivated for all 
other samples. With "Apply to longer samples as well", longer samples will also be 
adapted if they contain tempo and bar information provided by the Remix Agent. 

Remix Agent for the tempo and beat recognition of longer samples (>15 s): Here you 
can deactivate the automatic opening of the Remix Agent for longer samples (for 
example, CD tracks or MP3s). 

Automatically adjust waves to pitch: A wave's pitch can be adjusted automatically 
using pitchshifting. For this to work however, the used samples (much like the 
samples on the MAGIX soundpool CDs) must have the corresponding key and pitch 
information. The pitch of the arrangement will then correspond to the pitch 
information of the first sample in the arrangement. 

Use destructive adjustment for shorter samples: Usually, loaded samples are adapted 
to the arrangement in realtime with timestretching. For computers with lower 
processing power, this method can be deactivated – the timestretching effect will 
then be calculated into a new file which is copied to the hard disk. 

Import CD tracks analog instead of digitally: If this option is activated, you can record 
audio CDs via the record button in the transport control. Read more on this in the 
"Recording audio CDs" section in the "Audio objects" chapter. (view page 65) 

Automatically open MIDI editor during import of MIDI files: The MIDI Editor will 
automatically open after the loading of MIDI files, allowing you to make changes to 
channel and instrument assignment and other settings. 

Start file preview in Media Pool for...: Here you can deselect automatic file preview 
start for Media Pool files and certain file types. 

Import formats: You can deselect file formats that you never use, and these will no 
longer be imported. Please keep in mind that for some file types (AVI, WMA) several 
import modules exist, and MAGIX Music Maker 2013 uses the fastest one in each 
case. If you experience problems during the import of certain files, you can 
experiment with deactivation of certain import modules, forcing the program to use 
the slower, but more compatible import module. 

Audio 
Output device: This option determines which sound card and which output plays 
back the wave audio objects and the drivers that should be used. 

Advanced: Use these buttons to access the playback options window which provides 
information on the current sound card. ASIO provides the settings dialog for the ASIO 
driver, e.g. the MAGIX Low Latency ASIO driver. 
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Wave/Direct Sound/ASIO/WASAPI: Specifies which of the conventional Windows 
wave drivers should be used for the sound card, i.e. the DirectSound system or ASIO. 
Starting with Windows Vista, the WASAPI driver model is also an option. 

Windows wave drivers have the advantage of being relatively stable against strained 
peaks caused by large buffers. If playback becomes jerky as a result of processor-
heavy effects like time-stretching, switching to wave drivers may solve the problem. 
Otherwise the system may react more slowly with wave drivers because of the large 
buffers, that is, all changes are heard with a delay. 

16/24-bit wave/driver communication: If your sound card is able to play 24-bit 
audio, your arrangement will be played at this higher resolution (internal 32-bit float 
calculation). This is applicable only to wave drivers. 

When using live monitoring and when playing and recording VST instruments in real 
time, i.e. with as low a reaction time (latency) as possible, it's recommended that you 
use ASIO drivers. If your sound cards do not have ASIO drivers, you can use the 
MAGIX Low Latency driver. 

If you select ASIO as the driver model, you can set the output in the upper list field 
(for cards with multiple outputs) and the ASIO driver in the lower list field. Advanced 
opens the settings dialog of the ASIO driver. Please refer to the sound card manual for 
more information.  

WASAPI is a new Windows (native) driver model for low latency and can be used as 
an alternative to ASIO drivers. WASAPI is recommended for Windows Vista or later 
Windows versions when the sound card does not have its own ASIO driver and the 
MAGIX Low Latency driver isn't compatible.   

Audio buffer:Here you can specify the buffer size that should be used for playback of 
the entire arrangement or for previewing audio files in the Media Pool. 

As a rule of thumb: If response and loading times are too slow, reduce the buffer size; 
otherwise increase the buffer size if the audio playback is choppy or if real-time effect 
computation errors occur.  

As error-free playback is usually more important than fast reaction times, the buffer 
size should be raised to 16384 or 32768 if dropouts occur. 

MIDI 
Output device: MAGIX Music Maker 2013 uses an external MIDI device when no 
software instruments are applied and to preview MIDI files in the Media Pool. Here 
the "Microsoft GS Wavetable SW synth", a standard software synthesizer included in 
Windows® as an OS component, should be set as default. If sound cards with their 
own synthesizer are used or in case MIDI hardware synthesizers are connected, the 
MIDI driver of the sound card or a MIDI interface should be set!  
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FX: If MIDI playback is too fast or lagging behind, you can enter a speed correction 
factor here. 

Input device: Lets you select the MIDI driver for your MIDI recording, i.e. the driver 
for the MIDI device that is connected to your MIDI keyboard or the driver for your 
USB keyboard. 

Use MIDI target channel: The MIDI system offers 16 different channels to control 16 
different sounds. Normally, MAGIX Music Maker 2013 receives MIDI notes on all 
channels simultaneously. With this option, you can select a specific channel. Next you 
have to set the desired sound together with the MIDI channel on the device and 
select the MIDI recording options on this channel. 

Synthesizer latency: Some synthesizers, especially software synthesizers like VST 
instruments, create delay during playing, i.e. playback of the sound is delayed when 
the key is pressed. This value lets you even this out, causing all notes to be moved 
over by a certain temporal value. 

Integrate MIDI keyboard with Live Performer: The MIDI keyboard can be used to 
remotely control the Live Performer (only in Premium version); see Live Performer 
MIDI assignment. 

Options 
Create "Undo" before destructive editing of audio data: To undo destructive effects, 
the original files must be saved to the hard disk.  If you use this type of effect quite 
often, you can switch off the undo function and save on time used to create an undo 
file as well as save space in memory. 

Write real-time audio to wave file: If this option is activated, the entire arrangement 
can be mixed live and recorded simultaneously. During playback you can, for example, 
control mixer fades and effects or, with the help of keyboard shortcuts, you can play 
the beats in the arrangement  –  all activities will be recorded and written to a 
separate wave file.  Every time playback stops you will be asked if the portion you just 
played should be saved as a wave file, loaded into the arrangement, or deleted. 

Video 
Video standard: PAL is used in Europe, the US and Japan use NTSC. This setting 
should not be changed. 

Video display: The resolutions that can be set here concern only the picture display of 
DV videos in the Arranger. If playback becomes jerky, we recommend entering a 
lower value. The quality of exported videos is not influenced by this. 

Extract sound from videos during import: If a video contains audio data as well, you 
can use this function to extract the audio track from the video. It will be loaded 
directly underneath the video track and grouped together with it. If you ungroup them 
(in Edit menu), you can edit the sound as an independent object. 
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Automatically adjust videos to BPM during import: With the available BPM 
information you can automatically create a video in which the rhythm and order of 
pictures are synchronized. This does not play all frames of a video, but some are 
excluded according to the BPM setting on frame playback. The video appears faster at 
a higher BPM setting; it "dances" to the rhythm. The tempo can be set before every 
new arrangement in the transport control. Otherwise, the arrangement applies the 
BPM tempo of the first sample that is loaded. 

Adjust minor deviations from 04:03 aspect ratio during export: This option 
automatically customizes photos that have an approximate 04:03 aspect ratio to 
04:03 TV screen format. The pictures are therefore easily stretched or compressed. 
This inevitably brings about distortions in the picture. If this option is deactivated, 
black bars appear along the sides. 

Automatically preview exported clips: This option starts the clip immediately after 
exporting for verification. 

Automatically copy exported material to clipboard: This option is particularly useful 
when used with other programs, such as Microsoft PowerPoint. If switched on, the 
created multimedia file will be available straight after being inserted. 

Video priority: Usually, audio objects have priority over playback. Here, an overloading 
of the computer as a result of too many effects can bring about jerky video playback 
while the audio continues to play without any problems. 

To change this, you can give the video playback precedence over the audio. Video 
playback is then renewed after every audio buffer, which may lead to interruptions in 
the sound. 

Folders 
Here you can set the path where 

• arrangements will be saved (Arrangements) 
• files are exported (Export) or imported (Import), and recordings (Recordings) are 

saved, 
• files from the Soundpool are loacted (Soundpool) 
• your MP3 collection is available (My MP3s) 

Keyboard shortcuts 
Opens the dialog for editing shortcuts used in MAGIX Music Maker 2013. 

Shortcut:  U 

Language 
Here you can change the language used in MAGIX Music Maker 2013. Normally the 
language that is used for installation is set as the program language. 
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Reset Program Settings to Default... 
Use this function to reset all program settings (view page 204, view page 203) you 
made in MAGIX Music Maker 2013 to their original settings. 

Exit 
Exits MAGIX Music Maker 2013. 

Keyboard shortcut: Alt + F4 
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Edit Menu 

Undo 

 
10 commands can be undone, including object and cursor manipulations. If 
you don’t like the result of a change in your arrangement, the Undo function 
will take you back to the previous arrangement. 

Shortcut:  Ctrl + Z 

Redo 

 
Redo lets you reverse the last Undo command. 

Shortcut:  Ctrl + Y 

Object 
Create a new object 
Record a new object 
A new audio object is recorded; see Audio recording. 

Keyboard shortcut:  R 

Create a new MIDI object 
This function creates a new MIDI object in the current track. After invoking the 
function, a pop-up menu opens in which you can choose between an empty MIDI 
object or several standard templates. 

Shortcut:   Ctrl + Alt + N 

Text to speech 
Please refer to the Audio objects (view page 78) chapter. 

Shortcut:  Ctrl + Shift + T 

Create a new title object 
Creates a new title object and opens the title editor (view page 176). 

Shortcut:   Alt + Shift+ T 
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Cut 
The marked objects are cut out of the current arrangement and placed onto the 
clipboard. They can then be inserted at different positions. 

Shortcut:  Ctrl + X 

Copy objects 
Objects selected from the current arrangement will be cut out and saved to the 
clipboard. They can then be pasted to a different location. 

Keyboard shortcut:  Ctrl + C 

Duplicate objects 
This menu option lets you copy all selected objects. The copy appears next to the 
original and can be moved easily by holding the left mouse button (drag & drop). 

Shortcut:  Ctrl + D 

Inserting objects 
The contents of the clipboard are added  into the current arrangement at the position 
of the start marker. 

The playback marker is positioned at the end of the most recently inserted object so 
that the quick and easy multiple use of the command is also possible. Existing objects 
now become overwritten. 

Keyboard shortcut:  Ctrl + V 

Inserting multiple objects 
This function is similar to "Insert", but you can choose how often the content of the 
clipboard is to be inserted. 

Shortcut:  Ctrl + Numeric pad '+' 

Deleting objects 
Objects selected from the current arrangement will be deleted. 

Shortcut:  Del 

Split objects 
You can cut up a selected object at the S marker position. If you have not selected an 
object, all objects will be cut into pieces at the S marker position. 

Later on, if you want to re-join the pieces of an object, select “Build group” to join all 
selected objects to a group. 

Shortcut:  T 
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Save objects as takes 
The selected objects are saved in the takes directory. For more about using takes, 
please refer to the section „Takes“ (view page 54) in the chapter "Arranging Objects". 

Keyboard shortcut:  Alt + Shift + S 

Grouping 
Group objects 
Orders all selected objects into groups. As soon as an object is selected in the group, 
all objects in the group become highlighted so that you can work on them collectively. 

Shortcut:   Ctrl + G 

Ungroup objects 
Any selected objects that are part of an object group will become independent objects 
again in this case. 

Shortcut:   Ctrl + U 

Loop range 
Set user-defined loop 
Normally an object is always looped over the full length of the underlying data 
material (audio or video file). To set a clip from a file as a loop, shorten the object at 
the front and the back with the handles and choose the menu option "Edit  > Object > 
Loop range > Insert user-defined loop". This function is very useful for setting your 
own recording as a loop, as the silence at the beginning of a recording can be cut 
away. 

Remove user-defined loop 
The user-defined loop length is reset. 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc.  More information is available under 
Object properties. 

Shortcut:  Ctrl + P 

Track 
Add track 
A new empty track will be added to the arranger. In the "File > Arrangement 
properties" the count of tracks can be set in large increments. 

Shortcut:   Ctrl + I 
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Mixdown audio... 
This function can combine the arrangement or segments of the arrangement into a 
single audio/video object. Please refer to the "Track mixdown" (view page 55) section 
in the "Arrange objects" chapter. 

Tip: To create the finished end version of the song or video, it is recommended you 
select the "Export arrangement" function in the "File" menu instead of the 
"Mixdown" function. 

Shortcut:   Ctrl+Shift+G 

Range  
MAGIX Music Maker 2013 provides object-based functions as well as "band-
oriented" editing functions. These always refer to the whole arrangement from the 
first to the last track as well as to the area between the start and end marker. 

Cut range 
The section between the in and out points is cut from the current arrangement and 
placed on the clipboard. This section can be reinserted elsewhere. 

Shortcut:  Ctrl + Alt + X 

Copy range 
The section between the in and out points is copied from the current arrangement to 
the clipboard. This section can be reinserted elsewhere.  

Shortcut:   Ctrl + Alt + X 

Insert range 
The contents of the clipboard are inserted at the current arrangement's position of the 
in point.  

Shortcut:  Ctrl + Alt + V 

Insert segment multiple times 
Similar in function to "Insert", but you can stipulate how often the content of the 
clipboard is to be inserted. 

Shortcut:   Ctrl + Alt + Number key 

Delete range 
The section between the in and out points is deleted from the current arrangement 
and not copied to the clipboard. 
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Shortcut:  Ctrl + Del 

Extract range 
The section between the in and out points is preserved, and all of the material in front 
and behind it are deleted. Use this option to isolate a specific part of an arrangement 
for further individual editing. 

Shortcut:   Ctrl + Alt + E 

Navigation 
Move screen view 
Using these commands, a viewable portion together with the start marker will be 
moved in the timeline. You can quickly skip between different jump markers and 
object edges. 

Shortcuts:  See keyboard shortcut overview in the Arranger View (view 
page 236) section. 

Move playback position 
This sets the playback marker to the position of a jump marker. This function can best 
be used via the keyboard. 

When stopped, you can immediately move the playback markers to the position of 
the saved jump markers. During playback, the playback marker along with the 
playback range will be moved. Here, the old range is always played until the end so 
that you can remix your arrangement live once the jump markers have been placed 
where you want them without losing the beat. 

Shortcuts:  1..0 

Set jump marker 
This sets a jump marker at the position of the current playback marker. Here you can 
note specific parts of the arrangement. With the "Move playback position" function 
you can quickly jump to these positions. 

Shortcut:  Shift + 1...0 

Create jump marker sequence 
This option duplicates the currently selected playback area between the start and end 
markers by setting start markers equidistant to one another in the bar ruler. Now you 
can jump to every jump marker using keyboard shortcuts. 

Shortcut:  Ctrl + Alt + M 
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Delete all jump markers 
Deletes all jump markers 

Shortcut:  Alt+Shift+M 

Select all objects 
All objects in the arrangement will be selected. 

Shortcut:  Ctrl + A 
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Menu effects 

Song Maker 
This command opens the Song Maker (view page 67) to make arrangements semi-
automatically.  

Keyboard shortcut:  W 

Audio 

Please read the chapter "Audio effects (view page 132)" for more details on audio 
effects. 

Master audio effect rack 
Opens or closes the master effects rack; you can also use the "Master FX" button in 
the mixer window for this. 

Shortcut:  B 

Text to speech 
Please refer to the Audio objects (view page 78) chapter. 

Shortcut:  Ctrl + Shift + T 

Object effect rack 
See Object and master effects rack (view page 136). 

Shortcut:  E 

Audio effects 
This submenu includes all audio object effects plus the vintage effects and the effects 
from the MAGIX Mastering Suite (Premium version only); the latter can be used 
individually. 

Individual effects can be found in the chapter "Audio effects (view page 132)". 

Volume 
An assortment of different menu commands which influence the volume of your 
audio objects. 
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Mute/Unmute 
Use this command you can mute one or more selected objects. Selecting this 
command again makes it audible once again. 

Shortcut: Ctrl + M 

Set volume 
This function, located in both the effects menu and the context menu, controls the 
sound volume for individual objects, just like the object handles in the arranger. 

Automatic volume damping 
This command automatically dampens the volume of other audio objects. This can be 
used to insert voiceovers into your arrangement or add commentary to a film (with 
the original sound). You can also specify whether you want to dampen the original 
sound of existing videos or all soundtracks equally. 

In the dialog you can activate and deactivate the value of the dampening. 

You can use this command while recording audio (view page 60) (Audio recording, 
advanced options). 

Shortcut:   Ctrl+Shift+D 

Normalize 
The function "Normalize" raises the level of an audio object to the maximum possible 
level without clipping the material. This searches for the largest signal peak in the 
audio material and raises the level of the object so that this position matches exactly 
0 dB (maximum overdrive). 

Shortcut:  Alt + N 

Tempo and pitch 
An assortment of different menu commands which influence the pitch and tempo of 
your audio objects. 

MIDI transposition 
This command is only available for MIDI objects. It increases/decreases the pitch of a 
MIDI object's notes by a specific value (in semitones). Use this function, for example, 
to adjust the sound of imported MIDI files to other audio objects. This is more 
effective than repositioning audio objects (pitchshifting), since this can diminish the 
sound; transposition does not diminish the quality of MIDI objects because they are 
produced by the synthesizer. 

Shortcut:   Ctrl + T 
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Timestretch and pitchshift 
See Timestretch/pitchshift. 

Shortcut:   Shift + P 

Harmony Agent 
The Harmony Agent is designed to analyze harmonies.  

Read more on this in the corresponding section of the "Audio Objects (view page 
77)" chapter. 

Shortcut:   H 

One pitch higher/lower 
You can quickly alter the octave of an included sample without having to access the 
corresponding Soundpool folder in the Media Pool. 

The "*" and "÷" keys on the numeric keypad (right on the keyboard) place the sample 
one level higher or lower. 

The "+" and "-" keys on the numeric keypad change the pitch via pitchshifting; the 
respective effect in the audio effects rack is utilized for this. 

Set pitch 
Use this command (only in the Soundpool sample's context menu) to quickly change 
the pitch of the selected object (if present). This also functions when working with 
multiple selection. Simply select all the objects which are under one another and 
select a new pitch to create variations in the arrangement. 

Remix 
These are the commands for MAGIX Music Maker 2013's remix functions. 

Create Remix objects 
If, while running the Remix Agent, the tempo and beat information were saved to the 
audio file, this command can be used to create remix objects. If the Remix Agent has 
not yet been implemented, this command starts it and opens the presets dialog for 
creating remix objects. 

Shortcut:   Ctrl + J 

Remix Maker 
With the Remix Maker, automatic remixes can be created from Remix Agent loop 
objects. 
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Please refer to the Audio objects (view page 75) chapter. 

Shortcut:  Shift + K 

Tempo & beat recognition 
MAGIX Music Maker 2013 provides a Remix Agent for the automatic determination 
of the speed in BPM (beats per minute) and for the creation of loop objects. 

Please refer to the "<Remix Agent>"chapter. 

Shortcut:  J 

Loop finder 
The Loop Finder was developed for the purpose of finding BPMs in short rhythmic 
passages and placing BPMs into the arrangement. The Loop Finder can also help to fit 
short loops into an existing arrangement or extract short rhythmic passages from 
drum loops. 

Note: For longer passages (e. g. complete CD tracks), you can use the <Remix 
Agent> (view page 69, view page 220).  

The waveform of the audio material is displayed in the upper part of the dialog, preset 
at a zoom level of about 10 seconds. 

The principle involves moving the green start marker to the start of the beat and the 
red end marker to the start of the next beat. The BPM display to the left then shows 
the tempo of the loop in beats per minute (BPM). Here we presume that there are 
exactly the same amount of beats in the selected passage as is displayed in the 
"Beats" input field – 4 is the default. If there are two full bars between the start and 
end markers, the number of beats has to be increased to eight, otherwise the Loop 
Finder will only correlate half the speed. 

The precise marking of the beat length is required for exactly defining the loop length. 
This is also possible manually by moving the start and end markers, and can be 
similarly precise when using the zoom functions. But it's easier to do so using the 
following: 

Tap tempo: activates the automatic step-sequence to determine the tempo. First, 
audio playback begins at the start marker position. Then you will be requested to tap 
in the beat with "Tap" or by pressing the "T" key, that is, the "T" key should be pressed 
in time with the music. Playback stops after the number of beats set above is reached. 
The start marker is now positioned at the start of the tap process and at the end 
marker at the end. And that's it! The beat has now been set and the tempo can be 
read. Program automation makes sure that the start and end positions are placed 
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exactly at the next beat. Even if the tap process didn't work out exactly, automation 
nearly always finds the right beat meant when tapping. 

Snap marker: You can use the red and green arrow buttons at the top beside the 
wave display for moving the start and end marker one beat forward or one beat back. 
This makes it very easy to select "round loops", i.e. whole bars, during running 
playback. 

As long as a loop runs through without any problems, the correct tempo will be able 
to be read to the left. 

Here you should make sure that the number of beats per bar (default: 4) has to 
adapted to the actual loop length. That means if four bars are selected as a loop, 16 
has to be entered into this field. 

Start (S) and End (E) Markers: These markers indicate the beginning and the end of a 
loop. You can move them around with the mouse to fine-tune the range. 

Cut: Once a correct loop has been found, it can be cut using the this function in order 
to be able to use it again later.  

Use new BPM: The arrangement applies the BPM value found.  

Timestretching: Adapts the object to the tempo of the arrangement (as a result of the 
determined tempo) using timestretching. 

Resampling: Adapts the object to the tempo of the arrangement (as a result of the 
determined tempo) using resampling. 

Shortcut:  L 

Load/Save/Reset audio effects 
You can save the current effect combination of an audio object separately and apply it 
to other objects later. Or you can deactivate all currently used effects entirely (Reset) 
if you want to undo the changes.  

Keyboard 
shortcut: 

Load audio effects Ctrl + Alt + O 

 Save audio effects Ctrl + Alt + S 
 Reset audio effects Ctrl + Alt + R 
 

Convert stereo into two mono objects 
With this option stereo recordings can be split into two mono objects which are then 
connected to a group. You can use the "Ungroup" button to edit the channels as 
independent objects. 

Shortcut:  Shift + Z 
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Edit in external editor 
A selected audio object into the external program MAGIX Music Editor where it can 
be edited with lots of special features. Once editing has been completed, the edited 
material is used in MAGIX Music Maker 2013 instead of the original object. 

Shortcut:   Ctrl + Shift + M 

Video 
Edit image in external editor 
Graphics files (BMPs or JPEGs) may be edited retroactively with an external graphics 
program from the arranger. The selected image file is loaded automatically and, once 
editing has been completed, is used in the MAGIX Music Maker 2013 instead of the 
original material. 

Shortcut:   Ctrl+Shift+B 

Load video effects 
This command enables a saved effects combination to be loaded for the currently 
loaded object. If multiple objects are selected, then the effects combination will be 
applied to each selected object. 

Save video effects 
This command saves the current effects combination for each object separately. 

Reset video effects 
This option allows you to deactivate all currently used effects. The material will be 
reset to the state it was in before you applied the effect.  

Title 
Title Editor 
Opens the title editor (More information can be found in the section "Title Editor" on 
page 176) for the selected photo or video object. 

Shortcut:   Alt + Shift + T 

Load title template 
Use this command to load previously saved title effects for the current object.  

Save title template 
You can save the current effect combination for each title object separately and apply 
it to other title objects later. 
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View menu 

Standard layout 
This option determines, whether the video monitor and Media Pool are integrated in 
the main window or appear as a separate window which can be closed or opened. 

Shortcut:  F11 

Zoom Soundpool and Keyboard 
This setting enlarges the display of the loops in the Soundpool view of the Media Pool. 
The keyboard is also shown with a larger display. This makes it easier to use MAGIX 
Music Maker 2013 on touchscreens. 

Shortcut:  Tab 

Arranger 
Arranger visible 
This turns the arranger on and off. 

Shortcut:  F4 

Optimize view 

  The start marker is set at the beginning of the arrangement and the end 
marker is set at the end of the last object in the arrangement, so that the 
arrangement may be played back in full. 

Zooms out of the arrangement so that the complete duration of the arrangement is 
visible. The vertical zoom steps (track height) remain preserved. 

Shortcut:  F12 

Objects with stereo imaging 
This option determines whether the objects are displayed with one or two waveforms. 
When it is activated, the waveforms are displayed in stereo, i.e. with a right and left 
channel. 

Shortcut:  Ctrl + Alt + Z 

Highlight loop area 
With this option, you can fade the loop area in and out, visible by the stripe above the 
first track that indicates the area that will be played as an endless loop. 
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Show object marker > Show bar marker/harmony marker 
After using the Remix agent or the Harmony Agent, the analysed material receives 
beat and harmony information which is then shown in the arranger via these 
commands. 

Shortcut: Bar Marker Ctrl + Shift + F9 
 Harmony Markers Ctrl + Shift + F10 
 Beat Markers Ctrl + Shift + F11 
 

Media Pool 
Show Media Pool... 
This option hides or displays the Media Pool. 

Shortcut:  F2 

Media Pool views / template folders 
Opens the corresponding folder in the Media Pool. 

It's even easier to access the corresponding Media Pool views and folders via the 
corresponding keyboard shortcut. 

Video monitor 
Show video monitor 
Opens and closes the video window. 

Shortcut:   F3 

Full-screen Video Monitor 
This option shows the video preview monitor in full-screen mode. The right mouse 
button opens the context menu, the Esc-key returns you to normal viewing mode. 

Shortcut:  Alt + Enter 

Video output 
This option switches the preview monitor on or off to display the existing video 
objects in the Arranger.  

Shortcut:   Shift + F3 

Arrangement overview 
With this option you can display an overview of the entire arrangement on the video 
screen. It is particularly suitable for long and complex arrangements to prevent you 
from losing track.  
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You can view the whole arrangement and and still be able to access the sought-after 
object in a split second – you can zoom in directly on the video monitor or move 
around the clip displayed in the Arranger. 

 
The function can also be opened via "Overview" on the 
video monitor. 

Shortcut:   Shift + F2 

Audio peakmeter 

 
The video monitor is transformed into an analyzer which displays the 
sound as a graphic. 

 

Shortcut:   Shift + F4 

Infobox 

 
The InfoBox mode shows help text in the preview monitor if you hold 
the mouse pointer over a button on the screen. 

Shortcut:   Shift + F1 

Mix 
Mixer 
With this option you can open and close the real-time mixer. Further information can 
be found in the Mixer (view page 179) chapter. 

Shortcut:  M 

Master audio effect rack 
Opens or closes the master effects rack; you can also use the "Master FX" button in 
the mixer window for this. 

Shortcut:  B 
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The "Share" menu 
The Share menu provides access to online social networks as well as transfer 
functions to other MAGIX programs. 

Here you'll find options for uploading individual objects in the arranger or files from 
the Media Pool as well as the entire arrangement, as audio or video. You can also 
transfer your arrangement to another MAGIX program (if it is installed) e.g. to use it 
as background music for your slideshow. 

Community upload 
The menu entries featured under "File" > "Export" >"Community upload" or via the 
Export assistant allow you to upload the finished song to different web communities. 

Upload arrangement as MP3 to MAGIX Online Album 
Converts your arrangement into an MP3 file and uploads it to your personal MAGIX 
Online Album. 

Upload video to Facebook. 
Uploads  he current arrangement to Facebook. You can find additional information 
under Export to Facebook (view page 187). 

Upload video to YouTube 
Uploads the current arrangement to YouTube. See Export to YouTube (view page 
187) for details. 

Shortcut:   Shift + Y 

Upload audio to Soundcloud. 
Uploads the arrangement to the Soundcloud music platform. You can find additional 
information under Upload audio to Soundcloud (view page 188). 

Sending your arrangement as an email. 
This option creates a compressed file in Windows Media format. Your mail program 
is activated simultaneously and the created file of an opened message is added as an 
attachment. This lets you compress and send your arrangement immediately without 
having to go through any intermediate steps. 

Present music on magix.info 
Opens an Internet browser at the MAGIX Online World media upload page. There 
you can choose the file you would like to present on the website. 

Note: You first have to export (view page 183) your arrangement. 
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Use as background music 
Converts your arrangement into MP3 format and sends it to one of the specified 
programs, where it can be used as background music.  

• Video easy 3 SE 
• Video easy 3 HD 
• Movie Edit Pro MX HD 
• Movie Edit Pro MX Plus HD 
• Movie Edit Pro MX Premium HD 
• Photo Manager 10 
• Photo Manager 10 deluxe 
• Photo Manager MX 
• Photo Manager MX deluxe 

Note: This function is only available if you have at least one of the above programs 
installed.  

Add to music collection 
Converts your arrangement into MP3 format and sends it directly to a MAGIX music 
management program (e. g. MP3 deluxe MX), where it is added to an existing music 
collection.  

Note: This function is only available if you have installed an appropriate MAGIX 
program. 

Edit audio objects in external editors 
Converts your arrangement into WAV format and sends it directly to one of the 
specified programs where it can be edited further. 

• Music Editor 
• Audio Cleaning Lab 

Note: This function is only available if you have at least one of the above programs 
installed. 
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Burn audio to CD-R(W) 
Your arrangement will be sent to MAGIX Speed burnR, where it can be burned as an 
audio CD. The Premium version offers you MAGIX Music Editor. 

Keyboard shortcut:  Shift + C 

Burn arrangement and used media onto 
CD/DVD-R(W) 
You arrangement will be sent to MAGIX Speed burnR, where it can be burned to CD 
or DVD. 

Shortcut: Ctrl + B 
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Help Menu 

Show welcome dialog 
With this command you can display the "Welcome" dialog again. There, you have a 
quick access to important functions during program start. 

Documentation 
Content 
Use the command "Content" in the "Help" menu to open the start page of the help 
file. You can read through the help file step-by-step and jump to specific sections via 
the tree structure on the right hand side. 

PDF manual 
Opens the manual in PDF format. 

Context Help mouse mode 
The mouse cursor will turn into an arrow with a question mark. 

Click on any button of the main screen, to open program help which will describe the 
control element in question. 

Shortcut:  Alt + F1 

Display tooltips 
Tooltips are small information windows that open up automatically if the mouse 
pointer stops briefly on a button or some other area. They provide information about 
the function of the button. These information boxes can be switched on or off with 
this option. 

Start introductory video 
The introductory video shows you how all the most important features work. Specific 
topics are explained in detail in additional tutorial videos. 

Keyboard shortcut: Ctrl + F1 

To play the introductory video you may have to insert the program CD. 

Watch more tutorials online... 
Opens the magix.info with online tutorial videos. 
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Update program / Upgrade functions 
Register online 
This option opens the MAGIX homepage for online registration where you can 
register yourself as a MAGIX user.  

Registration grants you access to the MAGIX support website 
http://support.magix.net (see support) where various program updates and help 
programs can be downloaded.  

With the registration form supplied (start menu under "MAGIX Music Maker 2013 -> 
Service and support -> Register") you can register via post or fax. Simply print it out, 
fill it in, and send it off! 

Keyboard shortcut: F12 

Online Update 
Connects directly to the online update page where you can get the latest version of 
your program. 

magix.info - Multimedia Knowledge Community 
Help others and find help Directly from within the program you'll be able to access 
magix.info – the new MAGIX knowledge base. You'll find answers to all the most 
frequently asked questions about MAGIX products and multimedia in general. 
Couldn't find an answer to your particular question? No problem, just ask the 
question yourself. 

Ask the Knowledge Community a question online 
Ask magix.info a question. 

Find knowledge & workshops 
Have a look at the newest workshops at magix.info and read useful tips from other 
MAGIX Music Maker 2013 users. 

Present music on magix.info 
Opens an Internet browser at the MAGIX Online World media upload page. There 
you can choose the file you would like to present on the website. 

Note: You first have to export (view page 183) your arrangement. 

Open magix.info - Multimedia Community 
Opens the magix.info main page. 

http://support.magix.net/�


 

Help Menu 231  

 

MAGIX Screenshare 
This function makes it possible for you to offer assistance to other users directly via 
the Internet, or to get help from others. To do this, you have to register MAGIX Music 
Maker 2013 first. 

Hint: To inform the screensharing guests of exactly what is being shown, it is also a 
good idea to telephone or chat simultaneously. 

Register as host for a screen transfer 
1. If you want to start a screenshare instance yourself, then you have to register 

as a host first. To do this, open the menu "Share" and then select "Screen 
transfer as host...". 

2. In the dialog you can enter a name for the screen session. Your user account 
name is used here by default. 

3. Now click on "Start session". A small window will now open in the bottom 
right corner which displays the status of your screen session. A number will 
also be displayed (session ID) which serves as a password for your guests.  

4. Start the screenshare instance. 

Register as guest of a screen session 
1. You have to register as a guest to view a screensharing instance. To do this, 

open the menu "Share" and then select "Screen transfer as guest...". 
2. Enter the password you received from your host (8-digit session ID). 
3. Now click on "Start session". A window will open displaying a smaller version 

of your host's screen. 

About MAGIX Music Maker 2013 
Displays copyright info and version number of MAGIX Music Maker 2013. 
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Buttons overview and keyboard shortcuts 

Toolbar 

 
New arrangement Load arrangement 

 
Save arrangement Settings (view page 204, view page 203) 

 

 
magix.info Redo action 

 
Undo last action (Undo) Split Object 

 
Select mouse mode (view page 
48) 

  

 

Keyboard shortcuts 
In MAGIX Music Maker 2013, there are many functions for which key commands can 
be used to open your desired program at the touch of a button. In detail: 

• Menu and object context menu entries 
• Functions of the Media Pools (Options menu) 
• The video monitor menu 
• Move and zoom of the arranger view 
• Playback control (Moving the playback marker and the playback area) 
• Mouse modes 
• Smart preview function (Previewing Media Pool files in the arrangement context) 

File menu 
Load/Save arrangement 
New arrangement Ctrl + N 
Load arrangement Ctrl + O 
Save arrangement Ctrl + S 
Save arrangement as Shift + S 

Import 
Import Audio CD track(s) C 
Audio recording R 

Export 
Common export options X 
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Burn audio to CD-R(W) Shift + C 
Audio as Wave/ADPCM Shift + W 
Audio as MP3 Shift + M 
Audio as OGG Vorbis Shift + O 
Audio as Windows Media Shift + E 
Audio as AIFF Shift + I 
Audio as FLAC Shift + F 
Audio tracks as single waves Shift + U 
Video as AVI Shift + A 
Video as MAGIX video Shift + X 
Video as Quicktime Movie Shift + Q 
Video as Windows Media video Shift + V 
Picture as BMP Shift + B 
Picture as JPEG Shift + J 
Upload Video to YouTube Shift + Y 

Upload audio to MySpace Shift + S 

Backup copy 
Save arrangement and used media Ctrl + Alt + S 
Save arrangement and used media 
(audio as OGG Vorbis) 

Ctrl + Shift + C 

Burn arrangement and used media 
onto CD/DVD-R(W) 

Ctrl + B  

Burn manually selected files to 
CD/DVD 

Ctrl + Alt + B 

Settings 
Program settings P 
Arrangement settings A 

Audio recording R 

Keyboard shortcuts U 

Exit Alt + F4 
 

Edit menu 
undo Ctrl + Z 
Restore Ctrl + Y 
Select all Ctrl + A 
Object 
Record new audio object R 

New MIDI object Ctrl + Alt + N 

Text to speech Ctrl + T 
Create a new title object Alt + Shift + T 
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Cut Ctrl + X 
Copy Ctrl + C 
duplicating Ctrl+D 
Insert Ctrl + V 
Multiple insert Ctrl + "Num+" 
Delete Del 
Select all Ctrl + A 
Split T 
Save objects as takes Alt + Shift + S 

Group objects Ctrl+G 
Ungroup objects Ctrl+U 
Object properties Ctrl+P 

Range 
Cut Ctrl+Alt+X 
Copy Ctrl+Alt+C 
Insert Ctrl + Alt + V 
Multiple insert Ctrl + Alt + "Num+" 
Delete Ctrl + Del 
Extract Ctrl + Alt + E 

Navigation: Set jump marker, move playback position (see Playback control), move 
view (see Move arranger view (view page 236)). 

Effects menu 
Song Maker W 

Audio 
Master audio effects rack  B 
Text to speech Ctrl + Shift + T 

Object effect rack E 

10 Band Equalizer Q 
Compressor Shift + D 
Invert phase Ctrl + Shift + I 
Echo/Reverb Shift + H 

Distortion/Filter Shift + F 
Gater Ctrl + G 
Backwards Ctrl + Shift + R 

Mute/Unmute Ctrl + M 
Volume settings Ctrl + Shift + D 
Normalize Shift + N 

Timestretch/pitchshift Shift + P 
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MIDI transposition Ctrl + T 
Harmony Agent H 

One pitch higher Num * 

One pitch lower Num / 

Create remix objects Shift + J 

Remix Maker Shift + K 
Loop Finder L 
Remix Agent – Tempo and beat 
recognition 

J 

Load audio effects Ctrl + Alt + O 
Reset audio effects Ctrl + Alt + H 

Convert stereo into two mono 
objects 

Shift + Z 

Edit wave in external editor Ctrl + Shift + M 

Video 
Edit image in external editor Ctrl + Shift + B 

Title 
Title editor Ctrl + T 
 

View menu 
Zoom Soundpool and Keyboard Tab 

Arranger 
Arranger visible F4 
Optimize view F12 
Change object presentation Ctrl + Alt + Z 
Show object marker 
Bar marker Ctrl + Shift + F9 
Harmony marker Ctrl + Shift + F10 
Beat marker Ctrl + Shift + F11 

Media Pool 
Show Media Pool F2 
Soundpool F5 
File Browser F6 
Synthesizers F7 
Templates F8 
Catooh O 
Video monitor 
Show video monitor F3 
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Fullscreen video monitor Alt + Enter 
Video output Shift + F3 
Arrangement overview Shift + F2 
Audio peakmeter Shift + F4 
Info Box Shift + F1 

Mix 
Mixer M 
Master audio effects rack  B 

Standard layout F11 
 

Help menu 
Context help mouse mode Alt + F1 
About MAGIX Music Maker 2013 I 
 

MIDI objects context menu 
MIDI editor Ctrl + Shift + D 
Track VSTi editor Ctrl + Shift + F 
MIDI transposition Alt + Shift + D 
 

Media Pool 
Settings 
Soundpool F5 
File Browser F6 
Synthesizer F7 
Templates F8 
Keyboard F9 
Object inspector F10 
Catooh O 
 

Video Monitor 
Show video monitor F3 
Fullscreen video monitor Alt + Enter 
Video output Shift + F3 
Arrangement overview Shift + F2 
Audio peakmeter Shift + F4 
Info Box Shift + F1 
 

Move Arranger view 

Note: These commands similarly move the playback marker when it's stopped, the 
marker always remains visible in the arrangement clip. 

To next object edge Ctrl + 0 
To the previous object edge Ctrl + 9 
Go to beginning of arrangement Home 
Go to end of arrangement end cap 
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Go to start marker Ctrl + Home 
Go to end marker Ctrl+End.   
Page right/left  Page Up/Down 
Grid unit right/left Ctrl+PgUp/PgDn 
Go to the next jump marker Ctrl + Shift + PgDn 
Go to the previous jump marker Ctrl + Shift + PgUp 

 

Arranger view - Increase/Reduce clip size (zoom) 
Increase clip size (zoom in) Ctrl+Arrow up 
Reduce clip size (zoom out) Ctrl+Arrow down 
Zoom 1 frame Ctrl+1 
Zoom 5 frames Ctrl+2 
Zoom 1 sec Ctrl+3 
Zoom 10 sec Ctrl+4 
Zoom 1 min Ctrl+5 
Zoom 10 min Ctrl+6 
Zoom view between start and end 
marker 

Ctrl+7 

Zoom over whole arrangement Ctrl+8 
Increase track pitch Alt+Arrow up 
Reduce track pitch Alt+Arrow down 
 

Move playback control / playback marker / playback area 
Start/Stop playback Space bar 
Stop at position (stop playback, 
move playback marker to current 
position) 

Escape 

Set jump marker Shift+1...0 
Playback marker to jump marker 1..0 

Note: When stopped, the playback marker is moved to the jump marker (after the 
end of the current loop). 

Create jump marker sequence (10 
markers with intervals equal to the 
current playback area) 

Ctrl+Shift+M 

Delete all jump markers Alt+Shift+M 
Move playback range Arrow left/right 
Move playback one quarter of its 
length 

Ctrl+Arrow left/right 

Double/Halve playback area length Shift+Arrow right/left 
Double/Halve playback area length 
by a bar 

Ctrl+Shift+Arrow left/right 

 

Mouse modes 
Mouse modes for individual objects Alt + 1 
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Connect objects in one track Alt + 2 
Connect objects in all tracks Alt + 3 
Curve mouse mode Alt + 4 
Draw objects Alt + 5 
Splitting objects Alt + 6 
Object stretch mouse mode Alt + 7 
Preview objects mode Alt + 8 
Scrub mode Alt + 9 
Replace mouse mode Alt + 0 
 

Preview/Smart preview 
Preview of pitches Numbers 0..9 
Change preview object Arrow keys 
Insert into arrangement Enter 
Delete smart preview object Del 
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If you still have questions 

Tips for program help 
The "Help" file features hints on how to use the program and additional information. 
Many important terms are indicated in the text in italics and clicking on them displays 
an explanation. 

Context help: Press the "F1" key at any point in the opened program and the help file 
will open with the matching topic (context help). 

Search function: Use the search function to find out information about specific words. 
Enter either the individual word or use logical operators (OR, AND, NEAR) to refine 
your search if you have several search words. 

• "OR" (between two words): All topics which contain both words or one of the 
words will be listed. 

• "AND" (between two words): Only those topics will be listed which contain both 
words. 

• "NEAR" (between two words): Only those topics will be listed which contain both 
words. A maximum of six other words may be added between the search terms. 

• "NOT" (before a word): Topics which contain this word will not be listed. 

Print: Use the help program's print function to make a printout of individual topics or 
entire sections. The print button is located at the top of the help window in the 
toolbar. 

Uninstalling the program 
If you would like to uninstall MAGIX Music Maker 2013, you can do this in the control 
panel under "Software" or go to "Programs > MAGIX > MAGIX Music Maker 2013 > 
Service and Support > Uninstall MAGIX Music Maker 2013". 

System Requirements 
For Microsoft® Windows® 7 | XP® | Vista 

Minimum configuration: 
• PC with 2 GHz processor 
• 1 GB RAM (2 GB recommended) 
• Free hard disk space: 6 GB 
• Minimum screen resolution 1024 x 768 pixels 
• Sound card 
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• DVD drive 

Optional: 
• Burn CDs/DVDs with a CD/DVD±R(W) burner 
• MP3 export with Windows Media® Player 10 or higher 

Serial number 
A serial number is included in each product. This serial number is required for the 
installation of the software and enables usage of additional bonus services. Please 
store this number in a safe place. 

What can a serial number do? 
With a serial number your program is clearly assigned to you and only you. This will 
allow you take advantage of the free email support service. Serial numbers also help 
to protect against software piracy which ensures that we are able to continually 
provide our customers with an optimal price/performance ratio. 

Where can the serial number be found? 
The serial number can be found on the reverse side of your CD/DVD case. If your 
product is packed in a DVD box, you'll find the serial number on the inside. 

If you have purchased the download version, you will receive a confirmation email 
with the serial number. 

When will you need the serial number? 
The serial number is required when you start or register the program for the first time. 

Note: We explicitly recommend registering your product (free), since only then are 
you entitled to download updates and to use MAGIX support services (view page 4) 
or activate codecs. 
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Publishing works created in MAGIX Music 
Maker 2013 
What needs to be taken into account when publishing a music or video 
production? 
A distinction is made between "non-commercial use" and "commercial use". 

1. What constitutes non-commercial use? 
If songs are created with MAGIX Music Maker 2013 or if music is added to private 
videos, they can be shared with others on social networks (e.g. YouTube, Facebook, 
Soundcloud, Twitter or personal blogs/websites). The decisive factor in these cases is 
that no money is made or will be made from the song or video soundtrack. 

Examples of non-commercial use: 

• A user creates a song with Music Maker and uploads it to their SoundCloud page 
or YouTube channel. 

• A user produces a song using Music Maker, burns it to CD then sends it to their 
friends. 

2. What constitutes commercial use? 
Commercial use refers to videos with soundtracks or songs created using Music 
Maker for commercial purposes. Commercial use if if sales are made, if revenue is 
accrued through advertising (e.g. as a YouTube partner or through the process of 
monetizing) or if contracts are concluded. In this case the necessary licenses must be 
purchased from Catooh The Online Media Marketplace 
http://www.catooh.com/de/sys/id/search/?&search[mode]=fast&search[keyword
s]=music%20maker&search[category]=8563.  

Examples of commercial use: 

• A user creates a song in MAGIX Music Maker and uploads it to their YouTube 
channel, which they've enabled for advertising (YouTube Partner Program). 

• A user produces a song in MAGIX Music Maker and makes it available for 
purchase from an online download shop (e.g. iTunes, Musicload). 

• A musician produces a song with MAGIX Music Maker for a CD Compilation, 
which is sold at concerts. 

• A user makes a video in which they advertise their company or one of their 
company's products. 

Important: The downloadable styles in Catooh that are licensed for commercial use 
consist of high quality WAV files. Any "normal" Music Maker content from the 
installation DVD is in .ogg format for space reasons. 

http://www.catooh.com/de/sys/id/search/?&search[mode]=fast&search[keywords]=music%20maker&search[category]=8563�
http://www.catooh.com/de/sys/id/search/?&search[mode]=fast&search[keywords]=music%20maker&search[category]=8563�
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More about MAGIX 

MAGIX Online World 
MAGIX Online World from MAGIX offers you a range of new services for your 
photos, videos, and music that are accessible directly from the "Share" menu in 
MAGIX Music Maker 2013: 

MAGIX Online Album 
MAGIX Online Album (view page 199) is your personal multimedia album on the 
Internet. If you want to present slideshows or videos online, then MAGIX Online 
Album is the perfect service.  

MAGIX Website Maker 
MAGIX Website Maker helps you create a personal Internet showcase with a 
professional design in just a few mouse clicks – without prior knowledge, including 
your own chosen domain and email address. Publish slideshows and videos and 
accessorize your site with music and various effects  – anything from a simple 
business card to a fireworks display of effects, professional or private – show your 
best side! 

More about this topic can be found under MAGIX Website Maker. (view page 201) 

Catooh – the Online Content Library 
If your project is missing pictures, videos, DVD menus, sounds, or samples, then you 
should have a look at the huge selection available at Catooh. There you'll be able to 
buy media in excellent quality for low prices: DVD menus, Slideshow Maker styles, 
decorative elements, 3D power effects, 3D transition series, MAGIX Soundpools, 
songs, ringtones... Perfectly suited to all MAGIX photo, video, and music projects. 

magix.info 
Do you have questions, need help, or are looking for expert tips and tutorial videos on 
using your MAGIX product? At magix.info you will find answers and solutions as well 
as workshops and a comprehensive user forum for software and multimedia queries. 

You can access magix.info online at www.magix.info 
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Soundpool DVD Collection 
MAGIX Music Maker 2013 includes thousands of sound and video building blocks. 
Other media can be ordered later. MAGIX Sound  Essentials includes professionally 
produced loops and samples in impressive quality – the ideal enhancement for the 
most varying of music styles, including: 

• Ambient 
• Big Beat 
• Easy listening 
• Dance / Electro 
• Disco / House 
• Soundtrack 
• Hip hop 
• Rock/Pop 
• Techno / trance 
• Special effects 

 

In the upper menu bar under "Tasks" > "Discover more", you can order the MAGIX 
Sound  Essentials directly. 

Tip: At www.magix.com you'll always find the latest soundpool offers. 
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Audio formats............................................................................................................................57 
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Audio Objects.................................................................................................................... 46, 57 
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Context menu.......................................................................................................................... 107 
Control groups ........................................................................................................................ 180 
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Controller Editor Hints.............................................................................................................91 
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Copy objects.............................................................................................................................212 
Copy range............................................................................................................................... 214 
Copyright.......................................................................................................................................2 
Create a new MIDI object..................................................................................................... 211 
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